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Environment
Themes in MATLAB Online: Change the colors of the MATLAB desktop
by selecting a dark or light theme
In MATLAB Online™, you can change the colors of the MATLAB desktop using themes.

For example, to select a dark theme, on the Home tab, in the Environment section, click )
Preferences. Select MATLAB > Appearance and set the Theme to Dark.

E HOME PLOTS APpS EDITCR PUBLISH FILE VERSIONS
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To further customize the colors of the MATLAB desktop, select MATLAB > Appearance > Colors.

Then, change the colors in the Desktop tool colors, MATLAB syntax highlighting colors, and
MATLAB output colors sections.

As part of this change, icons in the MATLAB Online desktop have an improved visual appearance.

For more information about changing the colors of the MATLAB desktop, see “Change Desktop
Colors”.
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Live Editor Colors: Change the text and background colors of live
scripts and functions

You can change the text and background colors in the Live Editor by changing the MATLAB desktop
tool colors.

To change the text and background colors:

1 Onthe Home tab, in the Environment section, click & Preferences.

2 Select MATLAB > Colors

In MATLAB Online, select MATLAB > Appearance > Colors.
3 In the Desktop tool colors section, clear the Use system colors check box.

In MATLAB Online, the Use system colors check box is not available and this step can be
skipped.

4 Use the Text and Background fields to change the colors. For example, select white for the text
color and black for the background color.

The Live Editor automatically selects colors for titles and headings based on the selected background
color. To further customize the colors of titles and headings, use settings. For more information, see
matlab.fonts Settings.

Live Editor Hyperlinks: Insert hyperlinks to specific locations in
separate live scripts or live functions

Use hyperlinks to navigate to a location in a separate, existing live script or function. To insert a

hyperlink, select the text to link in the current file, go to the Insert tab, and click & Hyperlink. Edit
your display text (optional), select Location in existing document, and enter or browse for the file
path. Then, select a location in the document preview that displays on the right.

For more information about inserting hyperlinks, see “Format Text in the Live Editor”.
Live Editor Export: Export live scripts and functions programmatically
using the export function

Use the export function to programmatically export live scripts and functions to a standard format.
Available formats include PDE Microsoft® Word, HTML, and LaTeX.

For example, to export the live script homeworkl.mlx as HTML, type:

export("homeworkl.mlx", "homeworkl.html")

Live Editor Accessibility: Interact with output in live scripts using the
keyboard

You can now use keyboard shortcuts to interact with output in live scripts when output is on the right.

To move focus from the code to the output display panel, press Ctrl+Shift+0. On macOS, press
Option+Command+0. To activate an output, press Enter. Once an output is activated, you can

1-3



R2022a

1-4

scroll text using the arrow keys, navigate through hyperlinks and buttons using the Tab key, and open
the context menu by pressing Shift+F10.

Live Editor Tasks: View and interact with tasks when code is hidden

When you hide code in a live script, the Live Editor now displays Live Editor tasks along with
formatted text, labeled controls, and output.

To hide code, select the Hide Code button [= to the right of the live script or in the View tab.
Alternatively, if you are using the export function, you can hide the code using the HideCode name-
value argument.

If a Live Editor task is configured to show only code and no controls, then the task does not display
when you hide code.

Component Browser: Reorder children in App Designer or the Property
Inspector

You can now drag one or more Axes object children, Group object children, or Transform object
children sharing the same parent to reorder them in the Component Browser in App Designer or the
Property Inspector for figures.

When reordering children, use visual feedback for allowed moves. You can undo and redo the
reordering of the children with Undo or Redo or the corresponding keyboard shortcuts.

Editor Python Support: View and edit Python files with syntax
highlighting, auto-indenting, and delimiter matching
The Editor now displays Python® files with syntax highlighting for keywords, strings, comments, and

errors. In addition, the Editor auto-indents Python files and indicates matched and mismatched
delimiters such as parentheses, brackets, and braces.

Find and Replace Dialog Box: Search text in the Editor and Live Editor
using regular expressions

You can use a subset of regular expressions to search for text that matches a pattern in an open file in
the Editor or Live Editor. To search using a regular expression, on the Editor or Live Editor tab, in

the Navigate section, click *= Find. Then, in the find and replace dialog box, enter a regular
expression, and select the Regular Expression button -*?.

For example, to find all the words in a file that contain the letter x, enter the expression \w*x\w* and
select the Regular Expression button 7.

w Find "™ 373 [ € || » | aa ab, *7 X

Replace |§ Heplace ~| |f Replace All ~|

For more information, see “Find and Replace Text in Files and Go to Location”.
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Profiler: Access the Profiler from the Apps tab

The MATLAB Profiler is now available as an app and can be found in the MATLAB section of the apps
gallery in the Apps tab.

You can still access the Profiler from the Home tab, in the Code section, by clicking the Run and

Time button, or programmatically using the profile function.

Internationalization: UTF-8 system encoding on Windows platforms

MATLAB now uses UTF-8 as its system encoding on Windows®, completing the adoption of Unicode®
across all supported platforms. MATLAB has used UTF-8 as the default encoding for MATLAB files
and file I/O since R2020a.

Installation Settings: Configure persistent settings for MATLAB
installations

Installation-level settings provide a new layer of MATLAB configuration that lies between factory
settings and personal settings. Installation settings override the factory settings for all users of a
given MATLAB installation, and they are persistent across sessions.

In previous versions of MATLAB, if administrators wanted to limit RAM usage for a set of MATLAB
users by lowering the ArraySizelLimit, they had to create and distribute a script to change the
personal setting for each individual user. Starting in R2022a, the administrator can apply the change
to all users of their MATLAB installation using the installation setting for ArraySizelLimit.

Access installation-level settings using the new InstallationValue property of the Setting

object. Verify and clear installation settings with two new object functions, hasInstallationValue
and clearInstallationValue, respectively.

Comparison Tool: Save results as HTML report

You can now use the Comparison Tool to publish text comparison results in an HTML report. For
more details, see “Compare Text Files”.

Comparison Tool: Compare folders in MATLAB Online
Starting in R2022a, you can compare folders and zip files in MATLAB Online.

You can access the comparison tool from:

* The MATLAB Current Folder browser context menu
* The Current Project browser context menu
* The MATLAB Command Window using the visdiff function

Functionality being removed or changed

Live Editor figure size is bounded upon saving
Behavior change
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When opening a saved live script, existing images in the output have a maximum size equivalent to
the figure size upon saving. To adjust the size past this maximum limit, you can run the live script and
increase the figure size.
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Class Introspection: Description and DetailedDescription properties of
metaclasses contain text from code comments

The Description and DetailedDescription properties of these metaclasses pull content from
code comments:

+ meta.class

* meta.method

* meta.property

+ meta.event

+ meta.EnumeratedValue

For user-defined classes with appropriately placed code comments, the Description and
DetailedDescription properties of the metaclasses are populated with text pulled from those

comments. For more information on how to use code comments to store custom help text for user-
defined classes, see “Custom Help Text”.

Class Introspection: Access class aliases from meta.class instance

The aliases of a class are stored in the new Aliases property of meta.class. For more information
on class aliasing, see “Creating and Managing Class Aliases”.

Background Pool: See futures in the background
Starting in R2022a, you can query all queued and running futures in the background by using the

FevalQueue property of the pool. To create futures, use parfeval and parfevalOnAll. For more
information on futures, see Future.

cancelAll Method: Cancel currently queued and running futures in the
background pool

cancelAll cancels all futures currently queued or running in the background pool. Queued or
running futures are listed in the FevalQueue property.

Background Pool: Check the status of the background pool
Starting in R2022a, you can query to determine if the background pool is currently running by using

the Busy property of the pool. This property indicates whether the background pool is busy, specified
as true or false. The pool is busy if there is outstanding work for the pool to complete.

pcode Function: Create P-code files with enhanced obfuscation

The pcode function now has the option "-R2022a", which creates P-code files using a more complex
obfuscation algorithm. Files created with this option run only in MATLAB releases R2022a and later.
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str2num Function: Restrict evaluation to basic math expressions

str2num is implemented using the eval function, which evaluates the input argument. Starting in
R2022a, you can set the name-value argument Evaluation to "restricted" to restrict accepted
inputs to basic math expressions, such as 200 and 1+21i.

Functionality being removed or changed

Defining classes and packages: Using schema.m will not be supported in a future release
Still runs

Support for classes and packages defined using schema.m files will be removed in a future release.
Replace existing schema-based classes with classes defined using the classdef keyword.

dec2hex and dec2bin input types are now restricted
Behavior change

Input types allowed by dec2hex and dec2bin have been restricted. Supported input types are
primitive numeric types and classes that inherit from a primitive numeric type.

In addition, dec2bin(0,0) will now return ‘0’ rather than a 1x0 character vector.

cd no longer removes leading spaces for Windows drive letter paths
Behavior change

Before R2022a, on Windows platforms, the cd function removed leading spaces in input paths
specifying the drive letter. Input paths containing leading spaces now cause an error to be thrown
instead. If an input path is invalid with leading spaces, then use strip to remove the spaces before
using the cd function.

TruncateScalarObject name-value argument for widthConstrainedDataRepresentation
method renamed to AllowTruncatedDisplayForScalar
Behavior change in future release

The name of the TruncateScalarObject name-value argument for the
widthConstrainedDataRepresentation method is now AllowTruncatedDisplayForScalar.
The functionality of the option will not change. Support for the name TruncateScalarObject will
be removed in a future release.

cast returns consistent output for subclass of MATLAB numeric types
Behavior change

The syntax cast (A, "like", p) now returns output consistent with the prototype p when the data
type of p is a subclass of MATLAB numeric types.

For example, this code returns an output that has the same data type as p:

matlab.lang.0OnOffSwitchState.on;
cast(1l,"like",p)

p
X

X

OnOffSwitchState enumeration

on


https://www.mathworks.com/help/releases/R2020a/matlab/ref/classdef.html

Language and Programming

In previous releases, the code returns x = 1 with data type logical.
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Data Cleaner App: Interactively preprocess and organize column-
oriented data

The new Data Cleaner app enables you to:

* Access column-oriented data in the MATLAB workspace or import column-oriented data from a
file.

* Explore data by using the visualization, data, and summary views.

* Sort by a variable, rename a variable, or remove a variable.

* Retime data in a timetable, stack or unstack table variables, clean missing data, clean outlier data,
smooth data, or normalize data.

» Edit previously performed cleaning steps by using the Cleaning Steps panel.

» Export cleaned data to the MATLAB workspace, or export code for cleaning data as a script or
function.

You can open the Data Cleaner app from the MATLAB section of the apps gallery in the Apps tab.
Alternatively, enter dataCleaner in the MATLAB command window.

The Data Cleaner app currently supports cleaning only timetable data and importing only one
timetable at a time.

allfinite, anynan, and anymissing Functions: Determine if all array
elements are finite, any element is NaN, and any element is missing

Use the allfinite, anynan, and anymissing functions to examine the elements of an input array.

* allfinite: Determine if all array elements are finite.
* anynan: Determine if any array element is NaN.
* anymissing: Determine if any array element is missing.

quantile, prctile, and iqr Functions: Calculate quantiles, percentiles,

and interquartile range

Calculate quantiles, percentiles, and the interquartile range of a data set by using the quantile,
prctile, and iqgr functions.

Previously, the quantile, prctile, and iqr functions required Statistics and Machine Learning
Toolbox™.

rms Function: Calculate root-mean-square value
Calculate the root-mean-square (RMS) value of input data with rms.

You can specify the dimensions to operate along and whether to include or omit NaN values in the
calculation:



Data Analysis

+ Use "all" to calculate the RMS value of all elements of the input array.

* Use the dim input argument to calculate the RMS value along one dimension.

* Use the vecdim input argument to calculate the RMS value along multiple dimensions.

* Use "includenan" or "omitnan" to include or omit NaN values in the RMS calculation.

Previously, the rms function required Signal Processing Toolbox™.

std and var Functions: Optionally return mean as a second output

The std and var functions can now return the mean of the elements used to calculate the standard
deviation or variance by using a second output argument M. If a weighting scheme is specified, then
the weighted mean is returned.

Date and Time Functions: Some Financial Toolbox functions combined
with MATLAB functions

The following date and time functions from Financial Toolbox™ are combined with functions having
the same names in MATLAB. Before R2022a, these Financial Toolbox functions supported serial date
numbers and text timestamps as inputs, while the MATLAB functions supported datetime arrays.
Starting in R2022a, the MATLAB functions support datetime arrays, serial date numbers, and text
timestamps as inputs. The functions are removed from Financial Toolbox.

* day

* hour

* minute
* month

* quarter
* second
* year

Version History

While these functions support serial date number and text inputs, these types of inputs are not
recommended. Use datetime values as inputs instead. The datetime data type provides flexible
date and time formats, storage out to nanosecond precision, and properties to account for time zones
and daylight saving time. To convert serial date numbers or text timestamps to datetime values, use
the datetime function.

* To convert serial date numbers to datetime values, call datetime with the ConvertFrom name-
value argument:

dt = datetime(738457,"ConvertFrom", "datenum")
dt =
datetime

28-0ct-2021
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» To convert text timestamps, call datetime.

dt datetime("2021-10-28")

dt =
datetime
28-0ct-2021

There are no plans to remove support for serial date numbers or text timestamps from these MATLAB
functions.

Date and Time Functions: Some Financial Toolbox functions moved to
MATLAB

These date and time functions are removed from Financial Toolbox and moved to MATLAB:

* eomdate

* Tlweekdate
* m2xdate

* months

* nweekdate
* today

* weeknum

* x2mdate

Version History

While MATLAB supports these functions, they are not recommended because they use serial date
numbers in their calculations. The table shows recommended replacements that either accept or
return datetime values. The datetime data type is recommended because it provides flexible date
and time formats, storage out to nanosecond precision, and properties to account for time zones and
daylight saving time.

There are no plans to remove these functions from MATLAB.

Transferred Function Recommended Replacement

eomdate dateshift, with datetime values as inputs

lweekdate lweekdate, with outputType specified as
"datetime" to return datetime output

m2xdate exceltime, with datetime values as inputs

months between, with datetime values as inputs

nweekdate nweekdate, with outputType specified as
"datetime" to return datetime output

today datetime, with "today" as the input argument

weeknum week, with datetime values as inputs
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Transferred Function Recommended Replacement
x2mdate datetime, with dateType specified as "excel"

matlab.datetime.compatibility.convertDatenum Function: Convert text
timestamps and serial date numbers to datetime values in a
backward-compatible way

To convert text timestamps and serial date numbers to datetime values, use the
matlab.datetime.compatibility.convertDatenum function. For backward compatibility, this
function supports the subset of datestr formats that the datenum function recognizes when it
converts text timestamps without a format specifier.

Use this function in code where you intend to return datetime values, but to preserve compatibility
you need to interpret text inputs in the same way that datenum interprets them. This function is
designed to be a compatibility layer for function authors.

To explicitly convert serial date numbers to datetime values, use the datetime function instead,
with the ConvertFrom name-value argument:

dt = datetime(738457,"ConvertFrom", "datenum")
dt =
datetime

28-0ct-2021

categorical Data Type: Use a pattern object to specify category names
that match a pattern

When you specify category names of a categorical array, you can use a pattern object to specify
names that match a pattern.

For example, suppose you have a categorical array that has many different categories that can
represent "yes" and "no". This categorical array has six values and six categories because the values
in the input array are different.

C = categorical(["Y" "Yes" "Yeah" "N" "No" "Nope"])
C =
1x6 categorical array
Y Yes Yeah N No Nope

To combine all the different "yes" categories into one category and all the different "no" categories
into another category, use the mergecats function and wildcard patterns to match the category
names. The categorical array still has six values. But it has only two categories, "yes" and "no".

C = mergecats(C,"Y" + wildcardPattern,"yes");
C = mergecats(C,"N" + wildcardPattern,"no")
C =

1-13
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1x6 categorical array
yes yes yes no no no
These functions provide support for using patterns when you specify category names:

* histcounts (when you specify the Categories argument)
* 1iscategory (when you specify the catnames argument)

* mergecats (when you specify the oldcats argument)

* removecats (when you specify the oldcats argument)

* reordercats (when you specify the neworder argument)

table and timetable Data Types: Use a pattern object to specify row,
variable, and property names that match a pattern

When you specify rows, variables, or properties of a table or timetable, you can use a pattern object
to specify names that match a pattern.

You can use patterns when you subscript into a table by row names and variable names, or when you
subscript into a timetable by variable names.

For example, read a table into MATLAB.
T

readtable("outages.csv","TextType","string")
T =

1468x6 table

Region OutageTime Loss Customers RestorationTime Cause
"SouthWest" 2002-02-01 12:18 458.98 1.8202e+06 2002-02-07 16:50 "winter storm
"SouthEast" 2003-01-23 00:49 530.14 2.1204e+05 NaT "winter storm

"SouthEast" 2003-02-07 21:15 289.4 1.4294e+05 2003-02-17 08:14 "winter storm

To subscript into the table and select all variables whose names end with "Time", use a wildcard
pattern.

T2

T(:,wildcardPattern + "Time")
T2 =
1468x2 table

OutageTime RestorationTime

2002-02-01 12:18 2002-02-07 16:50
2003-01-23 00:49 NaT
2003-02-07 21:15 2003-02-17 08:14

These functions provide support for using patterns when you specify variables by name:
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* convertvars
* innerjoin

* issortedrows
* join

* movevars

* mergevars

* outerjoin

* removevars
* rowfun

* rows2vars

* sortrows

* splitvars

* stack

* topkrows

* unstack

* varfun

This function provides support for using patterns when you specify properties by name:

* rmprop

Data Preprocessing Functions: Append transformed variables to input
data using the ReplaceValues name-value argument

When you preprocess tables and timetables, you can now append variables containing the
transformed values to the input table. Set the ReplaceValues name-value argument to false for
these functions:

* smoothdata

* normalize

+ filloutliers

+ fillmissing

* standardizeMissing

Data Preprocessing Functions: Return table with logical values using
the OutputFormat name-value argument

When you preprocess tables and timetables, you can now output a table or timetable containing
logical values instead of a logical array. Set the OutputFormat name-value argument to "tabular"
for these functions:

* 1ischange

* 1islocalmax

* islocalmin
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* ismissing
* isoutlier

ismissing, rmmissing, and groupsummary Functions: Accept data
types with no standard missing value

The ismissing syntax ismissing(A) now returns logical @ (false) when the input data type has
no default definition of a standard missing value.

rmmissing and the nummissing and nnz methods of groupsummary no longer error for input data
types with no default definition of a standard missing value.

An example of code that used to error but now executes is:

A = [struct struct struct];
TF = ismissing(A)

TF =
1x3 logical array
0 0 0

Version History

Some input types that used to throw an error now execute. If your code relies on the errors that
MATLAB threw for those inputs, such as within a try/catch block, then your code may no longer
catch those errors.

Functionality being removed or changed

Plot a variable multiple times in a stacked plot
Behavior change

You can now display the same table or timetable variable multiple times when you call the
stackedplot function. In previous releases, specifying a variable more than once results in an error.

For example, create a timetable from the outages. csv file. Then plot the RestorationTime
variable under each of the other variables that you specify.

tbl = readtimetable("outages.csv");
tbl = sortrows(tbl);
stackedplot(tbl,["Loss","RestorationTime","Customers","RestorationTime"])

Live Editor tasks for arrays, tables, and timetables do not run automatically if inputs have
more than 1 million elements
Behavior change

Many Live Editor tasks for arrays, tables, and timetables do not run automatically if inputs have more
than 1 million elements. In previous releases, these tasks run automatically for input arrays, tables,
and timetables of any size. If the inputs have a large number of elements, then the code generated by
these tasks can take a noticeable amount of time to run (more than a few seconds).

This change in behavior affects these tasks:
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* Join Tables

* Retime Timetable

* Stack Table Variables

* Synchronize Timetables
* Unstack Table Variables

Live Editor tasks for preprocessing data do not run automatically if inputs have more than
1 million elements
Behavior change

Many Live Editor tasks for preprocessing data do not run automatically if inputs have more than 1
million elements. In previous releases, these tasks run automatically for input data of any size. If the
inputs have a large number of elements, then the code generated by these tasks can take a noticeable
amount of time to run (more than a few seconds).

This change in behavior affects these tasks:

* Clean Missing Data
* Clean Outlier Data
* Compute by Group
* Find Change Points
* Find Local Extrema
* Normalize Data

* Smooth Data

* Remove Trends
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Parquet: Read Parquet file data more efficiently using rowfilter to
conditionally filter rows

Conditionally filter and read data faster (Predicate Pushdown) from Parquet files when using
parquetread and parquetDatastore. You can create conditions for filtering by using the
rowfilter function, matlab.io.RowFilter object, and RowFilter name-value argument. Due to
its metadata-accelerated processing, the rowfilter workflow is the recommended approach for
filtering Parquet data to import.

Parquet: Determine and define row groups in Parquet file data

A Parquet file can store a range of rows as a distinct row group for increased granularity and
targeted analysis. parquetread uses the RowGroups name-value argument to determine row groups
while reading Parquet file data. parquetwrite uses the RowGroupHeights name-value argument to
define row groups while writing Parquet file data.

Parquet: Convert, import, and export nested data structures

Use parquetread to import nested Parquet file data with:

* LogicalType as LIST.
* LogicalType as NONE and PhysicalType as either BYTE ARRAY or FIXED LEN BYTE ARRAY.

The parquetread function converts and imports these data structures as cell arrays.

Use parquetwrite to export nested cell arrays as LIST arrays. Nested data is beneficial to working
with irregularly structured data such as jagged arrays.

writelines Function: Write plain text to a file

Use the writelines function to write a string array or a cell array of character vectors as plain text
to a file. The writelines function is the writing equivalent of the readlines function.

Reading Online Data: Use web options when reading files over HTTP
and HTTPS

Read files over HTTP and HTTPS using the weboptions function and specifying the WebOptions
name-value argument with these functions:

* readtable

* readtimetable

* readvars

* readstruct

* readmatrix

* readcell
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* readlines

Opus Files: Work with Opus (.opus) audio files.

Use audioread, audiowrite, and audioinfo to read, write, and analyze Ogg Opus audio files.

HDF5 Interface: Write datasets using dynamically loaded filters

You can read and write HDF5 datasets using dynamically loaded filters with both the high-level and
low-level interfaces. For details, see “Import HDF5 Files” and “Export to HDF5 Files”.

The h5create function introduces two name-value arguments, CustomFilterID and
CustomFilterParameters, to enable compression using dynamically loaded filters.

NetCDF Interface: Enable byte-range reading of remote datasets

You can now use the existing high-level and low-level interfaces for read-only access to remote
datasets using the HTTP byte-range capability. The latter assumes that the remote server supports
byte-range access.

NetCDF Interface: Read and write variable length array data types
(NC_VLEN)

You can now use the existing high-level functions to read variable length array data types (NC_VLEN)
from NetCDF-4 files. You can read and write NC_VLEN types using low-level functions.

Use these additional low-level functions to create NC_VLEN types and retrieve information about
them:

* netcdf.defVlen

* netcdf.inqUserType

* netcdf.ingVlen

Scientific File Format Libraries: NetCDF library is upgraded

The NetCDF library is upgraded to version 4.8.1.

Hardware Manager App: Discover and connect to your hardware from
MATLAB

The new Hardware Manager app allows you to discover and connect to your hardware from

MATLAB by providing access to the necessary add-ons and apps. For more information, see “Get
Started with Hardware Manager”.

TCP/IP Client Interface: Specify transfer delay options

You can now enable or disable a transfer delay to allow delayed acknowledgement from the
connected server for tcpclient objects and in the TCP/IP Explorer app. The transfer delay is
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enabled by default. Enabling the delay turns on Nagle's algorithm, which causes the client to collect
small segments of outstanding data and send them in a single packet when acknowledgement (ACK)
arrives from the server. Disabling it turns off Nagle's algorithm, which immediately sends data to the
network.

For the tcpclient interface, you can set the EnableTransferDelay property as a name-value
argument during object creation. For TCP/IP Explorer, you can select Transfer Delay options
during connection configuration.

For more information about this functionality, see EnableTransferDelay and “Configure Connection in
TCP/IP Explorer”.

Functionality being removed or changed

seriallist function will be removed
Warns

seriallist will be removed. Use serialportlist instead. For more information about updating
your code to use the recommended functionality, see “Transition Your Code to serialport Interface”.

serial function will be removed
Warns

serial and its object properties will be removed. Use serialport and its properties instead.

This example shows how to connect to a serial port device using the recommended functionality.

Functionality Use Instead

s = serial("COM1"); s = serialport("COM1",115200);
s.BaudRate = 115200;

fopen(s)

For more information about updating your code to use the recommended functionality, see
“Transition Your Code to serialport Interface”.

MATLAB Variable Editor: timeseries will no longer be supported
Warns

Viewing timeseries objects using the MATLAB Variable Editor will no longer be supported. To view
time-indexed data in the Variable Editor, use timetable instead.
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pagemldivide, pagemrdivide, and pageinv Functions: Solve linear
equations and calculate matrix inverses using pages of N-D arrays

Use the pagemldivide, pagemrdivide, and pageinv functions to perform linear algebra
operations on the pages of N-D arrays. In this context, the N-D array is treated as a container for
several 2-D matrices.

* pagemldivide and pagemrdivide: Solve linear equations using the pages of N-D arrays.

* pageinv: Calculate the matrix inverse of the pages of an N-D array.

tensorprod Function: Calculate tensor products between two arrays
Use the tensorprod function to calculate tensor products between two N-D arrays. You can perform

an inner product, outer product, or a combination of the two by specifying a subset of dimensions to
contract (multiply and sum) with each other.

round Function: Control tiebreak behavior
The round function has a new TieBreaker name-value argument to specify how to break ties. You

can now specify to round ties away from zero, towards zero, to the nearest even or odd integer, or
towards positive or negative infinity.

Version History
Starting in R2022a, the round function always rounds ties (that are within roundoff errors) away

from zero by default. In previous releases, the round function sometimes returns inconsistent results,
where ties are rounded towards zero by default.

null and orth Functions: Specify tolerance to treat singular values
below a threshold as zero
The null and orth functions now have a second input argument that specifies a tolerance. The

tolerance determines which singular values of the input matrix are treated as zero, which can change
the number of columns returned by null and orth.

norm Function: Frobenius norm calculations support N-D arrays

Frobenius norm calculations of the form norm(X, "fro") now support N-D arrays. See norm for
more information.

equilibrate Function: Specify output format of factorization
equilibrate now has an option with values of "vector" or "matrix" to specify whether the

output arguments are returned as vectors or matrices. For large factorizations, returning the outputs
as vectors can save memory and improve efficiency.
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rand, randi, and randn Functions: Support for complex input and
RandStream object with the "like" syntax

The rand, randi, and randn functions now support complex input and a RandSt ream object for the
"like" syntax.

For example, you can use X = rand(m,n, "like",p) to create an m-by-n array of random numbers
of the same data type and complexity (real or complex) as p. You can also use X =
rand(s,m,n,"like",p) to generate random numbers like p from the random number stream s
(RandStream object) instead of the default global stream.

eps, flintmax, intmax, intmin, realmax, and realmin Functions: Use
“like" syntax to return scalars based on prototype object

The eps, flintmax, intmax, intmin, realmax, and realmin functions now accept the "like"
syntax to return scalars based on a prototype object.

For example, you can use f = realmax("like",p) to return the largest finite floating-point
number with the same data type, sparsity, and complexity (real or complex) as the floating-point
variable p.

qr and gsvd Functions: Option for economy-size decompositions

gr and gsvd have a new "econ" option for economy-size decompositions.

» For gr, the functionality is the same as qr (A, 0) unless a third output is specified.
* For gsvd, the functionality is the same as gsvd(A,B,0).

Functionality being removed or changed

One-output qr syntax always returns upper-triangular factor
Behavior change

The syntax R = qr(A) always returns R as an upper-triangular matrix, regardless of whether A is full
or sparse. Previously, for full A, the one-output syntax returned an R matrix with intermediate data
used in the calculation located in the lower triangular portion of the matrix. See qr for more
information.

mldivide no longer uses LDL factorization for full matrices
Behavior change

mldivide no longer uses an LDL factorization for full matrices that are Hermitian indefinite. Instead,
the LU factorization is used for these matrices.
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Plotting Table Data: Create line plots by passing tables directly to
plotting functions

Create plots by passing a table directly to any of these functions: plot, plot3, loglog, semilogx,
semilogy, and polarplot. When you specify your data as a table, Cartesian axis labels and the
legend (if present) are automatically labeled using the table variable names.

For example, create a table with the variables Temperature and Humidity. Pass the table to the
plot function as the first argument, and specify the variables you want to plot.

Temperature = (40:70)';

Humidity = (50:80)' + randn(31,1);
T = table(Temperature,Humidity);
plot (T, "Humidity", "Temperature")

80

BT fuu///

45 . . . . .
40 45 50 55 60 65 70
Temperature

Data Tips: View table variable names as row labels

When plotting tabular data, the default row labels of data tips created interactively or with the
datatip function are the names of the table variables associated with the data point.

For example, create a table using the sample file patients.x1ls. Then, plot the Systolic,
Diastolic, and Weight variables in a bubble chart. A data tip created with datatip(b) displays
three rows. The row labels are "Systolic", "Diastolic", and "Weight".

tbl = readtable("patients.xls");

b = bubblechart(tbl,"Systolic","Diastolic","Weight");
datatip(b);
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Data Tips: View visual property values for scatter plots and bubble
charts

For scatter plots and bubble charts, data tips created interactively or with the datatip function
include by default rows for visual properties such as size, color, or transparency that are specified
with vector data.

For example, create a scatter plot of random data and define the marker sizes as vector sz. A data tip
created with datatip(s) displays three rows: X, Y, and Size. The Size row in the data tip displays
the marker size specified by sz for the associated data point.

X linspace(0,3*pi,200);
y cos(x) + rand(1,200);
sz = linspace(1,100,200);
s = scatter(x,y,sz);
datatip(s);
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Bubble Charts and 3-D Scatter Plots: Plot multiple data sets at once

The bubblechart, bubblechart3, polarbubblechart, and scatter3 functions now accept the
same combinations of matrices and vectors as the plot function does. As a result, you can visualize
multiple data sets at once rather than using the hold function between plotting commands.
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fontname and fontsize Functions: Specify the font and font size for
graphics objects

Use the fontname and fontsize functions to modify the fonts displayed with graphics objects such
as figures, axes, legends, tiled chart layouts, standalone visualizations, and UI components. MATLAB
applies your changes to the specified object and all the objects it contains. For example, if you change
the font on a figure, all the axes, annotations, and UI components within the figure use the new font.

exportgraphics Function: Create animated GIF files

Create animated GIF files by calling the exportgraphics function multiple times with the Append
name-value argument.

Annotation Graphics Objects: Change the annotation rotation angle
with the Rotation property

For text box, rectangle, and ellipse annotation objects, rotate the annotation a specified number of
degrees by using the Rotation property. The anchor point for rotation is the location specified by
the first two elements of the Position property, so the Position property is unaffected by rotation.

For more information, see TextBox Properties, Rectangle Properties, and Ellipse Properties.

Quiver Plots: Align the heads, centers, or tails of arrows with data
points

Set the Alignment property of a Quiver object to control how the arrows align with the data points.
Valid values are "head", "center", and "tail". For example, plot a grid of vectors with the arrow
heads positioned at the data points. Specify a marker symbol to show the locations of the data points.

[X,Y] = meshgrid(0:6,0:6);

U = 0.25*X;

V = 0.5%Y;
quiver(X,Y,U,V,"Alignment", "head", "Marker","o0")
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xlim, ylim, and zlim Functions: Query the axis limit method

Query the method MATLAB uses to set the axis limits by calling the x1im, ylim, and z1lim functions
and specifying "method" as an input argument.

view Function: Change the view on multiple axes simultaneously

Change the view of multiple axes objects at the same time by passing an array of axes objects to the
view function.

rendererinfo Function: Get renderer information without specifying
the axes

Call the rendererinfo function without any arguments to query the default graphics renderer
information. This new syntax allows you to call the rendererinfo function in a way that is
consistent with the opengl syntax. Since R2019a, the rendererinfo function has been
recommended instead of the opengl function for querying the renderer.

linkaxes Function: Synchronize axes in all dimensions by default

The linkaxes function now supports 3-D Cartesian axes and synchronizes the x-axis, y-axis, and z-
axis limits by default. The supported values of the dimension input argument are now 'xyz'
(default), 'x"', 'y"', 'z', 'xy', 'xz"', 'yz',and 'off".

Before R2022a, linkaxes supported only 2-D Cartesian axes and synchronized the x-axis and y-axis
limits by default.
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cameratoolbar Function: Syntax support for figures created with the
uifigure function

Syntaxes of the cameratoolbar function that do not directly make the toolbar visible are now
supported by figures created with the uifigure function.

Callbacks in Live Editor: Create callbacks for figures in the Live Editor

You can now create callbacks for figures created in the Live Editor. The callback workflow supports
optional source and event-data parameters.

Keyboard-based callback properties and anonymous function callbacks using Figure objects from
the MATLAB workspace are not currently supported in the Live Editor.

To define and execute a figure callback in the Live Editor, use one of these techniques:

* Create a figure callback and pass source and event data as parameters in the callback.

* Create a figure callback and do not pass source or event data as a parameter in the callback.

* Create a callback that includes a function for identifying a graphics object, such as gca or
findobj.

For example, define a callback function called colorchangeCallback. With the
colorchangeCallback function on the MATLAB path, use the @ operator to assign the function
handle to the WindowButtonDownFcn property of the figure fig.

fig = figure;

axis([-4 4 -4 4]);

plot(1:10)

fig.WindowButtonDownFcn = @(src,eventdata)colorchangeCallback(src);

Define the callback and set the Color property for the Axes object in the figure:

function colorchangeCallback(f,~)

% Change the axes color on button down
ax = f.Children;

ax.Color = rand(1,3);

end

For more information, see “Callbacks in Live Editor”.

Figure Code: Generate code for figure interactions in MATLAB Online

When you modify a figure in MATLAB Online using the Figure tab, MATLAB generates code that you
can view, copy, and export. To view the generated code, select Show Code in the File section of the
Figure tab. MATLAB generates code for these actions:

* Adding a title, axis label, legend, color bar, grid, or annotation

* Changing the text or line style

* Using the pan, zoom, rotate, or data tip interactions

MATLAB does not currently generate code for the Select and Edit option in the Figure tab.
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For example, you can create a surface plot with surf (peaks). Then, interactively add a title and
colorbar, zoom into the axes, and view generated code.
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Command Window

x1lim([16.2 36.8]) i
ylim([16.5 36.9]) o
zlim{[-2.67 5.48])

colorbar

title("3-D Surface Plot"™)

Functionality being removed or changed

Polar axes display angle values with degree symbols
Behavior change

Polar axes now display tick values in degrees with degree symbols when the ThetaAxisUnits
property is set to "degrees". For example, create a polar plot. By default, the theta-axis displays the
tick values with degree symbols.

theta = 0:0.01:2*pi;

rho = sin(2*theta).*cos(2*theta);
polarplot(theta, rho)
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This change clarifies which units are being used for the theta tick values. You can use the
ThetaAxisUnits property to display the tick values in degrees or radians. To remove the degree
symbols, change the tick label format for the theta-axis:

pax = gca;
pax.ThetaAxis.TickLabelFormat = "%g";

The caxis function is not recommended
Still runs

The caxis function is no longer recommended. However, the function continues to work, and there
are no plans to remove it at this time.

To update your code, call the clim function instead. It accepts the same input arguments and returns
the same output as the caxis function.

The im2java function will be removed
Still runs

im2java will be removed in a future release. There is no replacement for this function.

The Plot Catalog tool will be removed
Still runs

The Plot Catalog tool will be removed in a future release. Instead, to interactively create and explore
visualizations for your data, use the Plots tab in the MATLAB Toolstrip or the Create Plot task in the
Live Editor.

For more information about visualizations, see “Types of MATLAB Plots” or toolbox-specific
documentation.

The opengl function will be removed
Still runs
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The opengl function will be removed in a future release.

* To query the renderer, use the rendererinfo function instead of the opengl function.

* Changing the renderer with the opengl function will no longer be necessary when the function is
removed.

The renderer startup options will be removed
Still runs

In a future release, the MATLAB startup options for selecting the graphics renderer will be removed.
Specifically, these startup scenarios will no longer be available:

 matlab -softwareopengl

+ matlab -nosoftwareopengl

+ matlab -softwareopenglmesa

* matlab -noopengl

It will no longer be necessary to specify the renderer when these options are removed.

The Renderer property of figures will have no effect
Behavior change in future release

The Renderer and RendererMode properties of figures will have no effect in a future release. It will
no longer be necessary to change the renderer when these properties are disabled.

The FontSmoothing property will have no effect
Behavior change in future release

The FontSmoothing property for all types of axes, rulers, geographic scales, and text objects will
have no effect in a future release. Font smoothing will be enabled regardless of the value of the
property.

Some plot tools functions will redirect to the Figure Toolstrip and Property Inspector
Behavior change in future release

Calling these plot tools functions will open a configuration of the Figure Toolstrip and Property
Inspector. For more information, see the Version History section in the documentation for each
function.

+ figurepalette

* plotbrowser

* propertyeditor

* propedit

* plottools

* showplottool

* plotedit

Currently, calling plot tools functions opens the Figure Palette, Plot Browser, and Property Editor.
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uistyle Function: Add icons and format text in table cells and tree
nodes

You can now create styles for table and tree Ul components that specify an icon and a text interpreter
using the uistyle function.

» Specify the Icon property of the style object to add icons to table cells and tree nodes.

» Specify the IconAlignment property of the style object to modify where the icon appears in
relation to the text in table cells.

» Specify the Interpreter property of the style object to format text or add links using HTML
markup, or to add equations using TeX or LaTeX markup to table cells and tree nodes.

* Specify the HorizontalClipping property of the style object to control whether long text is
clipped on the left or the right in table cells and tree nodes.

Add a style to a Ul component using the addStyle function.

For example, this code creates two styles, one that specifies an icon and one that specifies the text
interpreter as TeX, and applies the styles to columns of a table.

T = table(["x™2";"3x"3+1"],["Success";"Success"]);
fig = uifigure(Position=[500 500 300 160]);
t = uitable(fig,Position=[10 10 250 140],Data=T);

sl uistyle(Interpreter="tex");

s2 uistyle(Icon="success",IconAlignment="right");
addStyle(t,sl,column=1)

addStyle(t,s2,column=2)

4 - m| X
Var1 Var2

%2 Success 3

3x341 Success 3

uitable Function: Rearrange columns of table Ul components
interactively

You can specify the ability to interactively rearrange table columns in an app by using the
ColumnRearrangeable property. In a table Ul component with the ColumnRearrangeable value
set to 'on’', rearrange table columns in the app by clicking and dragging the column header.

In App Designer and apps created using the uifigure function, you can program an app to respond
when a user rearranges table columns by creating a DisplayDataChangedFcn callback function.

For more information, see Table Properties.



App Building

focus Function: Give keyboard focus to Ul components
programmatically

Use the focus function to programmatically give focus to keyboard-focusable Ul components. When
a Ul component is focused, it is displayed with a blue focus ring, and app users can interact with the
component using the keyboard.

isinScrollView Function: Determine if a component is visible in a
scrollable container

Use the isInScrollView function to programmatically identify which components are visible given
the size and scroll location of a scrollable container. For example, you can determine which axes are
visible inside a scrollable figure window and then update the data only for those axes.

uigridlayout Function: Resize table, list box, and image Ul components
to fit content

Grid layout managers with row heights or column widths of ' fit' now resize to fit the contents of
table, list box, and image UI components.

For example, when you create a table Ul component inside a grid layout manager with a row height
or column width of ' fit"', the height of the row or the width of the column resizes to fit the data in
the table.

fig = uifigure(Position=[680 558 300 170]);
gl = uigridlayout(fig);

gl.RowHeight = {'fit'};

gl.ColumnWidth = {'fit'};

tbl = uitable(gl,Data=rand(3));

4 - 0 %

0.8147 09124 0.2785
2 0.9058 0.6324 0.5469
01270 0.0975 0.9575

Version History

In R2021Db, grid layout managers with row heights or column widths of ' fit' scaled to a fixed size
when the row or column contained a table, list box, or image Ul component.
» Table Ul component — Row height and column width previously resized to 300 pixels.

» List box Ul component — Row height previously resized to display at most four items. The exact
pixel value to display four items might vary depending on your settings.

* Image Ul component — Row height and column width previously resized to 100 pixels.
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To display a table, list box, or image at its size in a release before R2022a, set the corresponding
elements of the RowHeight and ColumnWidth properties of the GridLayout object to their
respective fixed sizes.

Live Editor Tasks: Develop your own Live Editor tasks for use in live
scripts and functions

Live Editor tasks are simple point-and-click interfaces that can be embedded into a live script. Tasks
represent a series of MATLAB commands that are automatically generated as users explore
parameters.

You can develop your own custom Live Editor tasks by creating a subclass of the LiveTask base
class. Develop tasks to perform your own specific set of operations within a live script.

For more information, see “Live Editor Task Development Overview”.

Custom Ul Components: Interactively create custom Ul components in
App Designer

Use App Designer to interactively build your own UI components. Open a new blank custom UI
component in App Designer, lay out the component by combining existing MATLAB UI components or
graphics objects, and configure the component interface by creating public properties and public
callbacks that can be set when the component is used in an app.

Creating a custom UI component has these benefits:

* Modularization — Separate the display of large apps into independent, maintainable pieces.

* Reusability — Provide a convenient interface for adding and customizing similar components in
apps.
» Flexibility — Extend the appearance and behavior of existing Ul components.

For more information, see “Create a Simple Custom UI Component in App Designer”.

App Designer: Modify tab focus order of components

You can view and modify the order in which components in your app receive keyboard focus when the
app user presses Tab. First, sort and filter the Component Browser by tab order by selecting Sort
& Filter by Tab Order from the drop-down list labeled View. The Component Browser lists only
the components in the app that can have focus, in the order of focus. You can then change the tab
order of the components by clicking and dragging the component names in the Component
Browser.

Alternatively, App Designer can automatically apply a left-to-right and then top-to-bottom tab focus
order for components in a container. Right-click the name of the container in the Component
Browser and select Apply Auto Tab Order.
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App Designer: Specify error handling options and navigate from error
messages when debugging an app

To specify error handling options when debugging code in App Designer, configure the [x" Run
button by clicking Run~-. You can choose to pause code execution when an error occurs, when a
warning occurs, or when a NaN or Inf value is returned.

Additionally, error messages in App Designer now contain links to relevant files and functions. Use
these links to navigate more easily to the documentation or to line numbers in your code when
debugging your apps.

App Designer: Manage image files in your app with an improved
workflow

When you specify image data for your app, such as the image source of an image component or the
icon of a button, select an image that is in the same folder as the MLAPP file or one of its subfolders.
The image will then load whenever the app is opened or run without it needing to be on the MATLAB
path. Alternatively, you can continue to use images in any location by adding the image files to the
MATLAB path.

App Designer: Convert components in a grid layout manager to use
pixel-based positioning

You can delete a grid layout manager and convert the components in the grid to use pixel-based
positioning. To use pixel-based positioning when you were previously using a grid layout manager,
right-click the container with the grid layout manager in the canvas, and select Remove Grid
Layout.

For more information, see “Use Grid Layout Managers in App Designer”.

App Designer: Use App Designer in most modern web browsers in
MATLAB Online

You can now use App Designer in MATLAB Online with the current versions of Mozilla® Firefox®,
Apple Safari, and Microsoft Edge®, in addition to Google Chrome™.

App Designer: Customize design environment layout

You can now customize the locations of the side panels and tabs in the App Designer design
environment.

To change the location of side panels such as the Component Library and the Component
Browser, click the panel header and drag it to a new location in the App Designer environment. To
change the location of your open tabs to display on the left, right, or bottom of the working area,
right-click the tab bar and select Tab Position.

Your changes to the design environment layout now persist even after you close and reopen App
Designer.
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Comparison Tool: Compare and merge app files in MATLAB Online

Compare and merge two versions of an app file in MATLAB Online using the Comparison Tool. To

open the Comparison Tool, click 2=~ Compare in the Designer tab of the App Designer Toolstrip.

For more information, see “Compare and Merge Apps”.

Functionality being removed or changed

RearrangeableColumns property of table Ul components is not recommended
Still runs

Starting in R2022a, using the RearrangeableColumns property to specify the ability to rearrange
columns in a table Ul component is not recommended. Use the ColumnRearrangeable property
instead. The new property can have the same values as the old one.

There are no plans to remove support for the RearrangeableColumns property at this time.
However, the RearrangeableColumns property no longer appears in the list returned by calling the
get function on a table UI component.

UlAxes content is not displayed in App Designer Design View when the component is off
the canvas
Behavior change

When creating an app with a UTAxes component in App Designer, the UTAxes component content is
not displayed in Design View when the component is partially or fully off the canvas. Instead, the
UIAxes component is shown as a placeholder image. To see the content of the component, drag it
fully onto the canvas.

You can still modify properties of the UIAxes component when it is off the canvas, but you will not be
able to see a visual reflection of those changes in Design View until the component is dragged onto
the canvas.

=, it {1
To display app.UlAxes, draqg it fully into
itz container
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ComponentContainer class assigns a parent before executing the setup method
Behavior change

When you create an instance of a custom Ul component created using the
matlab.ui.componentcontainer.ComponentContainer class, the class now assigns the
component parent before executing the setup method. As a result, you might see unexpected
behavior if your setup method creates underlying Ul components that can be parented to either a
figure created using the figure function or a figure created the uifigure function, such as panels,
tab groups, or button groups.

To update your class code, when you create such a component, specify the property value explicitly
for any property where the default value differs depending on the parent. For example, to create a
panel in your custom component that is sized using normalized units, specify Units as
"normalized" before setting the Position property.

ButtonDownFcn callback cannot be interactively assigned for custom Ul components in App
Designer
Behavior change

Starting in R2022a, when you use a custom UI component in an app in App Designer, you cannot
interactively assign a ButtonDownFcn callback to the component. If you have an existing App
Designer app that contains a custom UI component with a ButtonDownFcn callback that you
assigned interactively, opening the app in R2022a disconnects the callback from the component. To
reassign the callback to the component, follow these steps:

1 If your app does not contain a StartupFcn callback, right-click the app node from the top of the
Component Browser hierarchy and select Callbacks > Add StartupFcn Callback.

2 In Code View, in the startupFcn function, add this code to assign the appropriate
ButtonDownFcn callback programmatically:

app.CustomUIComponentName.ButtonDownFcn = ...
@(src,event)CallbackFunctionName (app,event);

For example, if your app contains a custom UI component named app . IPAddress with a
ButtonDownFcn callback named IPAddressButtonDown, add this code to the startupFcn
function of your app:

app.IPAddress.ButtonDownFcn = @(src,event)IPAddressButtonDown(app,event);
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table Data Type Indexing: Improved performance when subscripting
with dot notation or multiple levels of indexing

table subscripting when using dot notation is significantly faster in R2022a than in R2021b. Also,
subscripting with multiple levels of indexing is faster.

+ For example, when you use dot notation to refer to a table variable with 10° elements,
performance in R2022a is more than 4x faster than in R2021b.

function timingTest()
t = table(zeros(le6,1), ones(le6,1), nan(le6,1));
indices = 1:1e5;

tic;
% Refer to variable using dot notation
for i = indices
X = t.Varl;
end
toc
end

The approximate execution times are:
R2021b: 1.55s

R2022a: 0.36 s

 Similarly, when you use dot notation to assign an array to a table variable with 106 elements,
performance in R2022a is about 3x faster than in R2021b.

function timingTest()
t = table(zeros(1le6,1), ones(1le6,1), nan(le6,1));
indices = 1:1e5;
X = randi(le6,1le6,1);

tic;
% Assign to variable using dot notation
for i = indices
t.Varl = x;
end
toc
end

The approximate execution times are:
R2021b: 2.15 s

R2022a: 0.72 s

* Also, when you use dot notation and parentheses to assign individual values to elements of a table
variable, performance in R2022a is more than 4x faster than in R2021b.

function timingTest()
t = table(zeros(1le6,1), ones(1le6,1), nan(le6,1));
indices = randi(le6,1,1e5);
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tic;
% Assign to elements using dot notation and parentheses
for i = indices
t.Varl(i) = rand;
end
toc
end

The approximate execution times are:
R2021b: 5.08 s
R2022a: 1.20 s

The code was timed on a Windows 10, Intel® Xeon CPU W-2133 @ 3.60 GHz test system by calling
each version of the timingTest function.

Classes: Improved performance for static methods, constant property
access, and package functions in scripts

The overhead times for these three actions when performed in scripts are reduced:

» Executing a package function
» Executing a static method
* Accessing a constant property

The overhead times for these actions in a script are now comparable with the times of execution in a
function, and the overheads are small enough that they can generally be ignored for performance
considerations.

This code performs each of these actions 1,000,000 times. (The code called in each loop is shown at
the end of this note.)

tic;
for j = 1:1000000
out = pkgl.pkg2.packageFunction(2);
end
toc;

tic;
for j = 1:1000000
out = MyClass.staticMethod(1);
end
toc;

tic;
for j = 1:1000000
out = pkgl.PackageClass.constantProperty;
end
toc;
The approximate times to complete each loop are:

R2021b:
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* Package function: 8.4 s
* Static method: 7.8 s
* Constant property access: 32 s

R2022a:

» Package function: 0.04 s (210x faster)
» Static method: 0.031 s (252x faster)
* Constant property access: 0.039 s (821x faster)

The code was timed on a Windows 10, Intel Xeon® CPU W-2133 @ 3.60 GHz test system.

For use with the test code, PackageClass must be in folder +pkgl, and packageFunction must be
in folder +pkgl/+pkg2.

function out = packageFunction(in)
out = in;
end

classdef MyClass
methods (Static)
function out = staticMethod(in)
out = in;
end
end
end

classdef PackageClass
properties (Constant)
constantProperty = 3;
end
end

try Block: Improved performance when statements run error-free

The try block shows improved performance when the statements within the block run error-free. For
example, this code is approximately 6x faster than in the previous release:

function testTryPerformance
x =1;
for i = 1:1e8
try
X =X * i
catch
warning("Assignment was not successful.")
X =1;
end
end
end

The approximate execution times are:
R2021b: 2.3 s
R2022a: 0.4 s
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The code was timed on a Windows 10, Intel Xeon CPU E5-1650 v4 @ 3.60 GHz test system using the
timeit function:

timeit(@testTryPerformance)

Python Data Type Conversion: Improved performance when
converting between Python and MATLAB data types in out-of-process
mode

When you run Python code out of process, conversions between Python data types and MATLAB data
types show improved performance.

The timingPythonList function converts a Python 1ist object to a MATLAB cell array. This
code is about 118x faster than in the previous release:

function timingPythonList
1 = py.list(['MATLAB','R",2022,'a"','and',1.2,10"2,
2021,12,25,'2021"','12"','25",'and",
2021,12,25,'2021",'12"','25'1);
tic
ml = cell(l);
toc
end

The approximate execution times are:
R2021b: 1.18 s

R2022a: 0.01 s

The timingPythonDict function converts a Python dictionary object to a MATLAB structure.
This code is about 57.9x faster than in the previous release:

function timingPythonDict
d = py.dict(pyargs('a',1,'b',2,'c",3,'d",4,'e",5,
‘f',6,'9',7,'h",8,'1',9,'5"',10, 'k',11,"'1",12,
‘m',13,'n',14,'0',15,"'p"',16, 'q',17,'r",18,
's',19,'t',20));
tic
ms = struct(d);
toc
end

The approximate execution times are:
R2021b: 0.521 s

R2022a: 0.009 s

The timingDataTransfer function converts an array with 102 elements from a MATLAB double
array to a Python memoryview object and then back to a MATLAB double array. This code is
about 10x faster when converting from MATLAB to Python and approximately 11x faster when
converting from Python to MATLAB than in the previous release:

function timingDataTransfer

data = rand(100,1076);
tic
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pydata = py.memoryview(data);
toc
tic
mdata = double(pydata);
toc
end

The approximate execution times for converting the MATLAB double array to the Python
memoryview object are:

R2021b: 4.0 s
R2022a: 0.4 s

The approximate execution times for converting the Python memoryview object to the MATLAB
double array are:

R2021b: 7.7 s
R2022a: 0.7 s

All of the code was timed on a Windows 10, Intel Core™ i7-10510U CPU @ 1.80 GHz 2.30 GHz test
system by using Python 3.9 in out-of-process mode and calling the timingPythonList,
timingPythonDict, and timingDataTransfer functions.

MATLAB Engine API for Python: Improved performance with large
multidimensional arrays in Python

The Python multidimensional array component used by the MATLAB Engine API for Python shows
improved performance when:

1 Converting data from Python sequences to the data types defined by the matlab module
2 Transferring data back and forth between Python and MATLAB

In both cases, the improvement is noticeable when operating on arrays with at least 10 elements.
When transferring data back and forth, the improvement increases as the size of the array increases.

For example, this Python code measures the execution times of two operations:

1 Converting a Python array of size 102 to a MATLAB double array
2  Summing the elements of the MATLAB array using the MATLAB engine

The first operation is about 12x faster than in the previous release, and the second operation is about
110x faster than in the previous release:

import random

import time

import matlab.engine

eng = matlab.engine.start matlab()

rand array = [random.random() for i in range(10**8)]

sO@ = time.perf counter()

array md = matlab.double(rand array,size=(1, 10**8))

sl = time.perf counter() - sO

print('conversion to matlab.double(): {} seconds'.format(sl))
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sO@ = time.perf counter()

sum _of elems = eng.sum(array md,1)

sl = time.perf counter() - sO

print('sum(): {} seconds'.format(sl))

The approximate execution times for the first operation are:
R2021b: 42 s

R2022a: 3.6 s

The approximate execution times for the second operation are:
R2021b: 210 s

R2022a: 1.9 s

The code was timed on a Windows 10, Intel Xeon CPU E5-1650 v4 @ 3.60 GHz test system by using
Python perf counter() statements.

Matrix multiplication: Improved performance when multiplying sparse
and full matrices

Matrix multiplication shows improved performance when:

* One of the operands is a sparse matrix, and the other is a full matrix.
* The sparse operand has at least 50,000 nonzero elements.
* The full operand has at least 32 columns (or at least 32 rows when transposed).

The performance improvement arises from added support for multithreading in the operation, and
therefore the speedup improves as the matrix size and number of nonzero elements increase.

For example, multiplying a 102,400-by-102,400 sparse matrix with a 102,400-by-128 full matrix on a
machine with 6 physical cores is about 2.7x faster than in the previous release.

function timingSparseDenseMult
A = delsq(numgrid('S"',322));
B = rand(size(A,2),128);

tic

for k = 1:10
C = A*B;

end

toc

end

The approximate execution times are:

R2021b: 0.8 s

R2022a: 0.3 s

The code was timed on a Windows 10, Intel Xeon CPU W-2133 @ 3.60 GHz test system by calling the

timingSparseDenseMult function.
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inv Function: Improved performance when inverting large triangular
matrices

The inv function shows improved performance when operating on large triangular matrices.

For example, inverting a 5,000-by-5,000 upper triangular matrix is about 3.7x faster than in the
previous release.

function timingInv
rng default
A = randn(5e3);

[~,R] = lu(A);
tic

Y = inv(R);
toc

end

The approximate execution times are:
R2021b: 1.1 s
R2022a: 0.3 s

The code was timed on a Windows 10, Intel Xeon CPU W-2133 @ 3.60 GHz test system by calling the
timingInv function.

sprand and sprandn Functions: Improved performance when
generating random sparse matrices

The sprand and sprandn functions show improved performance when generating random sparse
matrices if the number of nonzero elements in the output is larger than the number of rows.

For example, generating a 10,000-by-10,000 matrix with 10% density of nonzero elements is about
2.5x faster than in the previous release.

function timingSprand
n = le4;

d =0.1;

rng default

tic

sprand(n,n,d);

toc

end

The approximate execution times are:
R2021b: 2.7 s
R2022a: 1.1s

The code was timed on a Windows 10, Intel Xeon CPU W-2133 @ 3.60 GHz test system by calling the
timingSprand function.
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fzero Function: Improved performance

The fzero function shows improved performance for objective functions specified as function
handles. This improvement is most noticeable for functions that take little time to evaluate. The
following example, which solves for 1e5 roots of a simple function, takes less than one third of the
time of the previous release:

N = 1e5;

rng default

levels = 1.5*rand(N,1);
out = zeros(N,1);

tic
for i = 1:N
out(i) = fzero(@(x)myfun(x,levels(i)), [0 21);
end
toc

function u = myfun(x,lv)
u = x*sin(x) - 1lv;
end

The approximate execution times are:
R2021b: 5.83 s
R2022a: 1.66 s

The code was timed on a Windows 10, Intel Xeon CPU E5-1650 v4 @ 3.60 GHz test system by running
the above script.

diff Function: Improved performance with large number of elements

The diff function shows improved performance when operating on vectors with at least 103
elements or when operating along the first or second dimension of matrices and multidimensional
arrays with at least 5 x 10° elements.

For example, this code creates a double array with 2.5 x 107 elements and calculates differences
between adjacent elements. It is approximately 2.4x faster than in the previous release.

function timingDiff
rng default

5000;

rand(N) ;

The approximate execution times are:
R2021b: 2.43 s
R2022a: 1.00 s
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The code was timed on a Windows 10, Intel Xeon CPU E5-1650 v4 @ 3.60 GHz test system by calling
the timingDiff function.

groupsummary, groupfilter, and grouptransform Functions: Improved
performance with small group size

Grouping functions groupsummary, groupfilter, and grouptransform show improved
performance, especially when the data count in each group is small.

For example, this code performs group summary computations on a matrix with 500 groups with a
count of 10 each. It is about 2.18x faster than in the previous release.

function timingGroupsummary
data = (1:5000)"';
groups = repelem(l:length(data)/10,10)";
p = randperm(length(data));
data = data(p);
groups = groups(p);
tic
for k = 1:300
G = groupsummary(data,groups, "mean");
end

toc
end

The approximate execution times are:
R2021b: 2.14 s
R2022a: 0.98 s

The code was timed on a Windows 10, Intel Xeon CPU E5-1650 v4 @ 3.60 GHz test system by calling
the timingGroupsummary function.

nufftn Function: Improved performance with nonuniform sample
points or query points

The nufftn function shows improved performance when operating on either nonuniformly spaced
sample points or nonuniformly spaced query points.

For example, this code constructs a 32,768-by-3 matrix of nonuniform sample points t and calculates
the nonuniform discrete Fourier transform along each dimension of a 32-by-32-by-32 array. The code
is about 14.5x faster than in the previous release.

function timingSamplePoints
rng default
t = rand(3273,3);
X = rand(32,32,32);
tic
Y = nufftn(X,t);
toc
end

The approximate execution times are:
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R2021b: 2.76 s
R2022a: 0.19 s

The code was timed on a Windows 10, Intel Xeon CPU E5-1650 v4 @ 3.60 GHz test system by calling
the timingSamplePoints function.

As another example, this code constructs a 65,536-by-3 matrix of nonuniform query points f and
calculates the nonuniform discrete Fourier transform along each dimension of a 64-by-32-by-32 array.
The code is about 42.6x faster than in the previous release.

function timingQueryPoints
rng default
f = rand(64*32*32,3);
X = rand(64,32,32);
tic
Y = nufftn(X,[],f);
toc
end

The approximate execution times are:
R2021b: 4.26 s
R2022a: 0.10 s

The code was timed on a Windows 10, Intel Xeon CPU E5-1650 v4 @ 3.60 GHz test system by calling
the timingQueryPoints function.

Variables Editor and Live Editor: Improved speed of data display when
scrolling

For text and datetime data types in the Variables editor or in the generated output of the Live Editor,
the performance of vertical and horizontal scrolling is improved. Displayed data is optimized and the
rendering mechanism is faster, so data appears more quickly after scrolling in R2022a than in
previous releases.

For example, on a Windows 10, Intel Xeon CPU E5-1650 v4 @ 3.60 GHz test system, when you scroll
through a timetable with 3000 rows, the displayed data renders more quickly in R2022a than in
R2021b.

App Building: Improved performance when creating Ul components

Creating UI components is faster in R2022a than in R2021b. As a result, apps start up faster when
you run them. This improvement is more noticeable for apps with many UI components.

For example, this code measures the time it takes to create 500 edit field components. The code is
about 1.25x faster than in the previous release.

function timingApp

fig = uifiqure;

gl = uigridlayout(fig,Scrollable="on");
gl.RowHeight = repmat({'fit'},1,50);
gl.ColumnWidth = repmat({'fit'},1,10);
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drawnow

tic

for k = 1:500
uieditfield(gl);

end

drawnow

toc

end

The approximate execution times are:
R2021b: 7.5 s
R2022a: 6.0 s

The code was timed on a Windows 10, Intel Xeon CPU E5-1650 v4 @ 3.60 GHz test system by calling
the timingApp function.

uitable Function and Ul Containers: Improved performance when
updating properties successively

Updating property values for certain Ul components and containers is faster in R2022a than in
R2021b. This performance improvement applies to table Ul components created using the uitable
function, Ul containers created using the uipanel, uibuttongroup, uitab, and uitabgroup
functions, and custom UI components created using the ComponentContainer base class, when
these objects are parented to a figure created using the uifigure function.

For example, this code creates a table Ul component and then updates the table cell values for 1000
cells. The code is about 5.2x faster than in the previous release.

function timingTableUpdates

fig = uifigure;

tbl = uitable(fig,"Data", rand(1000,15));
drawnow

tic

for k = 1:1000
tbl.Data(k,1) = 0;

end

drawnow

toc

end

The approximate execution times are:
R2021b: 2.6 s
R2022a: 0.5 s

The code was timed on a Windows 10, Intel Xeon CPU E5-1650 v4 @ 3.60 GHz test system by calling
the timingTableUpdates function.
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Ul Components: Improved performance when setting a property with
an unchanged value

Setting a property value of a Ul component when the value is unchanged is faster in R2022a than in
R2021b. This speed increase leads to improved performance in apps that update many UI component
properties at once, even if not all property values have changed.

For example, this code sets the Value property of an edit field to the same value 1000 times. The
code is about 23x faster than in the previous release.

function timingValueSet

fig = uifigure;

ef = uieditfield(fig);

drawnow

tic

for k = 1:1000
ef.Value = "Text";
drawnow

end

toc

end

The approximate execution times are:

R2021b: 2.3 s

R2022a: 0.1 s

The code was timed on a Windows 10, Intel Xeon CPU E5-1650 v4 @ 3.60 GHz test system by calling

the timingValueSet function.

App Designer: Improved performance when loading apps with UlAxes
components off the canvas

In App Designer, apps with UIAxes components that lie partially or fully off the canvas in Design
View have these performance improvements:

* The app loads faster when you open it.
* The UIAxes components update faster in response to property edits.

The speed increase improves as the number of UTAxes components that lie off the canvas increases.
For example, create an app in App Designer using these steps:

1 Drag five UIAxes components onto the canvas.
2 Drag each of the axes components so that they lie partially off the canvas.
3 Save and close the app.

Reopen the app. The time it takes for App Designer to fully load the app is about 5.2x faster than in
the previous release.

The approximate load times are:
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R2021b: 10.5 s
R2022a: 2 s

Once the app is fully loaded, select a UIAxes component and change its title in the Property
Inspector. The property updates almost instantaneously. In the previous release, the property update
takes approximately 2 seconds.

These interactions were timed on a Windows 10, Intel Xeon CPU E5-1650 v4 @ 3.60 GHz test system.

Plots in Apps: Improved responsiveness for event-driven updates in
apps

Apps that involve continuous event-driven updates, such as animations implemented with a timer, are
more responsive to those events. To observe the improvement, the animation must be created in an
app or in a figure created with the uifigure function. For example, an app containing an animation
controlled by a timer object is more responsive when you call the timer’s start and stop methods.

This code creates an app using a timer object to plot a random number every 0.01 second. If you run
this app on a Windows 10, Intel Xeon CPU W-2133 @ 3.60 GHz test system, the animation responds
more quickly when you click the Start/Stop button than in the previous release.

function mytimerapp

uif = uifigure("CloseRequestFcn",@CloseRequest);

uibutton(uif,"State","Position",[235 59 100 22],
"ValueChangedFcn",@StateButtonChanged, "Text","Start/Stop");

ax = uiaxes(uif,"Position",[25 100 508 300]1,"XDir","reverse");

% Create initial plot line

p = plot(ax,0:60,zeros(1,61));

% Create timer object

RandTimer = timer(...
"ExecutionMode", "fixedRate",
"Period",0.01,
"BusyMode", "queue",
"TimerFcn",@RandTimerFcn);

% Timer function

function RandTimerFcn(~,~,~)
% Generate a random number and update plot line
ydata = p.YData;
ydata = circshift(ydata,l);
ydata(l) = rand;
p.YData = ydata;

end

% State button callback function
function StateButtonChanged(obj,~)
switch obj.Value
case 0
stop(RandTimer);
case 1
% If timer is not running, start it
if strcmp(RandTimer.Running, "off")
start(RandTimer);
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end
end
end
% Figure close request function
function CloseRequest(~,~)
% Stop timer, then delete timer and figure

stop(RandTimer);
delete(RandTimer);
delete(uif);
end
end
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Plots in Apps: Improved responsiveness of axes interactions within
apps

Responsiveness is improved for panning, rotating, and zooming into a region of interest within a plot.
To observe the improvement, the plot must be created in an app or in a figure created with the
uifigure function. The improvement is most noticeable for plots with large numbers of points, or
those that involve complex effects such as lighting, transparency, or texture maps. Systems equipped
with modern GPUs are more likely to show the improvement.

For example, create a 3-D scatter plot with 200,000 points. If you run this code on a Windows 10,
Intel Xeon CPU W-2133 @ 3.60 GHz test system with an NVIDIA Quadro® P620 GPU, and then drag to

rotate the plot, the rotation is smoother and responds more quickly to the drag gesture than in the
previous release.

linspace(0,4*pi,200000);
2*cos(z) + rand(1,200000);
2*sin(z) + rand(1,200000);
uifigure; a = axes(f);
catter3(a,x,y,z,"filled")

n —+Hh< X N

1-51



R2022a

1-52

Plots in Apps: Improved responsiveness of axes interactions in plots
with two y-axes

Responsiveness is improved for panning, rotating, and zooming into a region of interest within a
UIAxes or Axes object in MATLAB Online that contains a chart created with yyaxis and a legend.
For such charts, updates are faster, and interactions are smoother in R2022a than in the previous
release.

For example, create a UIAxes object with two y-axes and a legend. If you run this code on a Windows
10, Intel Xeon CPU E5-1650 v4 @ 3.60 GHz test system, when you drag the cursor to pan the view of
a UIAxes object, the axes pan faster and track the cursor more closely in R2022a than in R2021b.

f = uifigure;

a = uiaxes(f);
plot(a,1:100,rand(1,100));
yyaxis(a,"right");
plot(a,1:100,linspace(1,10,100));
legend(a);
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Plots in Apps: Faster animations in apps when multiple figures are
open

Animations show improved performance in apps when multiple figures are open. To observe the
improvement, all figures must be created with the uifigure function.

For example, this code opens 10 empty figures and an additional figure containing a plot. The plot
displays one marker that traces the path of a line at every iteration of a loop. The loop is about 6x
faster than in the previous release.

function movingmarker

% Open 10 empty figures

for n = 1:10
uifigure("Position",[10+n*3 10+n*3 200 200]);
end
% Create a figure and a plot with one marker
uifigure;

C
if =
= llnspace(O 10,200);
= sin(x);
X = axes(uif);

= plot(ax,x,y,"-0","MarkerIndices",1);

% Move the marker along the sine wave
tic
for idx = 2:200
p.MarkerIndices = idx;
drawnow
end
toc
end
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The approximate execution times for the loop are:
R2021b: 32.6 s
R2022a: 5.4 s

The code was timed on a Windows 10, Intel Xeon CPU W-2133 @ 3.60 GHz test system by calling the
movingmarker function.

Property Inspector: Improved performance when opening for the first
time

The Property Inspector for a figure window shows improved performance when opening for the first
time in a MATLAB session. The delay between clicking the Property Inspector icon or calling
inspect and the inspector being ready is reduced. The improvement is most noticeable as the plot in
the figure window becomes more complex.

For example, open the Property Inspector for a plot of a 5-by-5 matrix by calling inspect. If you run
this code on a Windows 10, Intel Xeon CPU E5-1650 v4 @ 3.60 GHz test system, you can use the
Property Inspector sooner in R2022a than in R2021b.

r = rand(5,5);
p = plot(r);
inspect(p)
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Projects: Reduce test runtime in continuous integration workflows
using the dependency cache

You can now specify where your project stores the dependency analysis results. In agile development
workflows that use Git™ and a continuous integration (CI) server, share the dependency cache file
(.graphml) to run an incremental dependency analysis and reduce the test suite runtime. See
“Continuous Integration Using MATLAB Projects and Jenkins”.

To set the project dependency cache file, on the Project tab, in the Environment section, click
Details. In Dependency cache file, browse to and specify a GraphML file. If the cache file does not
exist, the project creates it for you.

Alternatively, you can create and set the project dependency cache programmatically:

matlab.project.example.timesTable
proj = currentProject;
proj.DependencyCacheFile = "myProjectCacheFile"

Dependency Analyzer: Save dependency graph as image

You can now save the dependency analysis results as an image. See “Export Dependency Analysis
Results”.

Code Compatibility Analyzer App: Identify and address compatibility
issues against current version of MATLAB

The MATLAB Code Compatibility Report is now available as an app. You can access the Code
Compatibility Analyzer from the apps gallery in MATLAB or from the command line using
codeCompatabilityAnalyzer. For more information, see “MATLAB Code Compatibility Analyzer”.

Unit Testing Framework: Create test classes interactively using the
Current Folder browser

You can now create a test class using the Current Folder browser in MATLAB and MATLAB Online. To
create a new test class, right-click in the Current Folder browser and then select New > Test Class.

Unit Testing Framework: Create temporary folders that are
automatically removed

The matlab.unittest.TestCase class has a new method createTemporaryFolder that creates

a temporary folder for your tests. The lifecycle of the folder is tied to the test case. Once the test case
goes out of scope, the testing framework removes the folder.
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Unit Testing Framework: Generate DOCX, HTML, and PDF reports after
test execution

The matlab.unittest.TestResult class has three new methods that enable you to generate
various test reports from test results. You can run your tests and collect the test results, and then
generate test reports from part or all of your results:

* To generate a DOCX report from the test results, use the generateDOCXReport method.
* To generate an HTML report from the test results, use the generateHTMLReport method.
» To generate a PDF report from the test results, use the generatePDFReport method.

With this feature, you are no longer required to run tests using a TestReportPlugin instance. For
example, run your tests and then generate an HTML report from the test results. Save the report as
report.html in a folder named myResults.

suite = testsuite("MyTestClass");

runner = testrunner;

results = run(runner,suite);

generateHTMLReport(results, "myResults",MainFile="report.html")

Unit Testing Framework: Debug uncaught errors in tests

Starting in R2022a, when a test runner with a StopOnFailuresPlugin instance encounters an
uncaught error, MATLAB enters debug mode at the source of the error and lets you use debugging
commands to investigate the cause of the error. In previous releases, while the plugin stops the test
run to report the error, debugging capabilities are limited because the error disrupts the stack.

Unit Testing Framework: Collect statement and function coverage
metrics for your source code

Starting in R2022a, when you generate an HTML code coverage report using the CoverageReport
format, the report displays statement and function coverage metrics:

* Use statement coverage to see whether every MATLAB statement in your source code is executed
at least once.

* Use function coverage to see whether every function in your source code is called at least once.

In previous releases, you can generate only line coverage metrics for your source code. Compared to
line coverage, statement and function coverage provide a more detailed analysis of the source code
covered by the tests.

Functionality being removed or changed

pack function will be removed in a future release
Warns

The pack function will be removed in a future release. There is no replacement for this function
because you do not need to use it on a 64-bit system. For more information about strategies for
reducing memory usage, see “Strategies for Efficient Use of Memory” and “Resolve “Out of Memory”
Errors”.
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matlab.unittest.TestSuite.fromFolder includes tests from package folders when creating a
test suite
Behavior change

Starting in R2022a, the matlab.unittest.TestSuite. fromFolder method treats folders and
packages the same way, and includes tests defined within package folders when creating a test suite.
For example, suite =
matlab.unittest.TestSuite.fromFolder(pwd,IncludingSubfolders=true) creates a suite
from all the test files in the current folder and any of its subfolders, including package folders. In
previous releases, the method ignores any tests defined in a package folder and its subfolders.

This behavior change also applies to the testsuite, runtests, and runperf functions when they
operate on a folder containing tests. With the consistent treatment of folders and packages, creating
a suite from all test files within a folder and its subfolders becomes more convenient and independent
of the folder structure.

To exclude tests defined within packages, filter the suite being constructed or returned by
fromFolder. For example, create a filtered test suite comprising tests whose names do not include
any dots (that is, do not refer to any packages).

import matlab.unittest.TestSuite

import matlab.unittest.selectors.HasName

import matlab.unittest.constraints.ContainsSubstring

suite = TestSuite.fromFolder(pwd,HasName(~ContainsSubstring(".")),
IncludingSubfolders=true);

builddocsearchdb creates searchable database with new name
Behavior change

When building a searchable documentation database for custom toolboxes, the builddocsearchdb
function now creates the subfolder helpsearch-v4 to contain the search database files. Previously,
builddocsearchdb created a subfolder named helpsearch-v3.

To ensure the documentation for the custom toolbox is searchable in R2022a, run
builddocsearchdb against your help files using MATLAB R2022a. Maintain the helpsearch-v4
subfolder containing the search database files created in R2022a and the helpsearch-v3 subfolder
containing the search database files created in previous releases side by side. Then, when you run
any MATLAB release, the Help browser automatically uses the appropriate database for searching
your documentation.
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C++ Interface: Array size help text for functions and methods

If a function or method takes a clib or MATLAB array, the generated help text displays size
information for the argument. For more information, see “Array Size Help for Functions and
Methods”.

C Interface: Build third-party C library interface using
clibgen.generateLibraryDefinition

Create interfaces for libraries with C files that are built with C compilers using
clibgen.generatelLibraryDefinition. Use this function to get the benefits of publishing an
interface as described in “Build MATLAB Interface to C++ Library” instead of calling the
loadlibrary function described in “Call C from MATLAB”.

For information about using clibgen.generatelLibraryDefinition with C files, see Files in
Your Library under the “Tips” section. To build an interface to C libraries, use the CLinkage name-
value argument.

C++ Interface: Support for C++ language features

The C++ interface supports these additional C++ language features.

* std::complex support for complex scalars and arrays for fundamental types of double, float,
int8, uint8, intl6, uintl6, int32, uint32, int64, and uint64. For information about
mapping these types to MATLAB data, see “Numeric Types”.

* Box array parameters with multiple dimensions. For example, the input to this function is a 2-D
array mat of size len-by-typeSz.

void readMatrix2DArr(int const [] mat, size t len, size t typeSz)

You can specify the SHAPE of the argument as ["len", "typeSz"]. For more information, see
“Define Missing SHAPE Parameter”.

 std::vector as data member.

C++ Interface: Publisher options

The C++ interface supports these build configuration features.

* Specify compiler and linker flags used to build an interface. Use the AdditionalCompilerFlags
or AdditionalLinkerFlags name-value arguments in
clibgen.generatelLibraryDefinition or clibgen.buildInterface to pass flags to the
compiler and linker. These functions do not validate the flags. The publisher needs to know how
the flags affect the build process. For more information, see “Build C++ Library Interface and
Review Contents”.

* Build an interface using a specific compiler standard. For example, to build a library defined by
A.hpp with C++17, type:

clibgen.generateLibraryDefinition("A.hpp",AdditionalCompilerFlags="-std=c++17")
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For more information, see “Specify C++ Compiler Standard”.

+ Include static libraries with . a file extension on Linux® and macOS platforms, and on Windows if
the library is compiled with a supported MinGW® compiler. To include a static library, use the
Libraries name-value argument in clibgen.generatelLibraryDefinition or
clibgen.buildInterface.

Call MATLAB from C++: Generate C++ code Interface for MATLAB
Packages, Classes, and Functions

The matlab.engine.typedinterface.generateCPP creates a C++ header file from MATLAB
packages, classes, and functions. For more information, see “What is Strongly Typed Interface for C+
+?”,

MATLAB Data Array API: matlab::data::Array support for row-major
order

The MATLAB data array API supports iterating through the data of a matlab: :data: :Array in
either row-major or column-major order. For information about specifying the layout when creating
an array, see the inputLayout parameter for createArray. For information about iterating
through an array, see matlab: :data: :ColumnMajor,
matlab::data::ColumnMajorIterator<T>, matlab::data::RowMajor, and
matlab::data::RowMajorIterator<T>.

MEX Functions: UTF-8 system encoding on Windows platforms

MATLAB now uses UTF-8 as its system encoding on Windows, completing the adoption of Unicode
across all supported platforms. System calls made from within a MEX file take and return UTF-8
encoded strings. If your MEX file contains code or links to third-party libraries that assume a different
system encoding, then you might see garbled text and thus need to update the code to be Unicode
compliant.

Python: Use Name=Value syntax to pass keyword arguments to
Python functions

You can use MATLAB Name=Value syntax as an alternative to the pyargs function to pass keyword
arguments to Python functions. However, do not mix Name=Value arguments with the use of the
pyargs function.

MATLAB does not support Name, Value syntax for passing keyword arguments.

Python: Convert Python list and tuple types to MATLAB types

You can convert Python list and tuple types using MATLAB string and numeric converters. For
details, see the py.list and py.tuple entry in the “Explicitly Convert Python Types to MATLAB
Types” table. For examples, see “Use Python list Variables in MATLAB” and “Use Python tuple
Variables in MATLAB”.

Conversion functions might not work on lists or tuples that contain elements which cannot be
converted to the requested type:
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double(py.list({3.0, 'MATLAB'}))

Error using py.list/double
Conversion of Python element at position 2 to type 'double' failed. All
Python elements must be convertible as scalar to the requested type.

Related documentation

For the related documentation, see “Error Converting Elements of list or tuple”.

Perl 5.34.0: MATLAB support on Windows

As of R2022a, MATLAB on Windows ships with an updated version of Perl, version 5.34.0.

Version History

If you use the perl command on Windows platforms, see https://www.perl.org/ for information about
using this version of the Perl programming language.

Compilers: Support for Microsoft Visual Studio 2022

As of R2021b Update 3, MATLAB supports Microsoft Visual Studio® 2022 for building C and C++
interfaces, MEX files, and standalone MATLAB engine and MAT-file applications.

Functionality being removed or changed

Python: Version 3.7 is no longer supported
Errors

Support for Python version 3.7 is discontinued. For continued support for your applications, upgrade
to a supported version of Python. For supported version information, see Versions of Python
Compatible with MATLAB Products by Release.

MEX file macro FORTRAN_COMPLEX_FUNCTIONS_RETURN_VOID has been removed
Behavior change

For MEX files built in R2021b and earlier, MATLAB provided a macro,

FORTRAN COMPLEX FUNCTIONS RETURN VOID, to handle platform-dependent calling syntax
differences for passing complex numbers to Fortran BLAS and LAPACK functions. As of R2022a, you
no longer need a different calling syntax on different platforms, and the macro for handling this
difference has been removed.

To update your code, replace statements such as these using
FORTRAN COMPLEX FUNCTIONS RETURN VOID:

/* Call BLAS function */
/* Use a different call syntax on different platforms */
#ifdef FORTRAN_COMPLEX FUNCTIONS RETURN VOID
zdotu(&result, &nElements, zinA, &incx, zinB, &incy);
#else
result = zdotu(&nElements, zinA, &incx, zinB, &incy);
#endif

with:


https://www.perl.org/
https://www.mathworks.com/content/dam/mathworks/mathworks-dot-com/support/sysreq/files/python-compatibility.pdf
https://www.mathworks.com/content/dam/mathworks/mathworks-dot-com/support/sysreq/files/python-compatibility.pdf

External Language Interfaces

/* Call BLAS function */
zdotu(&result, &nElements, zinA, &incx, zinB, &incy);

See dotProductComplex.c.

NET.addAssembly no longer removes leading spaces for Windows drive letter paths
Behavior change

Before R2022a, on Windows platforms, the NET.addAssembly function removed leading spaces in
paths specifying the drive letter. If the full path to your assembly is invalid with leading spaces, then
remove the spaces before calling NET.addAssembly.
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Editor Selection: Select and edit a rectangular area of code

In the Editor, you now can select a rectangular area in your code (also known as column selection or

block edit) by pressing the Alt key while making a selection with the mouse. On macOS systems, use

the Option key instead. Selecting and editing a rectangular area of code is useful if you want to copy
or delete several columns of data, or if you want to edit multiple lines at one time.

For example, select the second column of data in A.

A= [le Bl 22 42 58;
0B s S8 98 1e;
11e pkelsl 138 14 158 ];

Type 0 to set all the selected values to 0.

A=1[12¢ 30 48 s58; ...
60 ¢ se 9e 1e@; ...
112 @ 122 140 150 ];

Editor Display: Zoom in and out in the Editor

To zoom in or out in the Editor, go to the View tab, and in the Zoom section, select the ‘%, Zoom In

or =4 Zoom Out button. As you zoom, MATLAB displays the current scale in the bottom-right corner
of the Editor. You also can hold the Ctrl key and move the scroll wheel, or press Ctrl+Plus and Ctrl
+Minus. On macOS systems, use the Command key and move the scroll wheel, or press Command
+Shift+Plus and Command+Shift+Minus.

To return to the default scale, in the View tab Zoom section, select ':’-'{ Reset Zoom. You also can
press Ctrl+Alt+0 (Command+Alt+0 on macOS).

Editor Code: Show code suggestions and completions automatically

Starting in R2021b, when you write commands in the Editor, MATLAB automatically displays
contextual hints for arguments, property values, and alternative syntaxes. In previous releases,
MATLAB only completes names in the Editor after a Tab key press.

For example, if you want to use the size function, MATLAB automatically displays the syntax
information to help you write the command as you type.



Environment

sizeﬂ]

(@) | size(a,dim) 1ofd4 -

Input array
scalar | vector | matrix | multidimensional array

MATLAB also automatically suggests and completes the names of functions, models, MATLAB objects,
files, folders, variables, structures, graphics properties, parameters, and options.

You can disable automatic completions in the Editor and Live Editor by having MATLAB suggest and
complete names only after you press the Tab key. To do so, on the View tab, in the Display section,
click the |§_. Automatic Completions button off. You also can go to the Home tab, and in the
Environment section, click @ preferences. Then, select Editor/Debugger > Automatic
Completions and in the Suggestions and completions section, select Show on tab.

For more information, see Check Syntax as You Type.

Editor Debugging: Diagnose problems in scripts and functions using
inline debugging controls and a breadcrumb-style function call stack

When debugging code in the Editor, you now can diagnose problems using inline debugging controls.

For example, to run to a specific line of code and then pause, click the [*ll button to the left of the line.
n = 5g;

(] r = randin,1};

plot{ry
Run to Here

hold on

plet{[@,n],[m,m]}

hold off

title('Mean of Random Uniform Data®)

i G s e

O oa

To step into a file, click the = button directly to the left of the function you want to step into. After

stepping in, click the < button at the top of the file to run the rest of the called function, leave the
called function, and then pause.

By default, the = button only appears for user-defined functions and scripts. To show the button for

MathWorks® functions as well, on the Home tab, in the Environment section, click @
Preferences. Then, select MATLAB > Editor/Debugger, and in the Debugging in the Live Editor
section, clear the Only show Step in button for user-defined functions option.

When you step into a called function or file, the Editor displays an improved breadcrumb-style list of
the functions MATLAB executed before pausing at the current line (also called the function call
stack). The function call stack is shown at the top of the file and displays the functions in order,
starting on the left with the first called script or function, and ending on the right with the current
script or function in which MATLAB is paused.
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plotRand » | mean (-
For more information, see Debug MATLAB Code Files.

Editor Refactoring: Automatically convert selected code to a function

Break large scripts or functions into smaller pieces by converting selected code into functions in files
or local functions. With one or more lines of code selected, on the Editor tab, in the Code section,

click the 4% Refactor button, and then select from the available options. MATLAB creates a function
with the selected code and replaces the original code with a call to the newly created function.

Editor Code: Automatically complete block endings, match delimiters,
and wrap comments while editing code

MATLAB now automatically completes parentheses and quotes when you enter code in the Editor. For
example, if you type an open parenthesis in the Editor, MATLAB automatically adds the closing
parenthesis. MATLAB also automatically completes comments, character vectors, strings, and
parentheses split across two lines.

You also can have MATLAB automatically complete block endings. To do so, on the Home tab, in the

Environment section, click @ Ppreferences. Select Editor/Debugger > Automatic Completions
and in the Autocoding options section, select one or more of the Autocomplete block endings
options.

To undo an automatic code completion, press Ctrl+Z or the Q@ Undo button. To disable automatic
code completions, in the Editor/Debugger > Automatic Completions preferences, clear one or
more of the options in the Autocoding options section.

Editor Sections: Create sections with an improved appearance

Starting in R2021b, sections in the Editor have an improved appearance. To create a new section, go
to the Editor tab and in the Section section, click the Section Break button. The new section is
highlighted with a blue border, indicating that it is selected.

%X Calculate and Plot Sine Wave &
¥ Define the range for x.
% Calculate and plot v = sin(x).
X = B:1:6%pi;
y = sin{x);
6 plot{x,y)

%X Modify Plot Properties

g title('Sine Wave')

18 xlabel( ="}

11 ylabel( 'sin(x}")

12 fig = gcf;

13 fig.MenuBar = "none’;


https://www.mathworks.com/help/releases/R2021b/matlab/matlab_prog/debugging-process-and-features.html
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To maximize the space available for editing code in the Editor, you can hide the Run to Here and Code
Folding margins. This minimizes the gray area to the left of your code. To hide the two margins, right-
click the gray area to the left of your code and clear the Show Run to Here Margin and Show Code
Folding Margin options.

1 #% Calculate and Plot Sine Wave o
2 ¥ Define the range for x.

3 ¥ Calculate and plot y = sin(x).
a4 ® o= B:1:6%pi;

g ¥y = sin{x);

6 plot{x,y)

3 %% Modify Plot Properties

9 title('Sine Wave')
18 xlabel( 'x")

11 ylabel( sin(x)")

12 fig = gcf;

13 fig.MenuBar = "none’;

As part of this change, the options for changing the appearance of code sections in the Editor have
been removed. These options were previously available in the MATLAB > Colors > Programming
Tools preferences, in the Section display options section.

For more information about sections in the Editor, see Create and Run Sections in Code.

Editor Code: Change the case of text and code

You can change the case of selected text or code in the Editor from all uppercase to lowercase, or
vice versa. To change the case, select the text, right-click, and select Change Case. You also can
press Ctrl+Shift+A to change the case. If the text contains both uppercase and lowercase text,
MATLAB changes the case to all uppercase.

Editor Bookmarks: Maintain bookmarks after closing a file

Starting in R2021b, MATLAB maintains all bookmarks after you close a file in the Editor. In previous
releases, MATLAB does not maintain bookmarks after closing a file.

For more information, see Go To Location in File.

Live Editor Controls: Set default values for sliders, drop-down lists,
check boxes, and edit fields

You can set the default values for sliders, drop-down lists, check boxes, and edit fields in your live
scripts. To set the default value for a control, right-click the control and select Configure Control.
Then, in the Defaults section, specify a default value by entering the value or by selecting a

workspace variable from the list. The list shows only valid variables for the control. For drop-down
lists, select the default value from the list of items.

To restore the default value for a control, right-click the control and select Restore Default Value.
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For more information, see Add Interactive Controls to a Live Script.
Live Editor Animations: Export animations to movies or animated GIFs

Export animations to movies or animated GIFs using the new 3 Export Animation button in the Live
Editor animation playback controls. The Export Animation button is not supported for animations
generated by the movie function.

For example, this code animates a line growing as it accumulates 2000 data points in the Live Editor.

When the animation is done playing, playback controls, including the new = Export Animation
button, display within the figure window.

h = animatedline;
axis ([0 4*pi -1 1])
x = linspace(0,4*pi,2000);

for k

1:length(x)
y = sin(x(k))

addpoints(h,x
drawnow

(K),y);

end
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For more information about creating animations, see Animation Techniques.

Live Editor Figures: Interact with real MATLAB figures and resize them
with improved layouts

Live Editor output figures are now real MATLAB figures with most of the interaction capabilities of
standalone MATLAB figures. In addition, when you resize a figure in the Live Editor, the font sizes

and spacing between elements in the figure now automatically adjust to provide the best possible
presentation for the new size.


https://www.mathworks.com/help/releases/R2021b/matlab/matlab_prog/add-interactive-controls-to-a-live-script.html
https://www.mathworks.com/help/releases/R2021b/matlab/ref/movie.html
https://www.mathworks.com/help/releases/R2021b/matlab/creating_plots/animation-techniques-1.html
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Live Editor: Improved performance when saving live scripts or
functions

Saving live scripts and live functions in the Live Editor is faster in R2021b than in R2021a. The

improvement is most noticeable when you save live functions with more than 1000 lines of code and
live scripts with fewer than 100 lines of code.

For example, on a Windows 10, Intel Xeon E5-1650 CPU @ 3.60 GHz test system, saving an example
live function containing 4000 lines of code takes approximately 2.05 seconds in R2021b. In R2021a3,
saving the same live function takes approximately 2.57 seconds.

Comparison Tool: Compare and merge text files with improved

usability, appearance, and syntax highlighting

In R2021b, the comparison tool uses MATLAB Editor syntax highlighting. Text changes and merge
choices are now easier to understand. Changes are highlighted with strong colors. Modified lines are

highlighted and flagged with the comparison icons 1, H or . Merging line by line is

straightforward, and merge choices are flagged with the merge content icon o=

20 % Find input indices that are not line objects

21 nothandle = ~ishandle(hline);
for nh = 1:pred(size(hline))
notline(nh) = ~ishandle(hline(nh)) || ~Stremp('line',lower(get(hline(nh), type'}));

24 end

26 len = zeros(size(hline));

it i i

4\ lengthofline.m vs. lengthofline2.m — m} s
COMPARISON
4} ¢4> Swap Sides 7 & 8
s (S BEE= Filter Save  Retumto
(4 Find - - Result Comparison
NAVIGATE FILTER | CHANGES FINISH
lengthefline.m v lengthofline2_modified m * (Result) -
H 1 function [len,dims] = lengthofline(hline) =] H 1 function [len,dims] = lengthofline2(hline)
2 %LENGTHOFLINE Calculates the length of a line object 2 %LENGTHOFLINE Calculates the length of a line object
3 % LEN = LENGTHOFLINE(HLIME) takes the handle to a line object as the 3 % LEN = LENGTHOFLINE(HLINE) takes the handle to a line object as the
4 % dinput, and returns its length. The accuracy of the result is directly 4 % input, and returns its length. The accuracy of the result is directly
5 % dependent on the number of distinct points used to describe the line. 5 % dependent on the number of distinct points used to describe the line.
6 % 5 %
7 % [LEN,DIM] = LENGTHOFLIME(HLIME) additionally tells whether the line is 7 % [LEN,DIM] = LENGTHOFLINE(HLINE) additionally tells whether the line is
8 % 2D or 3D by returning either a numeric 2 or 3 in DIM. A line in a 8 % 2D or 3D by returning either a numeric 2 or 3 in DIM. A line in a
9 % plane parallel to a coordinate plane is considered 2D. 9 % plane parallel to a coordinate plane is considered 2D.
10 % 18 %
11 % If HLINE is a matrix of line handles, LEN and DIM will be matrices of results. 11 % If HLINE is a matrix of line handles, LEN and DIM will be matrices of results.
12| % 12| %
13 % Example: 13 % Example
14 4 figure; h2 = plot3(1:18,rand(1,18),rand(18,5)); 14 % figure; h2 = plot3(1:18@,rand(1,1@),rand(16,5));
15 % hold on; h1 = plot(1:1@,rand(1@,5)); 15 % hold on; h1 = plet(1:1e,rand(18,5));
16 % [1len,dim] = lengthofline([h1 h2]) 16 % [len,dim] = lengthofline([h1 h2])
17 17
lg % Copyright 1984-2884 The Mathkiorks, Inc. ng % Copyright 1984-28@5 The Mathliorks, Inc.
%als(cwwsnt n right pane with content in the left pane [ 2087/81/38 @9:24:18 §
19 28

21 % Find input indices that are not line objects
22 nothandle = ~ishandle(hline);
23 notline = false(size(hline));
for nh = 1:numel(hline)
notline(nh) = nothandle(nh) || ~strempi('line’',get(hline(nh), 'type’));
26 end

28 len = zeros(size(hline));

45 29 dim = len;
Hz: for nl = 1:pred(size(hline)}) 45 Hae for nl = 1:pumel(hline)
28 % If it's a line, get the data and compute the length 31 % If it's a line, get the data and compute the length
20 if ~notline(nl) 32 if ~notline(nl)
30 flds = get(hline(nl}); 33 flds = get(hline(nl));
31 fdata = {'XData’,'VData', "IData’}; 314 fdata = {'XData’,'YData', ZData'};
& 35 data - cell(size(fdata));
32 LT » 36 for nd = 1:length(fdata) -
Insertion [l Deletion  [EJ Modification - 16 Differences
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Version History

Starting in R2021b, you no longer can save the comparison report as HTML or specify whether to
show only the differences or the entire files.

Importing Preferences from Previous Releases: MATLAB checks for
preferences from R2019b or newer

During start up, MATLAB checks for a preferences folder that matches the current release. If that
folder is not found, MATLAB checks for preferences folders going back as far as R2019b. Releases
before R2021b continue to check for up to three previous releases.

MATLAB Release Previous Release Preferences Folders
R2021b R2021a, R2020b, R2020a, R2019b
R2021a R2020b, R2020a, R2019b

R2020b R2020a, R2019b, R2019a

Display language: MATLAB uses Windows display language settings
for selecting desktop language

MATLAB uses the Windows display language settings on Windows 10 to control the MATLAB
desktop language. The display language you select on Windows changes the default language used by
Windows features like settings and file explorer.

Prior to R2021b, MATLAB controlled the desktop language using the Windows locale setting which is
managed in the Region settings.

For information about Windows locale settings in MATLAB, see Set Locale on Microsoft Windows
Platforms.

For information about managing display language settings, refer to your Windows 10 documentation.

Functionality being removed or changed

Increment Value and Run Section tool has been removed

The Increment Value and Run Section tool previously available in the Editor has been removed.

To increment a numeric value within a section, use controls in the Live Editor. For example, this code
calculates the factorial of the variable x.

X =5;
y = factorial(x)
y =

120

To interactively change the value of x, in a live script, replace the value 5 with a numeric slider. By
default, MATLAB reruns the current section when the value of the slider changes.


https://www.mathworks.com/help/releases/R2021b/matlab/matlab_env/setting-locale-on-windows-platforms.html
https://www.mathworks.com/help/releases/R2021b/matlab/matlab_env/setting-locale-on-windows-platforms.html
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= 5 3 U 1@ *
y = factorial(x)
y = 128

For more information, see Add Interactive Controls to a Live Script.
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cast Function: Consistent output for all syntaxes with the same data
type conversion

The cast function now returns consistent output for all syntaxes with the same data type conversion.

For example, starting in R2021b, both b = cast(fi(1l), 'like',sym(1l)) andb =

cast(fi(1l), 'sym') return b = 1 of the sym data type. In previous releases, b =

cast(fi(1l), 'like',sym(1)) returns b = 1 of the sym data type, butb = cast(fi(1l), 'sym')
throws an error.

Run Code in the Background: Use parallel language to run code
asynchronously

You can now run code in the background using backgroundPool. When you run code in the
background, you can:

* Run other MATLAB code at the same time as a long running calculation
» Create more responsive user interfaces

Use the background pool with the following parallel language:

* parfeval and related functionality such as afterEach and afterAll
* parallel.pool.DataQueue and related functionality such as afterEach
+ parallel.pool.PollableDataQueue and related functionality such as poll

For more information, see Background Processing.

Portable Parallel Code: Share parallel code and seamlessly run in
parallel

You can now run parallel code even if you do not have Parallel Computing Toolbox™. When you run
portable parallel code without Parallel Computing Toolbox, you run the code in serial on your
machine. When you run this code with Parallel Computing Toolbox, you can automatically scale up
and run the code in parallel on your local machine, on a remote cluster, or in the cloud.

The following parallel language features are available for prototyping:

+ parfeval — Seamlessly run multiple functions at once (since R2021b)
* parfor — Seamlessly run for-loops in parallel (since R2008a)

For more information, see Run Parallel Language in MATLAB.
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https://www.mathworks.com/help/releases/R2021b/matlab/matlab_prog/run-parallel-language-in-matlab.html
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Compact Display for Classes: Customize display of information about
classes when space is limited

Use the matlab.mixin.CustomCompactDisplayProvider class to customize how information
about your classes is displayed in a container variable—such as a struct, cell array, or table—where
space is limited. Options for customization include:

» Displaying partial sets of data

* Adding annotations

* Controlling how and when class names are displayed

For example, an enumeration class of the days of the week, WeekDays, can be customized so that
when arrays of WeekDays members cannot be fully displayed, MATLAB displays the size, the class,
and an annotation. When the width of the Command Window is large enough, the full array is shown:

myStruc =
struct with fields:

propl: [Monday Wednesday Friday Saturday Sunday]

When the Command Window is not wide enough to display the full array, the size, the class, and an
annotation are shown:

myStruc =
struct with fields:

propl: 1x5 Weekdays (Enum of days of week)

Class Aliasing: Create aliases for renamed classes to maintain
backward compatibility

When you need to change a class name, you can create an alias to preserve compatibility with code
written before the name change. The matlab.alias.AliasFileManager class provides an API for
defining and implementing aliases. Once you define an alias, you can use the alias anywhere you use
the class name. Aliases maintain backward compatibility when reloading objects with the old name
into a MATLAB version that uses the new name, as well as forward compatibility when loading
objects saved in a newer version into an older version that predates the definition of the alias.
MATLAB substitutes the new class name whenever it encounters the old name.

Modular Indexing: Customize class indexing operations individually
using new superclasses

To customize how indexing operations behave with your class in previous versions of MATLAB, you
need to overload the subsref and subsasgn methods. Doing so requires implementing code for all
indexing reference and assignment operations, including parentheses, dot, and brace operations,
even if you want to change only one type of indexing operation.

Starting in R2021b, you can inherit from three new superclasses to customize parentheses, dot, and
brace indexing operations individually:

2-11


https://www.mathworks.com/help/releases/R2021b/matlab/ref/matlab.mixin.customcompactdisplayprovider-class.html
https://www.mathworks.com/help/releases/R2021b/matlab/ref/matlab.alias.aliasfilemanager-class.html

R2021b

2-12

* matlab.mixin.indexing.RedefinesParen - Customize parentheses reference, assignment,
and deletion operations.

* matlab.mixin.indexing.RedefinesDot - Customize dot reference and assignment
operations.

* matlab.mixin.indexing.RedefinesBrace - Customize brace reference and assignment
operations.

You can inherit from one or more of these classes without affecting how the other indexing operations
work. These classes also enable you to forward levels of indexing in compound statements to other
MATLAB values. For example, your class can implement custom parentheses indexing for the first
level of a compound reference and then allow MATLAB to apply the other levels to an object
contained by your class.

Scalar Classes: Inherit from the matlab.mixin.Scalar superclass to
ensure instances behave as scalars

Instances of classes that inherit from matlab.mixin.Scalar must behave as scalars. You cannot
form arrays of instances of such a class, including empty arrays, and you cannot concatenate
instances. This class is useful for cases in which concatenation does not make sense, like a dictionary
or other container class in which parentheses indexing is customized to access data in the class, not
to form or access arrays.

startat Function: Time zone information in datetime objects now
supported

The startat function now recognizes time zone and daylight savings time information of datetime
inputs.

Functionality being removed or changed

newclass input argument of the syntax cast(A,newclass) is now case-sensitive
Behavior change

Starting in R2021b, the newclass input argument of the syntax cast (A, newclass) is case-
sensitive. You must specify newclass as a character vector or a string of lowercase letters that
represents the new data type.

For example, to convert a double value to the int8 data type, you must use b =
cast(1.234, 'int8"). The function syntax b = cast(1.234, 'Int8"') now throws an error.

Defining classes and packages: Using schema.m will not be supported in a future release
Still runs

Support for classes and packages defined using schema.m files will be removed in a future release.
Replace existing schema-based classes with classes defined using the classdef keyword.

InexactCaseMatch and InexactCaseMatchForExtension Errors: These errors are replaced by
UndefinedFunction error
Behavior change


https://www.mathworks.com/help/releases/R2021b/matlab/ref/matlab.mixin.indexing.redefinesparen-class.html
https://www.mathworks.com/help/releases/R2021b/matlab/ref/matlab.mixin.indexing.redefinesdot-class.html
https://www.mathworks.com/help/releases/R2021b/matlab/ref/matlab.mixin.indexing.redefinesbrace-class.html
https://www.mathworks.com/help/releases/R2021b/matlab/ref/matlab.mixin.scalar-class.html
https://www.mathworks.com/help/releases/R2021b/matlab/ref/timer.startat.html
https://www.mathworks.com/help/releases/R2021b/matlab/ref/datetime.html
https://www.mathworks.com/help/releases/R2020a/matlab/ref/classdef.html
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The InexactCaseMatch and InexactCaseMatchForExtension errors have been removed and
MATLAB throws an UndefinedFunction error instead. This change does not generate new errors in
code that did not previously throw an error.
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Compute by Group Live Editor Task: Interactively summarize,
transform, or filter groups of data

Use the Compute by Group Live Editor task to interactively compute statistics, transform data, or
filter data by group. To open the task in the Live Editor, use the Task menu on the Live Editor tab.

Normalize Data Live Editor Task: Interactively center and scale data

Use the Normalize Data Live Editor task to visualize the effects of centering and scaling data using
various methods, such as the z-score. To open the task in the Live Editor, use the Task menu on the
Live Editor tab.

Clean Missing Data Live Editor Task: Define missing values

When using the Clean Missing Data Live Editor task, you can now define missing value indicators
that are different from the standard MATLAB missing values.

trenddecomp Function: Find trends in data

Use the trenddecomp function to additively decompose data into a long-term trend and seasonal
trends.

min and max Functions: Specify the comparison method for
determining minimum and maximum values

The min and max functions now accept the 'ComparisonMethod' parameter, which specifies a
method for determining the minimum and maximum values of the input while preserving the sign in
the output.

uniquetol Function: Options to control element selection and preserve
range of data

uniquetol has two new options to control behavior:

* occurrence argument: Specify whether the algorithm begins with the highest or lowest elements
in the input data. This can change which element, among several that are within tolerance of each
other, is selected as being unique. The default is to begin with the lowest elements.

* 'PreserveRange' name-value argument: Specify whether the range of the output data should be
the same as the input data.

Data Preprocessing Functions: Specify table variable as sample points
vector

When you operate on table input data, the following functions now allow you to specify which variable
in the table to use with the 'SamplePoints' parameter:
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+ fillmissing
+ filloutliers
* 1ischange

* 1islocalmax

* islocalmin

* isoutlier

* rmoutliers

* smoothdata

dateshift Function: Shift to next occurrence of weekday or weekend
day

You can now use the 'weekday' and 'weekend' arguments to shift the elements of a datetime
array when using the dateshift function.

» To shift to the next occurrence of a weekday on or after each element of the input datetime
array, use 'weekday'.

» To shift to the next occurrence of a weekend day on or after each element of the input datetime
array, use 'weekend'.

isbetween Function: Support for open, closed, and half open intervals

The isbetween function now supports open, closed, and half open intervals. In previous releases,
isbetween supports only closed intervals.

isregular Function: Support for datetime and duration data types

You can now use the isregular function to determine if a timetable, datetime vector, or duration
vector is regular. In previous releases, you can use isregular only on a timetable.

istabular Function: Determine if input is a table or timetable
To determine if an input variable is either a table or a timetable, use the istabular function.

Using this function is equivalent to using the statement tf = istable(A) || istimetable(A),
but is more convenient.

retime and synchronize Functions: Median and mode methods
supported

When you synchronize data in timetables, you can now specify 'median' and 'mode' as aggregation
functions. For more information, see retime and synchronize.

timeofday Function: Return the date as the second output argument

You can now return the dates from the elements of a datetime array as the second output argument
from the timeofday function.
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timeseries2timetable Function: Convert timeseries objects to
timetables

To convert timeseries objects to timetables, use the timeseries2timetable function.

Functionality being removed or changed

isordinal accepts input argument that has any data type
Behavior change

The isordinal function now accepts an input argument that has any data type. In previous releases,
isordinal threw an error if the input argument was not a categorical array.

Synchronize Timetables Live Editor task synchronizes an unlimited number of timetables
Behavior change

The Synchronize Timetables Live Editor task can now synchronize an unlimited number of
timetables. In previous releases, the task can synchronize no more than five timetables.

timeseries2timetable replaces ts2timetable
Behavior change

The timeseries2timetable function replaces the ts2timetable function, although
ts2timetable is still provided. The two functions are synonyms. In R2021a, MATLAB provides
ts2timetable only.
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sftp Function: Connect to SFTP servers

MATLAB can connect to SFTP servers for encrypted data transfers. Create an SFTP connection object
using the sftp function to read data from an SFTP server.

Datastores: Specify FileSet objects as data locations for some
datastores

Some datastore functions and objects accept FileSet objects as the locations of files to include in
the datastore. FileSet objects provide increased performance compared to file paths or DsFileSet
objects. This functionality is supported by these functions:

* tabularTextDatastore

* spreadsheetDatastore

+ fileDatastore

* keyValueDatastore

+ tallDatastore

* parquetDatastore

* 1imageDatastore

* signalDatastore (Signal Processing Toolbox)

* audioDatastore (Audio Toolbox)

* mdfDatastore (Vehicle Network Toolbox)

Table Import: Read tables from HTML and Microsoft Word documents
The readtable function now supports reading tables from HTML and Microsoft Word files.

To customize import options for HTML and Microsoft Word files, use htmlImportOptions and
wordDocumentImportOptions, respectively. To automatically detect import options from files, use
the detectImportOptions function.

HDF5 Interface: Use new functionality in support of HDF5 1.10.7

Use these new capabilities of the MATLAB HDF5 function interfaces:

» Single-Writer/Multiple-Reader (SWMR) — Write data to an HDF5 file in one process while you
concurrently read from the file in one or more reader processes. For more information, see Read
and Write Data Concurrently Using Single-Writer/Multiple-Reader (SWMR).

* Virtual Dataset (VDS) — Use the MATLAB low-level interface to access data stored across multiple
HDF?5 files, including files in remote locations, as a single, unified HDF5 dataset. You can also read
data stored in Virtual Datasets using the HDF5 high-level interface. For more information, see
Work with HDF5 Virtual Datasets (VDS).

* Metadata Cache Fine-Tuning — Improve performance by controlling the parameters of the
metadata cache, such as limiting the number of file reading attempts.
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» Partial Edge Chunk — Control whether to filter partial edge chunks.

NetCDF Interface: Read and write NC_STRING data

You can now use the existing high-level and low-level functions to read NC_STRING data from
NetCDF-4 files and write text data as type NC_STRING.

For more information on data type mapping between the NetCDF API and MATLAB, see Map NetCDF
API Syntax to MATLAB Syntax.

Scientific File Format Libraries: HDF5 and NetCDF libraries are
upgraded

The HDF?5 library is upgraded to version 1.10.7, and the NetCDF library is upgraded to version 4.7.4.

Audio, Video, and Image I/0O Functions: Run functions in a thread-
based environment

You can now run the following functions in the background using MATLAB backgroundPool:

* audioread

* audiowrite
 imwrite

* VideoReader
* VideoWriter

For more information, see Run MATLAB Functions in Thread-Based Environment.

Image File Format Libraries: LIbTIFF library upgraded to version 4.2.0

The LibTIFF library is upgraded to version 4.2.0.

New Serial Explorer and TCP/IP Explorer apps

Two new apps offer functionality for communicating with your device, instrument, or server:

* The Serial Explorer app provides a user interface to connect to and communicate with a serial
port device on your machine.

* The TCP/IP Explorer app provides a user interface to create a TCP/IP client that communicates
with a TCP/IP server.

Launch these apps from the Apps tab, under the Test and Measurement section. You can also call
the serialExplorer and tcpipExplorer commands in the Command Window.

You can use the apps to perform the following operations on your serial port device or TCP/IP client.

* Configure connection and communication properties.
* Write binary or string data.
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* Read binary or string data.

* Plot data in a separate figure window.

* Analyze data by viewing it in the Signal Analyzer app.
» Export data to the MATLAB workspace.

* Generate a MATLAB script for app interactions that uses the serialport or tcpclient
interface.

For more information about these apps, see Serial Explorer and TCP/IP Explorer.

Functionality being removed or changed

Video and Image I/O Functions: Pixel value differences might exist between JPEG 2000
images in R2021b and previous versions of MATLAB
Behavior change

In R2021b, when you use the imread, imwrite, VideoReader, or VideoWriter functions to read
or write JPEG 2000 image files, the image you import or export in R2021b might have pixel value
differences with the same image in previous versions of MATLAB.

HDF5 Interface: Linux users need to rebuild filter plugins using MATLAB HDF5 1.10.7
shared library
Behavior change

Starting in R2021b, in certain cases, Linux users using a filter plugin with callbacks to core HDF5
library functions need to rebuild the plugin using the shipping MATLAB HDF5 1.10.7 shared library, /
matlab/bin/glnxa64/1libhdf5.s0.103.3.0. If you do not rebuild the plugin using this version of
the shared library, you might experience issues ranging from undefined behavior to crashes. For more
information, see Build HDF5 Filter Plugins on Linux Using MATLAB HDF5 Shared Library or GNU
Export Map.

ftp Function: FTPClientConfig class, properties, and methods are no longer supported

The ftp function no longer supports the Apache™ FTPClientConfig class or any associated
objects, properties, or methods. To customize how to parse the LIST command output of the FTP
server use the ftp function’s DirParserFcn name-value argument.

MATLAB Variable Editor: timeseries will no longer be supported in a future release
Still runs

Viewing timeseries objects using the MATLAB Variable Editor will no longer be supported in a
future release. To view time-indexed data in the Variable Editor, use timetable instead.
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ode78 and ode89 Functions: High-order Runge-Kutta solvers for
ordinary differential equations

The MATLAB ODE suite has been expanded with two new solvers:

* 0de78 uses 7th- and 8th-order Runge-Kutta formulas
* 0de89 uses 8th- and 9th-order Runge-Kutta formulas

The new solvers expand on the existing Runge-Kutta solvers ode23 and ode45. In particular, ode78
and ode89 can be more efficient than ode45 on nonstiff problems that are smooth, and ode89 can be
more efficient than ode78 on very smooth problems, when you integrate over long time intervals or
when tolerances are tight.

pagesvd Function: Perform singular value decomposition on pages of
N-D arrays

Use the pagesvd function to perform batched singular value decompositions on the pages of N-D
arrays. In this context, the N-D array is treated as a container for several 2-D matrices.

svd Function: Option to control output format of singular values

svd has a new option outputFormat to control whether the singular values are returned as a vector
or diagonal matrix.

mpower Function: Improved algorithm for defective matrices

The mpower function has an improved algorithm to handle defective matrices raised to a real power.
In previous releases, mpower uses an algorithm based on eigenvalue decomposition for these inputs
that can return incorrect results for defective matrices. The new algorithm for defective matrices is

instead based on the Schur decomposition.

Functionality being removed or changed

svd, eig, cond, and pinv functions return NaN for nonfinite inputs
Behavior change

In R2021b, the svd, eig, cond, and pinv functions return NaN values when the input contains
nonfinite values (Inf or NaN).

In previous releases, these functions throw an error when the input contains nonfinite values.
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Plotting Table Data: Create scatter plots, bubble charts, and swarm
charts by passing tables directly to plotting functions

Create plots by passing a table directly to any of these functions: scatter, scatters3,
bubblechart, bubblechart3, swarmchart, swarmchart3, polarscatter, and
polarbubblechart. When you specify your data as a table, the axis labels and the legend (if
present) are automatically labeled using the table variable names.

The objects returned by these functions have new properties to support tables.

Property

Description

SourceTable

Table containing the data to plot

XVariable, YVariable, and ZVariable

Table variables containing the x, y, and z values
for Cartesian plots

ThetaVariable and RVariable

Table variables containing the angle and radius
values for polar plots

SizeVariable Table variable containing the marker size data
ColorVariable Table variable containing the marker color data
AlphaVariable Table variable containing the marker

transparency data

For example, create a table with the variables "Trials" and "Response". Pass the table to the
scatter function as the first argument, and indicate the variables you want to plot by name.

Trials = randi(10,50,1);
Response = rand(50,1);

t = table(Trials,Response);
scatter(t,"Trials", "Response")
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Axes Ticks and Colors: Control the appearance of axis tick marks and
tick label colors

Now, you can remove tick marks and customize tick label colors independently of other elements in
the axes.

* Removing Tick Marks — Remove all the tick marks from an axes, polar axes, or geographic axes
object by setting the TickDir property to 'none'. To remove the tick marks from a specific axis,
for example the x-axis, set the TickDirection property of the ruler to 'none"’.

* Customizing Tick Label Colors — Customize the color of the tick labels on an axis by setting
the TickLabelColor property of the corresponding ruler object. You can customize tick label
colors for any axes, polar axes, or geographic axes.

For example, create a bar chart, and then get the current axes. Remove the x-axis tick marks and
change the color of the x-axis tick labels to red.

bar([2017 2018 2019 2020],1:4)

ax = gca;
ax.XAxis.TickDirection = 'none';
ax.XAxis.TickLabelColor = 'r';



Graphics

2017 2018 2019 2020

Create Plot Live Task: Add additional visualizations to generated plots

Easily add additional visualizations to plots generated using the Create Plot Live Task. To add a new
plot, click the Add tab at the bottom of the Live Task Panel and select the visualization and data. This
Live Task combines the plot using the hold function.

Create Plot Q0 :

Overay of multiple plots in same axes
1 L
~ Select visualization
| Search for a visualization | Filter by Category | All
05+
o i NN
plua scatter | Bubblechart | |  swarmchart :mur mesh quiv ok
= \ i |[ H [
contourf errorbar scatterd bubblachart3 | | swamahar3 peolor quwera _ surf 05+
~ Select data 1
X [ v )
Y |z v 0 5 10 15 20
Size |x v

Color | default v |

» Select optional visualization parameters

|p|01 bubblechart |Md \
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Create Plot Live Task: Control chart input syntax using configuration
drop-down

The Create Plot Live Task now supports multiple configurations of charting functions with multiple
input syntaxes, including surf and mesh. Use the Configurations drop-down menu to select the
desired configuration.

+ Select data
Configuraticn | Specify X, ¥, Z, and Color ¥

% » Specify X, Y, Z, and Color

Specify £ and Color
¥ ¥ =

exportgraphics Function: Capture and append graphics to existing
PDFs

Capture and append graphics to an existing PDF file by calling the exportgraphics function and
setting the 'Append' name-value argument to true. For example, create a plot and export it as a
PDF called 'mycharts.pdf'. Then, create a bar chart and append it to the end of
'mycharts.pdf'. The resulting PDF file has two pages. The plots appear in the PDF in the order
that you export them.

plot([0 3 1 6 4 10])

exportgraphics(gca, 'mycharts.pdf")

bar([10 20 30 40])

exportgraphics(gca, 'mycharts.pdf"', "Append’, true)

stackedplot Function: Support for semilog y-axes

You can create plots using the stackedplot function where individual y-axes can be plotted on a log
scale. To set a log scale for the y-axis of a plot, set the YScale property of the
StackedAxesProperties object associated with the plot. For more information, see
StackedAxesProperties Properties.

Text Objects: Use editinteractions in the Interactions property to click
or tap on text to edit

Click or tap to edit text when the Interactions property has the value editInteraction. The edit
interaction is default behavior for title, subtitle, xlabel, ylabel, and zlabel text objects for axes,
geographic axes, and polar axes.

dataTipTextRow Function: Customize data tip content using data
properties, such as UserData

You can now assign information to the DataTipTemplate property by passing it to the
dataTipTextRow function as a property name, such as UserData.
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p = patch;
p.UserData = p.XData;
p.DataTipTemplate.DataTipRows(3) = dataTipTextRow('XDataAsUserData', 'UserData');

MATLAB Online™ Accessibility: Use a screen reader to interact with
figures

In MATLAB Online™, you can use a screen reader and keyboard commands to pan, zoom, and rotate
when you work with plotted data. Using a screen reader is not supported in the Live Editor.

For more information, see Use a Screen Reader in MATLAB Online.

For more details on interacting with MATLAB figures, see Control Chart Interactivity.

Functionality being removed or changed

The print options -opengl and -painters are not recommended
Still runs

The following print options are no longer recommended. There are no plans to remove the values,
and they will continue to behave the same way as in previous releases. The following table lists the
recommended replacement options.

Not Recommended Replacement Option

The -opengl renderer option. For example: Use the -image option. For example:

print('-opengl','-dpdf', 'myfigure.pdf"') print('-image','-dpdf', 'myfigure.pdf"')

The -painters renderer option. For example: Use the -vector option. For example:

print('-painters','-dpdf', 'myfigure.pdf') |print('-vector','-dpdf', 'myfiqgure.pdf')

plottools functions will be removed in a future release
Still runs

The plottools functions listed below will be removed in a future release. Use inspect to launch
the Property Inspector instead.

plottools functions

* plottools

* showplottool

+ figurepalette

* plotbrowser

* propertyeditor

* propedit

» plotedit options 'showtoolsmenu' and 'hidetoolsmenu’
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uialert, uiconfirm, and uiprogressdlg Functions: Mark up text and
display equations in dialog boxes

When you create dialog boxes using the uialert, uiconfirm, and uiprogressdlg functions,
enable markup in the dialog box text using the Interpreter name-value argument. Specify the
interpreter as 'html', 'latex', 'tex', or 'none’.

addStyle Function: Add styles to nodes and levels in a tree Ul
component

Create styles for specific tree nodes or tree node levels in a tree Ul component using the uistyle
and addStyle functions. For example, you can make the tree nodes at the top level of the tree red
with italic font. To get information on applied styles, query the StyleConfigurations property of
the Tree object. To remove a style from a tree, use the removeStyle function.

uitable Function: Set and query table selections programmatically and
control table selection options

You can now configure selection options of table UI components.

* Set and query the table selection using the Selection property.

* Specify whether a user can select table cells, rows, or columns using the SelectionType
property.

» Specify whether a user can select single or multiple table elements using the Multiselect
property.

» Update your app whenever a user selects table data by specifying a SelectionChangedFcn
callback.

Selection options in table UI components are supported only in App Designer apps and in figures
created with the uifigure function.

For more information, see Table Properties.
uitextarea Function: Program apps to respond while a user is typing in
a text area component

You can now specify a ValueChangingFcn callback for a TextArea component. The component
executes the callback function repeatedly while a user types in the text area.

For more information, see TextArea Properties.
Run Code in the Background: Use parallel language to create more
responsive apps

You can now create apps that remain responsive while performing calculations in the background by
using backgroundPool.


https://www.mathworks.com/help/releases/R2021b/matlab/ref/uialert.html
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Use the background pool with the following parallel language:

» parfeval and related functionality such as afterEach and afterAll
* parallel.pool.DataQueue and related functionality such as afterEach

For more information, see Use the Background to Make Your Apps More Responsive.

App Designer: Debug code in Code View

When debugging code in App Designer, you now can diagnose problems using debugging controls in
Code View. You can use the controls in the Run section of the Editor tab to run to the next
breakpoint, run the next line of code, or step into or out of a function.

L.E;’ @> Step In D

¥
Continue Step @ Step Out Stop

-

RUN

You can also debug your app code using inline debugging controls. For example, to run to a specific
line of code and then pause, click the [Pl button to the left of the line. To step into a function, click the

+ button directly to the left of the function you want to step into. After stepping in, click the <
button at the top of the file to run the rest of the called function, leave the called function, and then
pause.

When you step into a called function or file, App Designer displays a breadcrumb-style list of the
functions MATLAB executed before pausing at the current line (also called the function call stack).
The function call stack is shown at the top of the file and displays the functions in order, starting on
the left with the first called script or function, and ending on the right with the current script or
function in which MATLAB is paused.

piotRand » [mean | T

App Designer: Efficiently manage your app code with tools and
shortcuts from Live Editor

Many of the tools and shortcuts for navigating and organizing code that are available in the Live
Editor can now be used in App Designer Code View. This table lists the functionality that is new to
App Designer.

Functionality Menu Item Keyboard Shortcut

Wrap comment Right-click the comment and Ctrl+]
select Wrap Comments, or in
the Editor tab, in the Code

o
section, click the i d button.

Navigate code using bookmarks |In the Editor tab, in the Set or clear bookmark: Ctrl+F2
Navigate section, click
Bookmark. Then, select
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Functionality

Menu ltem

Keyboard Shortcut

Bookmark to set or clear a
select Previous or Next to

navigate between the existing
bookmarks.

m Bookmark |-

Move to previous bookmark:

bookmark on the current line, or|Shift+F2

Move to next bookmark F2

section, click Print. You can
print the entire document or the
current selection.

= Print h

Print
= Cird+P
{ — Print..

| Print Selection...

Boolkmark
) Ctrl+F2
Add new bookmark to the line
Previous
) Shift=F2
Mowve to the previous bookmark
Mext £
Move to the next bookmark
Print app code In the Editor tab, in the File Ctrl+P

Fold and expand code

In the View tab, click the
buttons in the Code Folding
section.

Expand current fold: Ctrl+Shift
+Period (.)

Collapse current fold: Ctrl
+Period (.)

ﬁpj Expand all folds: Ctrl+Shift

+Comma (,)

L = B
Expand Collapse Expand Colla
All All

CODE FOLDING

Collapse all folds: Ctrl+Comma
)

Toggle display preferences

In the View tab, in the Display
section, toggle line highlighting
and line numbers.

=] = L
Highlight Line Datatips
Current Line  Numbers
DISPLAY

N/A
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Functionality Menu Item Keyboard Shortcut

Duplicate line Right-click a line and select Ctrl+Shift+C
Duplicate Line(s).

Insert section break Right-click a line and select Ctrl+Alt+Enter, or type %%
Section Break.

Convert text to uppercase or Highlight the text, right-click it, |Ctrl+Shift+A
lowercase and select Change Case.

Variable rename When you rename a variable, Shift+Enter
App Designer gives you the
option to automatically update
all other instances of the
variable in your code.

[ B |

methods (Accegs = public)

1@
11 function func{app)

12 var?| 1 1;

A= - —

Fress Shift + Enter to rename 2 other instances of "var1” to "var2"

. -}

15 end

Version History

Code folding in App Designer persists even after you close and then reopen the file. In R2021a and
earlier releases, when opening a file, App Designer expands all the code.

App Designer: Interactively modify canvas zoom level and fit canvas
to view
In Design View, use the zoom controls in the lower right corner of the App Designer canvas,

indicated by the “ button, to modify the canvas zoom level.

To automatically zoom to fit the entire app in the view, press Space. Alternatively, click El Fit to
View in the Zoom section of the View tab, or right-click on the canvas and select Zoom > Fit to
View.

App Designer: Convert between similar Ul components

To convert one type of Ul component to another with similar functionality, right-click the component
on the canvas or in the Component Browser and select Replace With. Then, select the component
to convert to. Replacing one component with another preserves relevant property values, such as font
properties and callbacks that exist for both components. You can convert component types within
each of these families:

* Numeric edit field, spinner, slider, and knob
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» Edit field and text area
* Label and hyperlink

App Designer: Add help text for your app

You can now provide help for apps that you create. Help text appears in the Command Window when
an app user calls the help function and specifies the name of the app.

To add help text, in the Editor tab in Code View, click @ App Help Text. Use the App Help Text
dialog box to specify the app summary and detailed explanation.

In addition, when an app user views the documentation for your app (for example, by calling the doc
function or by clicking the documentation link in the help text for the app), the documentation page
now displays additional information:

* The top of the page displays the app summary and detailed explanation.

* The Methods Summary section displays the public functions. For each function, it also displays
any comment that is inserted after the function definition statement.

App Designer: Remove auto-reflow behavior from an app with auto-
reflow

To convert an app with auto-reflow to an app without auto-reflow, in the Canvas tab in Design View,
click Convert. Select the App without Auto-Reflow option. Doing so creates a duplicate of your app
with the auto-reflow behavior removed.

For more information, see Apps with Auto-Reflow.

Deployed Web Apps: Deploy web apps directly to the MATLAB Web
App Server from within App Designer

Once you have MATLAB Compiler™ installed on the system running MATLAB, package your MATLAB
app into a web app from within App Designer by clicking Share in the Designer tab and selecting
Web App. In the packaging dialog, specify the server URL to directly deploy your web app to the
server once packaging is complete. Authentication must be enabled on the server for this to work. For
details, see Authentication (MATLAB Web App Server).

App Testing Framework: Perform press gestures on axes and Ul axes
with different selection types

The app testing framework now supports mouse selection types in press gestures that are
performed on axes and Ul axes. For example, create an axes with a plot and then test a double-click
gesture at the point (3, 2).

f = uifigure;

ax = axes(f);

plot(ax,1:10)

tc = matlab.uitest.TestCase.forInteractiveUse;
tc.press(ax,[3 2], 'SelectionType', 'open')


https://www.mathworks.com/help/releases/R2021b/matlab/creating_guis/apps-with-auto-reflow.html
https://www.mathworks.com/help/releases/R2021b/webappserver/ug/authentication.html
https://www.mathworks.com/help/releases/R2021b/matlab/ref/matlab.uitest.testcase.press.html
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App Testing Framework: Perform drag gestures on axes and figures
with different selection types

Starting in R2021b, the app testing framework supports drag gestures on UI figures. Additionally,
when you test a drag gesture on an axes, Ul axes, or Ul figure, you can specify the mouse selection
type. For example, create a figure and drag on it from the point (100, 200) to the point (200, 300)
using a right-click gesture.

f = uifigure;

tc = matlab.uitest.TestCase.forInteractiveUse;
tc.drag(f,[100 200],[200 300], 'SelectionType', 'alt')

App Testing Framework: Use any units of measurement in gestures at
the center of components

Starting in R2021b, when you perform a gesture at the center of a component, the component or its
parent containers can use any units of measurement. In previous releases, the framework does not
support containers that use nonpixel units.

For example, create a figure and set its Units property to 'normalized'. Then, create a panel in
the figure and press at the center of the panel.

f = uifigure;

f.Units = 'normalized';

p = uipanel(f);

tc = matlab.uitest.TestCase.forInteractiveUse;
tc.press(p)

If you perform a gesture at the center of a component using a syntax that accepts location as an input
(for instance, press(testcase, comp, location)), then the figure or parent containers can use
only 'pixels"' as their units of measurement.

Functionality being removed or changed

Ctri+Click selects and deselects cells in a table Ul component
Behavior change

In tables created using the uitable function, you can select and deselect noncontiguous table cells
by holding Ctrl and clicking a cell. In R2021a and earlier releases, Ctrl+Click gives focus to a cell
and Shift+Click selects the cell that has focus.

App Designer toolstrip organization has changed
Behavior change

The organization of the tools in the App Designer toolstrip in Design View and Code View has
changed.

In Design View, use the tools in the Canvas tab to lay out your app, and use the tools in the View
tab to manage your Design View preferences.

In Code View, use the tools in the Editor tab to program your app behavior and to run and debug
your app, and use the tools in the View tab to manage your Code View preferences.

matlab.fonts.editor.codefont.Size setting has been removed
Errors
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The matlab. fonts.editor.codefont.Size setting has been removed. Use the
matlab.fonts.codefont.Size setting instead. The matlab. fonts.codefont.Size setting
controls both the App Designer Code View font size and the desktop code font size.

To update your code, change instances of the setting matlab.fonts.editor.codefont.Size to
matlab.fonts.codefont.Size. For more information, see matlab.fonts Settings.

App Designer Smart Indent applies to individual lines
Behavior change

When you apply Smart Indent to code in App Designer, the indentation change applies only to the
current line. In R2021a and earlier releases, the Smart Indent option applied to the entire document.

To apply Smart Indent to the entire document, in Code View, first select all the code (for example, by

pressing Ctrl+A). Then, apply Smart Indent by clicking the |:i| button in the Editor tab, or pressing
Ctrl+1.

CellSelectionCallback property of table Ul components is not recommended in uifigure-
based apps
Still runs

Starting in R2021b, using the CellSelectionCallback property to program a response to table
selection is not recommended for table Ul components in App Designer apps and in figures created
with the uifigure function. Use the SelectionChangedFcn property instead.

To update your code, assign all callback functions assigned to the CellSelectionCallback
property to the SelectionChangedFcn property instead. If a callback function accesses the callback
event data, you might need to update the event property names. For example, to access the indices of
the elements the user selected, use the Selection property of the TableSelectionChangedData
object. For more information, see Table Properties.


https://www.mathworks.com/help/releases/R2021b/matlab/ref/matlab.fonts-settings.html
https://www.mathworks.com/help/releases/R2021b/matlab/ref/matlab.ui.control.table-properties.html
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table Data Type Indexing: Improved performance when assigning
elements by subscripting with curly braces

table subscripted assignment using curly braces is significantly faster in R2021b than in R2021a.

For example, when you assign into three table variables with 10 elements, performance in R2021b is
approximately 4.4x faster, as shown below.

function timingTest()
t = table(zeros(1le6,1), ones(1le6,1), nan(le6,1));
indices = randi(1le6,1,10000);

tic;
% Assign row vector of random values to randomly chosen row
for i = indices
t{i,:} = rand(1,3);
end
toc
end

The approximate execution times are:

R2021a: 7.4 s

R2021b: 1.7 s

The code was timed on a Windows 10 system with a 3.6 GHz Intel Xeon W-2133 CPU by calling the
timingTest function in R2021a and R2021b.

grinsert and grdelete Functions: Improved performance modifying QR
factorizations

The grinsert and qrdelete functions show improved performance inserting and deleting rows and
columns in a QR factorization. The speedup is most noticeable for square matrices of order 1000 or
less and is similar in magnitude for both rows and columns.

For example, this code uses a loop to insert and delete columns from the QR factorization of a random
200-by-200 matrix. qrinsert and qrdelete are about 12x faster than in the previous release.

function timingQRMod
X = rand(200);

[Q,R] = gr(X);
y = rand(200,1);
tic

for k = 1:1000

[Qn,Rn] = grinsert(Q,R,100,y);
end
toc
tic
for k = 1:1000

[Qn,Rn] = grdelete(Q,R,100);
end
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toc
end

The approximate execution times are:
R2021a: 1.7 s (insertion) and 1.2 s (deletion)
R2021b: 0.15 s (insertion) and 0.10 s (deletion)

The code was timed on a Windows 10, Intel Xeon W-2133 CPU @ 3.60 GHz test system by calling the
timingQRMod function.

Titles and Labels in Plots: Improved performance when creating and
querying titles or labels in a loop

Creating and querying the following types of titles and labels in a loop has improved performance.

* Plot titles, such as those created with the title or subtitle functions
* Axis labels, such as those created with the xlabel, ylabel, or zlabel functions

For example, this code creates 100 axes with titles in a tiled chart layout. It runs 11.9x faster than in
the previous release:

function timingTitle

tiledlayout(10,10);

for n = 1:100
nexttile
title(n)

end

end

The approximate execution times are:
R2021a: 9.5s
R2021b: 0.8 s

The code was timed on a Windows 10, Intel Xeon CPU E5-1650 v4 @ 3.60 GHz test system by calling
the timeit function:

timeit(@timingTitle)

The performance gains increase with the number of axes, titles, and axis labels you are working with.
For example, this table shows the improvements for looping over 10, 20, 50, and 100 axes with titles.

Number of Axes with Titles Performance Gain
10 2.5x

20 4.2x

50 7.0x

100 11.9x
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Plot Interactions: Improved performance for rendering data tips and
rotating scatter plots of large data sets

In figures created with the uifigure function and in MATLAB Online, interactions with scatter plots
of large data sets have the following performance improvements:

* Data tip markers track the mouse motion more closely.
» 3-D scatter plots are more responsive to rotation gestures.

This improvement can be seen when the axes are created with either the axes or uiaxes function.

For example, on a Windows 10, Intel Xeon CPU E5-1650 v4 @ 3.60 GHz system, when you hover the
cursor over the following sphere, the cursor changes to a crosshair more quickly, and the data tip
markers track the cursor more closely. When you click and drag the cursor within the axes, the
sphere rotates more quickly and tracks the cursor more closely.

f = uifigure;

ax = axes(f);

[X,Y,Z] = sphere(900);
scatter3(ax,X(:),Y(:),Z(:),[1,Z(:),".™)

X 0.68921
Y 0.53847
Z -0.48431

HE

Plots in Apps: Improved performance for creating plots

The performance is improved for creating plots in apps or in figures created with the uifigure
function. For example, create a figure and an axes object. Then plot 10,000 points. This code runs 14x
faster in R2021b.

function timingPlot

% Create figure and axes
f = uifiqure;

ax = axes(f);

drawnow;

% Create data vector
y = rand(1,10000);

% Plot the data
tic;
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plot(ax,y);

toc;

end

The approximate execution times are:

R2021a: 0.14 s

R2021b: 0.01 s

The code was timed on a Windows 10, Intel Xeon W-2133 CPU @ 3.60 GHz test system by calling the

timingPlot function.

App Designer: Improved performance when opening Start Page and
loading apps

When you use App Designer, these operations have improved performance:

* Opening the App Designer Start Page
* Opening an existing app
For example, opening App Designer by entering appdesigner in the Command Window loads the

Start Page approximately 1.8x faster in R2021b than in R2021a the first time it is opened, and 2.1x
faster in subsequent times. The approximate startup times are:

Release First Startup Subsequent Startups
R2021a 6.6s 3.6s
R2021b 3.6s 1.7 s

Also, loading an app in App Designer shows improved performance. For example, after creating and
saving a new blank app, opening the app in App Designer is about 1.3x faster in R2021b than in
R2021a. The approximate loading times are:

R2021a: 1.98 s
R2021b: 1.56 s
The performance improvement is larger if you have additional toolboxes installed.

These operations were timed on a Windows 10, Intel Core i7-5600 CPU @ 2.60 GHz test system.

App Designer: Improved performance when saving apps

Saving apps in App Designer after you edit an app function or property is faster in R2021b than in
R2021a. The more lines of code in the app file, the greater the performance improvement becomes.

For example, on a Windows 10, Intel Xeon W-2133 CPU @ 3.60 GHz test system, in an app containing

10,000 lines of code, if you click Property @ to create a new property and then click Save LEJ to

save the app, you can run the updated app sooner in R2021b than in R2021a.

The approximate save times are:
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R2021a: 20 s
R2021b: 1.5s

Comparison Tool: Improved performance when loading and saving
MLAPP files

When you use the Comparison Tool to compare and merge changes between app code in MLAPP files,
these operations have improved performance:

* Loading the files into the Comparison Tool
» Saving the files after merging changes

For example, if you load two apps with 5000 lines of code into the Comparison Tool by clicking

Compare =~ in the App Designer toolstrip, you can compare and merge the files sooner in R2021b
than in R2021a.

The approximate loading times are:
R2021a: 13 s
R2021b: 8s

Also, if you use the Comparison Tool to merge changes between two apps with 5000 lines of code (for

example, by clicking Merge Mode =, merging the changes, and then clicking Save Result Q;?), you
can compare the saved files sooner in R2021b than in R2021a.

The approximate save times are:
R2021a: 24 s
R2021b: 8 s

Both of these operations were timed on a Windows 10, Intel Xeon W-2133 CPU @ 3.60 GHz test
system.

uigridlayout Function: Improved performance when adding
components spanning multiple columns with 'fit' width

The performance of parenting components to a grid layout manager created using the
uigridlayout function has improved when the components span multiple columns with a
ColumnWidth value of ' fit'. The performance improvement gets better as the number of
components spanning multiple columns and the number of columns spanned increases.

For example, this code creates a grid layout manager with 10 columns with a ColumnWidth value of
'fit', and then creates 50 labels that span all 10 columns. Performance in R2021b is about 4.7x
faster than in R2021a.

function timingGridLayout
f = uifigure;
numrows 50;
numcols 10;
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g = uigridlayout(f);

g.Scrollable = 'on';

g.RowHeight = repmat({'fit'},1,numrows);
g.ColumnWidth = repmat({'fit'},1,numcols);
drawnow

tic
for row = l:numrows
txt = ['This is a label in row ' num2str(row) ' that spans
num2str(numcols) ' columns in the grid.'];
bl = uilabel(g, 'Text"', txt);
lbl.Layout.Column = [1 numcols];
end
drawnow
toc
end

The approximate execution times are:
R2021a: 5.2 s
R2021b: 1.1 s

The code was timed on a Windows 10, Intel Xeon CPU E5-1650 v4 @ 3.60 GHz test system by calling
the function timingGridLayout.

uigridlayout Function: Improved resizing performance when wrapping
text in resizable columns

The performance when you resize apps containing a grid layout manager created using the
uigridlayout function has improved when both of these conditions hold:

* The grid layout manager contains a component with a WordWrap value of 'on".

* The row and column containing the component with word wrap have a RowHeight of 'fit' and a
ColumnWidth that is resizable, such as '1x"'.

For example, on a Windows 10, Intel Xeon CPU E5-1650 v4 @ 3.60 GHz test system, if you create 100
labels with wrapping text in a grid layout manager with fit height rows and resizable columns, and
then resize the figure window by dragging the corner of the figure, the label text adjusts to fit the size
of the figure almost immediately. In R20214a, there is a delay of about 2 seconds before the text

adjusts.
f uifigure;

g uigridlayout(f);

g.ColumnWidth = {'1x'};

numrows = 100;

g.RowHeight = repmat({'fit'},numrows,1);

for row = l:numrows
c = uilabel(qg);

c.Text = ['Lorem ipsum dolor sit amet, consectetur adipiscing elit,"

' sed do eiusmod tempor incididunt ut labore et dolore magna aliqua.'l];
c.WordWrap = 'on';

end
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Y - O x
Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod
tempor incididunt ut labore et dolore magna aligua.

Laorem ipsum dolor sit amet, consectetur adipiscing elit, sed do elusmod
tempor incididunt ut labore et dolore magna aliqua.

Larem ipsum dolor sit amet, consectetur adipiscing elit, sed do elusmod
tempor incididunt ut labore et dolore magna aligua.

Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do elusmod
tempor incididunt ut Iabore et dolore magna aliqua.

Larem ipsum dolor sit amet, consectetur adipiscing elit, sed do elusmod
tempor incididunt ut Iabore et dolore magna aliqua.

Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do eiusmod
tempor incididunt ut Iabore et dolore magna aliqua.

Lorem ipsum dolor sit amet, consectetur adipiscing elit, sed do elusmod
tempor incididunt ut labore et dolore magna aliqua.
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Lorem ipsum dolor sit amet, consectetur adipiscing
glit, sed do eiusmod tempor incididunt ut labore et
dolore magna aliqua.
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glit, sed do eiusmod tempor incididunt ut labore et
dolore magna aliqua.
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glit, sed do eiusmod tempor incididunt ut labore et
dolore magna aliqua.
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Live Editor: Improved performance when saving live scripts or
functions

Saving live scripts and live functions in the Live Editor is faster in R2021b than in R2021a. The
improvement is most noticeable when you save live functions with more than 1000 lines of code and
live scripts with fewer than 100 lines of code.

For example, on a Windows 10, Intel Xeon E5-1650 CPU @ 3.60 GHz test system, saving an example
live function containing 4000 lines of code takes approximately 2.05 seconds in R2021b. In R2021a,
saving the same live function takes approximately 2.57 seconds.

Data Processing Dialog Boxes: Improved resizing performance

The Basic Fitting UI, Data Statistics UI, Colormap Editor, and Linked Plot Data Sources dialog now
use uigridlayout to manage positions of UI components. This change results in a smoother experience
when adjusting the size of these dialog boxes. For more information about the Data Statistics UlI,
see Computing with Descriptive Statistics.

For example, on a Windows 10, Intel Xeon E5-1650 CPU @ 3.60 GHz test system, when you increase
the size of the Colormap Editor, the size changes smoothly.

Figure Interactions: Improved performance when using built-in axes
interactions

Performance of figure interactions has been improved by coalescing built-in axes interactions so that

there are significantly fewer interactions to process. These changes make interacting with a plot
smoother and reduce the delay between an input and a response.

For example, on a Windows 10, Intel Xeon E5-1650 CPU @ 3.60 GHz test system, while
panInteraction mode is active, when you click and drag the cursor within the axes the figure pans
more quickly and tracks the cursor more closely.
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Ul Figures: Improved performance when displaying axes toolbar

The performance of the axes toolbar in Ul figures has been improved to reduce the delay before the
toolbar appears.

For example, on a Windows 10, Intel Xeon E5-1650 CPU @ 3.60 GHz test system, when you pause the
cursor on the axes, the axes toolbar appears more quickly.

Ul Figures: Improved performance when interacting with linked axes

Interacting with linked axes has improved performance when using figures created with the
uifigure function or figures created in MATLAB Online™.


https://www.mathworks.com/help/releases/R2021b/matlab/ref/uifigure.html
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Projects: Collaborate using projects in MATLAB Online

Starting in R2021b, MATLAB Online provides support for basic projects workflows:

* Create an empty project and add files and folders.

* Clone a project from Git.

» Explore your project and run a dependency analysis.

* Create a project and manage your project files programmatically.

Source Control: Work with files under Git in MATLAB Online

Starting in R2021b, MATLAB Online provides support for basic Git workflows:

* Cloning a remote Git repository
* Committing files to Git
* Pulling, pushing, and fetching files with Git

Unit Testing Framework: Use the TestCase class template to create
tests more quickly and accurately

You can now create a TestCase class, including basic test functionality, in MATLAB and MATLAB
Online. To create a new test class, select New > Test Class on the Home, Editor, or Live Editor
tabs.

Use the TestCase class template to create tests more conveniently. The template includes a
TestClassSetup methods block, a TestMethodSetup methods block, and a Test methods block
that defines a simple Test method. To customize your test class, add code to the file or remove
unused code that is included by default. For more information about class-based tests, see Author
Class-Based Unit Tests in MATLAB.

Unit Testing Framework: Run live-function-based tests interactively in
MATLAB Online

Starting in R2021b, you can run live-function-based tests interactively in MATLAB Online. When you
open an MLX file defining a function-based test in MATLAB Online, the toolstrip lets you run all tests
in the file or just the current test.

To run tests and customize your test run interactively, use the Run Tests section in the Live Editor
tab of the toolstrip. For more information, see Run Tests in Editor.

App Testing Framework: Perform press gestures on axes and Ul axes
with different selection types

The app testing framework now supports mouse selection types in press gestures that are

performed on axes and Ul axes. For example, create an axes with a plot and then test a double-click
gesture at the point (3, 2).
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f = uifigure;

ax = axes(f);

plot(ax,1:10)

tc = matlab.uitest.TestCase.forInteractiveUse;
tc.press(ax,[3 2], 'SelectionType', 'open')

App Testing Framework: Perform drag gestures on axes and figures
with different selection types

Starting in R2021b, the app testing framework supports drag gestures on UI figures. Additionally,
when you test a drag gesture on an axes, Ul axes, or Ul figure, you can specify the mouse selection
type. For example, create a figure and drag on it from the point (100, 200) to the point (200, 300)
using a right-click gesture.

f = uifigure;

tc = matlab.uitest.TestCase.forInteractiveUse;
tc.drag(f,[100 200],[200 300], 'SelectionType', 'alt"')

App Testing Framework: Use any units of measurement in gestures at
the center of components

Starting in R2021b, when you perform a gesture at the center of a component, the component or its
parent containers can use any units of measurement. In previous releases, the framework does not
support containers that use nonpixel units.

For example, create a figure and set its Units property to 'normalized'. Then, create a panel in
the figure and press at the center of the panel.

f = uifigure;

f.Units = 'normalized';

p = uipanel(f);

tc = matlab.uitest.TestCase.forInteractiveUse;
tc.press(p)

If you perform a gesture at the center of a component using a syntax that accepts location as an input
(for instance, press(testcase, comp, location)), then the figure or parent containers can use
only 'pixels’ as their units of measurement.

Functionality being removed or changed

Specifying diagnostic after name-value arguments in qualifications is not recommended
Still runs

Starting in R2021b, when you test for equality using the verifyEqual, assumeEqual,
assertEqual, or fatalAssertEqual methods, specifying name-value arguments before the
diagnostic input argument is not recommended. Place name-value arguments after all of the
positional arguments instead. Although not recommended, you still can specify diagnostic after the
name-value arguments when these arguments use the name, value syntax.

The reason for this change is that, starting in R2021a, MATLAB supports a new syntax for passing
name-value arguments. In the new syntax, the name and value arguments are connected by an equals
sign (name=value), and the name is not enclosed in quotes. To use the new syntax with qualification
methods, specify positional arguments, including diagnostic, before the name=value arguments. If
you specify diagnostic after name=value arguments, MATLAB produces an error.

This table shows an example of how you can update your code.


https://www.mathworks.com/help/releases/R2021b/matlab/ref/matlab.uitest.testcase.drag.html
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R2021a and Earlier

Starting in R2021b

testCase matlab.unittest.TestCase.forInte

verifyEqual(testCase,1.5,2,
"RelTol",0.1,"Difference must be withirn

assumeEqual(testCase, 1,2,

"AbsTol",0.5,"Difference must be withirn

tastlaskdse; matlab.unittest.TestCase.forInteg

verifyEqual(testCase,1.5,2,
reldbDivdereberamast" pbe within relative tol

assumeEqual(testCase, 1,2,

absdDitderebheramast" be within absolute tol

For more information, see verifyEqual.

matlab.unittest.TestSuite.fromProject ignores
when creating a test suite
Behavior change

the files that do not define test procedures

Starting in R2021Db, if your project includes files with the Test classification,
matlab.unittest.TestSuite.fromProject ignores the files that do not define test procedures
when you create a test suite. For example, if an abstract TestCase class definition file is labeled with
the Test classification, fromProject ignores it. In previous releases, MATLAB produces an error if
fromProject is called on a project that uses the Test classification for any files other than concrete
test files. With this change, fromProject becomes consistent with the
matlab.unittest.TestSuite.fromFolder method: both methods create a test suite from all the
concrete test files and ignore any other files in the folder.

This behavior change also applies to the testsuite, runtests, and runperf functions when they
operate on code organized into files and folders within a project.

Test suites created from projects cannot run without the Java Virtual Machine (JVM)

software
Behavior change

Starting in R2021b, if you start MATLAB without the Java® Virtual Machine (JVM™) software and
create a suite from the test files in a project using testsuite, the function uses the
matlab.unittest.TestSuite.fromProject method to create the suite. If you then try to run the
test suite without the JVM software, MATLAB produces an error because the project cannot be
opened without the JVM software. In previous releases, when MATLAB runs without the JVM
software, testsuite uses matlab.unittest.TestSuite.fromFolder to create a suite from the
test files in the project, and the testing framework runs the resulting test suite.

This behavior change also applies to the runtests and runperf functions when they operate on
code organized into files and folders within a project.
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C++ interface: Support for C++ language features
The C++ interface supports these additional C++ language features.
Support for void** parameters

MATLAB returns a void* argument for void** parameters. For more information, see void** Input
Argument Types. For information about memory management of void** parameters, see Pass
Ownership of Memory to MATLAB.

char [] parameters behave like char * parameters

MATLAB supports char[] parameters as either integer or character (string), the same as char*
parameters. Likewise, the Unicode types wchar t[], charl6 t[1, and char32 t[] behave like
wchar t*, charl6e t*, and char32 t*. For more information, see C++ char* and char[] Types.

Support for static data members

Public static and public const static data members are treated as read-only properties in MATLAB.
You cannot modify the value of a C++ static data member in MATLAB. For more information, see
Static Data Members.

You can use a public static data member (property) as the data type of an input argument or return
type in a class constructor, method, or function. You also can use a static property or method to define
the shape of an argument. For information about using static properties to define the shape, see Use
Property or Method as SHAPE.

C++ interface: Publisher options
The C++ interface supports these build configuration features.
Overwrite existing library definition files

Publishers can automatically overwrite existing library definition MLX files when calling
clibgen.generatelLibraryDefinition. Set the OverwriteExistingDefinitionFiles name-value
argument to true. This option is useful when you create and modify the definition file for a library
libname.

When you use this option, MATLAB deletes definelibname.mlx and definelibname.m, including
any edits you made to the files.

Options for defining arguments

* By default, when a MATLAB input has fewer dimensions than the corresponding C++ argument,
then MATLAB inserts singleton dimensions at the beginning of the Shape argument. For more
information, see Dimension Matching. To insert singleton dimensions at the end, set the
'AddTrailingSingletons' name-value argument to true in the defineArgument functions -
defineArgument (ConstructorDefinition), defineArgument (FunctionDefinition),
and defineArgument (MethodDefinition).

» Ifa C++ function has a character array parameter used to return a C++ string, you can define
the argument so that the function returns a null-terminated string. Use the
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"NumElementsInBuffer' name-value argument in the defineArgument
(FunctionDefinition) or defineArgument (MethodDefinition) functions. For an
example, see the getMessage function in the Define String Argument table.

* You can transfer ownership of the memory of function or method parameters of double pointer
type with scalar output to MATLAB using the DeleteFcn name-value argument. For more
information, see defineArgument (FunctionDefinition) and defineArgument
(MethodDefinition).

* MATLAB lets you control the lifetime management of objects created with a constructor by
specifying the ReleaseOnCall name-value argument in the library definition file. For more
information, see defineArgument (ConstructorDefinition) and Lifetime Management of C
++ Objects in MATLAB.

* You can use a method or a property to define the shape of an argument. For more information, see
Use Property or Method as SHAPE.

* You can transfer ownership to MATLAB of the memory of double pointer input arguments void**
and object**, Use the 'DeleteFcn' name-value argument for defineArgument, as described
in Pass Ownership of Memory to MATLAB.

Java interface: Specify JRE path for MATLAB

You can run MATLAB with your system version of the Java Runtime Environment (JRE™). For
information about Java versions compatible with MATLAB, see MATLAB Interfaces to Other
Languages.

To set the JRE path in MATLAB, call jenv. You must restart MATLAB to use the updated path. This
command sets the path for all future MATLAB sessions but does not change the path for other
applications on your computer.

Alternatively, you can set the path from the operating system prompt. Call matlab_jenv, then start
MATLAB.

Java: Call into MATLAB from a Java program called by MATLAB
Java developers can use the com.mathworks.engine.MatlabEngine API getCurrentMatlab
method to call back into MATLAB from Java. Incorporating this method in your application allows

MATLAB users to call functionality from your Java program.

For information about developing these Java programs, see Call Back into MATLAB from Java.

Python interface: Run Python commands and scripts from MATLAB

The pyrun and pyrunfile functions let you call Python commands and scripts from MATLAB. For
more information, see Directly Call Python Functionality from MATLAB

Python: Support for complex multidimensional arrays
MATLAB supports passing complex multidimensional array data to Python and from Python to

MATLAB, for both in-process and out-of-process execution modes. For example, create a file test.py
containing this code:
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def returnData(data):
return data

To pass a complex MATLAB array to returnData, type:

mc = complex(magic(3));
c = py.test.returnData(mc)

C =
Python memoryview:

8.0000 + 0.0000i 1.0000 + 0.00001 6.0000 + 0.00001
3.0000 + 0.00001 5.0000 + 0.00001 7.0000 + 0.00001
4.0000 + 0.0000i 9.0000 + 0.00001 2.0000 + 0.00001

Use details function to view the properties of the Python object.

Use double function to convert to a MATLAB array.

To convert the return value to a MATLAB array, type:

C

double(c)

C 3x3 complex

8.0000 + 0.00001 1.0000 + 0.00001 6.0000 + 0.00001
3.0000 + 0.00001 5.0000 + 0.00001 7.0000 + 0.00001
4.0000 + 0.0000i 9.0000 + 0.00001 2.0000 + 0.00001

For information about MATLAB to Python data type mapping, see Pass Matrices and Multidimensional
Arrays to Python.

Python: Version 3.9 support

MATLAB now supports CPython 3.9, in addition to existing support for 2.7, 3.7, and 3.8. For more
information, see Versions of Python Compatible with MATLAB Products by Release

WSDL Web Services Documents: Apache CXF version 3.4.2 support

MATLAB supports Apache CXF version 3.4.2 for use with WSDL Web services. For more information,
see Set Up WSDL Tools.

Version History

Download the latest version 3.4.2 release of the Apache CXF tool from https://cxf.apache.org/
download.

Perl 5.32.1: MATLAB support on Windows

As of R2021b, MATLAB on Windows ships with an updated version of Perl, version 5.32.1. See https://
www.perl.org for a standard distribution of Perl, Perl source code, and information about using Perl.
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Version History

If you use the perl command on Windows platforms, see https://www.perl.org for information about
using this version of the Perl programming language.

Functionality being removed or changed

name=value syntax errors for calls to Python functions using py. prefix

Behavior change

Starting in R2021b, MATLAB errors when you use name=value syntax for passing keyword
arguments to Python functions using the py. prefix. In R2021a, MATLAB might silently give the
wrong answer. Use pyargs to pass keyword arguments.

For example, the Python print function has a keyword argument sep. This Python statement sets
the sep argument to a comma followed by a space:

print('comma', 'separated', 'values',sep="',
When you call this statement in MATLAB, MATLAB interprets sep=", '

py.print('comma', 'separated’,

")

")

‘values',sep="',

as a name=value argument:

R2021a Behavior

R2021b Behavior

How to Update Your Code

py.print(...
‘comma', 'separated’', 'val
sep=", ")

Silent wrong answer:

comma separated values sep ,

py.print(...
ues','.comma', 'separated', 'val
sep=", ')

Error:

Error using py.print
Using name=value format is n

Use pyargs to pass keyword a

py.print(...
ues','.comma', 'separated’', 'val
pyargs(sep=', "))

comma, separated, values

ot supported.
rguments

ues

createSoapMessage, callSoapService, and parseSoapResponse have been removed

Errors

Consider using matlab.wsdl.createWSDLClient instead of the createSoapMessage,
callSoapService, and parseSoapResponse functions to communicate with Web services using
Simple Object Access Protocol (SOAP). There is no direct function replacement for the SOAP
functions, but when you create a WSDL interface, you have access to the Web service functionality.

createClassFromWsdl has been removed

Errors

The matlab.wsdl.createWSDLClient function replaces the createClassFromWsdl function to
communicate with Web services from MATLAB using Web Services Description Language (WSDL).

matlab.wsdl.createWSDLClient enables you to specify additional information needed to access
the WSDL document. For more information, see weboptions.

To get started using matlab.wsdl.createWSDLClient, follow these steps.

1

information, see Set Up WSDL Tools.

Download supported versions of the Java JDK™ and Apache CXF programs. For more
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2 Set the paths to these programs, where jdk is the path to the JDK installation and cxf is the
path to the CXF program.

matlab.wsdl.setWSDLToolPath('JDK',jdk, 'CXF', cxf)

To update your code, replace calls to createClassFromwWsdl with calls to
matlab.wsdl.createWSDLClient. For example, for a Web service with this URL.:

url = 'https://examplesite.com/samplewebservice';

replace this call to createClassFromwWsdl:

createClassFromWsdl(strcat(url, '?wWSDL"))
with:

matlab.wsdl.createWSDLClient (url)

Note matlab.wsdl.createWSDLClient does not support RPC-encoded WSDL documents.
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Hardware Support

Connect and Control Arduino board using the Arduino Explorer App
The MATLAB Support Package for Arduino® Hardware now has an Arduino Explorer app.

Using this app, you can:

* Set up the Arduino board

» Connect to an Arduino board over USB, Bluetooth®, and WiFi

* Configure, read from, and write to Arduino pins

* Visualize data from Arduino pins

* Record and save data from Arduino pins to the MATLAB workspace
* Analyze the recorded data

* Generate equivalent MATLAB code

Read data from APDS9960 sensor connected to the Arduino hardware

The MATLAB Support Package for Arduino Hardware enables you to read gesture, proximity, clear
light and color (RGB) data from APDS9960 sensor connected to Arduino hardware.

Support for CAN shields on Raspberry Pi Hardware

Use the MATLAB Support Package for Raspberry Pi™ Hardware to read and write CAN messages
from the CAN network on the Raspberry Pi hardware.
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Live Editor Controls: Create dynamic controls in live scripts by linking
variables to drop-down items and slider values
When adding a drop-down list to a live script, you can populate the items in it using values stored in a

variable. When adding a slider, you can specify the minimum, maximum, and step values using
variables.

For example, create a live script and define the variable lastnames that contains a list of last names.

lastnames = ["Houston","Vega","Obrien","Potter","Rivera","Hanson","Fowler","Tran","Briggs"];

Run the live script to create lastnames and add it to the workspace. Then, go to the Live Editor
tab, and in the Code section, select Control > Drop Down. In the Items section of the control
configuration menu, select Llastnames as the Variable.

= LABEL
Text to display when code is hidden

Label Drop down

v ITEMS

Enter labels or values to add fo drop down

Item labels

Item values

Select a variable to add its confent to drop down

Variable lastnames | - |
> EXECUTION
Run Current section | -

Close the configuration menu to return to the live script. The drop-down list now contains the last
names defined in lastnames.

|J Housten - |

Houston
\Vega
Obrien
Potter
Rivera
Hanson
Fowler
Tran

Briggs

If you add, remove, or edit the values in lastnames, the items in the drop-down list update
accordingly.
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For more information, see Add Interactive Controls to a Live Script.

Live Editor Fonts: Change the name, style, size, and color of fonts
programmatically using settings

You can change the name, style, size, and color of titles, headings, text, and code in the Live Editor
using settings.

For example, this code changes the color and style of titles in the Live Editor:
s = settings;

s.matlab.fonts.editor.title.Style.PersonalValue
s.matlab.fonts.editor.title.Color.PersonalValue

{'bold'};
[0 6 255 11;

This code increases the size and changes the font of normal text in the Live Editor:

s = settings;
s.matlab.fonts.editor.normal.Size.PersonalValue
s.matlab.fonts.editor.normal.Name.PersonalValue

20;
'Calibri’';

The Live Editor updates all open live scripts and live functions to show the selected fonts. When you
create new live scripts or functions, they use the new fonts as well.

Plot Random Data

This script plots a vector of random data
and draws a horizontal line on the plot at
the mean.

n 58;
r rand(n,1);
plot(r)

m = mean(r);
hold on

plot([e,n],[m,m])
hold off
title('Mean of Random Uniform Data')

For more information, see matlab.fonts.

Live Editor Display: Specify where to display output by default

You can change the default location for output in a new live script. Depending on this preference, new
live scripts that you create display their output inline or on the right. To change the default, go to the

Home tab, and in the Environment section, select {& Preferences. Select MATLAB > Editor /
Debugger > Display, and then select an option for the Live Editor default view:

* Output on right — Output displays to the right of the code. Each output displays next to the line
that creates it. This option is ideal when writing code.

* Output inline — Output displays inline with the code. Each output displays underneath the line
that creates it. This option is ideal for sharing.
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Live Editor Functions: Run live functions interactively using the Run
button in MATLAB Online

In MATLAB Online, you can now run live functions interactively using the [,:’ Run button.

To run live functions that require input argument values or any other additional setup, configure the
[,3* Run button by clicking Run- and adding one or more commands. For more information about

configuring the [4:’ Run button, see Configure the Run Button for Functions.

Live Editor Bookmarks: Navigate quickly between lines

To navigate quickly between lines, set bookmarks in your live scripts or live functions. Bookmarks are
particularly useful in long files when you frequently need to move between sections.

To set a bookmark, put the cursor on the line that you want to set it on. Then, go to the Live Editor

tab and, in the Navigate section, click m Bookmark. A bookmark icon appears to the left of the
line. To clear a bookmark, with the cursor on the line with the bookmark, click Bookmark - and

select Set/Clear. You also can clear the bookmark by clicking the bookmark icon I to the left of the
line.

To navigate to a bookmark, go to the Live Editor tab, and in the Navigate section, click Bookmark
=. Then, select Previous or Next.

For more information about navigating within files, see Go To Location in File.

Live Editor Animation Playback Controls: Interactive interface to
control animations

Playback controls now appear within the figure window after an animation is done playing. These
playback controls provide the ability to replay the animation and explore individual frames without
having to re-run the entire live script. Animation playback controls are not supported for animations
generated by the movie function.

Live Editor Performance: Improved performance when saving large
live scripts or functions

When saving large live scripts or functions, you can continue using the Live Editor sooner in R2021a
than in R2020b. While you continue to use the Live Editor, MATLAB saves the file in the background.
When MATLAB finishes saving the file, the asterisk (*) next to the file name disappears, indicating
that the file is saved.

For example, on a Windows 10, Intel Xeon E5-1650 CPU @ 3.60 GHz test system, if you save a live
script containing 35,000 lines of code and then click the title bar of another document open in the
Live Editor, MATLAB immediately switches to the other open document. In R2020b, there is a
noticeable delay before MATLAB switches to the other open document.


https://www.mathworks.com/help/releases/R2021a/matlab/matlab_prog/configure-run-button.html
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Help Browser: View web documentation by default

Starting in R2021a, when you run MATLAB with an internet connection, the Help browser displays
the web documentation by default. When you run MATLAB on a system without an internet
connection, or if your internet connection becomes unavailable, the Help browser displays the
installed documentation instead.

To change the default documentation location, on the Home tab, in the Environment section, click

@ Preferences. Select MATLAB > Help and change the Documentation Location. For more
information, see Help Preferences.

Documentation: View MATLAB documentation in French, Italian, and
German

A subset of MATLAB documentation in French, Italian, and German is available on the web to
licensed MATLAB users. Only a subset of the full documentation is available. For more information,
see Translated Documentation.

MATLAB Drive: Get the location of your MATLAB Drive root folder
programmatically

You can get the location of your MATLAB Drive™ root folder programmatically, using the
matlabdrive command, from your desktop or in other MATLAB environments such as MATLAB
Online. For example, if you have MATLAB Drive Connector installed on your desktop system, MATLAB
returns the location of your MATLAB Drive:

path matlabdrive

path

(@)

:\Users\username\MATLAB Drive'

Functionality being removed or changed

PNG images in documentation are compressed
Behavior change

Starting in R2021a, all PNG images included in the documentation are compressed, reducing their
stored size on disk. The compressed images should be visually identical to the original images.


https://www.mathworks.com/help/releases/R2021a/matlab/matlab_env/help-preferences.html
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Name=Value Syntax: Use nhame=value syntax for passing name-value
arguments

MATLAB supports a new syntax for passing name-value arguments. In the new syntax, the name and
value arguments are connected by an equal sign, and the name is not enclosed in quotes.

Name=value syntax: plot(x,y,LineWidth=2)
Comma-separated syntax: plot(x,y,"LineWidth",2)

MATLAB continues to support the comma-separated name, value syntax. Existing functions and
methods support both syntaxes, and the process for writing functions and methods with name-value
arguments is unchanged.

Use the new syntax to help identify name-value arguments for functions and to distinguish names
from values in lists of name-value arguments. There are some limitations on where and how the
name=value syntax can be used:

* The recommended practice is to use only one syntax in any given function call. However, if you do
mix name=value and name, value syntaxes in a single call, all name=value arguments must
appear after the name, value arguments. For example,
plot(x,y,"Color","red",LineWidth=2) is a valid combination, but
plot(x,y,Color="red","LineWidth",2) errors.

* Similarly, name=value arguments must appear after all positional arguments. Calling
myFunction(name=value, posArgument) errors.

* The name=value syntax can only be used directly in function calls. They cannot be wrapped in a
cell array or additional parentheses. Calling myFunction(a, (name=value)) errors.

Retrieving Display Format: format function can get and set display
format

The format function can now output the current Command Window display format. Calling format
with an output variable returns a DisplayFormatOptions object that describes the current
numeric and line spacing formats:

fmt format

fmt =
DisplayFormatOptions with properties:

NumericFormat: "shortE"
LineSpacing: "loose"

You can also use a DisplayFormatOptions object as an input to format to change the display
format.
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Capturing disp Output: Use the formattedDisplayText function to store
disp output as a string

formattedDisplayText captures the output of disp(obj) as a string. The function also enables
you to control the formatting of the captured string, including numeric format and line spacing. For
example, A is a vector containing three logical values. formattedDisplayText displays the vector
elements as the words “true” or “false”:

out = formattedDisplayText(A, "UseTrueFalseForLogical",true)

out =
true false true

Virtual File Storage: mkdir and rmdir will now be able to create and
remove files from VFS directories

Starting in R2021a, rmdir and mkdir are able to create folders in remote locations.

Function Argument Validation: Debugger and profiler is now
supported

The MATLAB debugger will now be usable inside of the arguments blocks of functions. While
debugging an arguments block the workspace is read only. The MATLAB profiler will now record
lines inside of arguments blocks.

Class Diagram Viewer: Create graphical class diagrams to explore
class details and share designs

Use the Class Diagram Viewer tool to create graphical class diagrams, including details such as:

» Inheritance relationships, including abstract classes, mixins, and multiple inheritances
» Lists of properties, methods, and events

* C(Class member access levels

You can use the diagrams to explore complex class designs. You can also use the diagrams to share
proposed designs with team members, either as static images or editable diagrams.

Use the associated matlab.diagram.ClassViewer class for command line access to diagrams.
Enumeration Comparisons: Use isequal to compare enumeration
members with text data types

Enumeration classes now have a default implementation of the isequal method. You can use

isequal to compare enumeration members with character vectors, strings, and cell arrays of
character vectors or strings. For more information, see isequal Method.
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eval function: Context checking to resolve identifiers

MATLAB now resolves identifiers like variable names in an eval statement using additional context.
For instance, MATLAB recognizes when a call to eval uses a variable declared in a function.

Version History

With the additional context, MATLAB resolves ambiguities differently than in previous releases. Some
code now produces errors or warnings.

Code that warns starting in R2021a will error in a future release.

% myfun.m file with 1

function myfun
local()
assignlLocal
eval("local")

end

function local
disp("local fx")

end

% function call:
>> myfun

pcal function:

Example Previous Result R2021 Result Notes
function myfun(pi) ans = Errors MATLAB resolves pi as
eval('pi'") a variable in the
end 3.1416 function workspace, so
o> mvf my fun now errors when
myTun pi is not defined.
function myfun 3.1416 Same output but warns |MATLAB resolves pi as
disp(pi) . . on assignment. a variable in the
eval('pi = 1'); |pi = function workspace.
end
- 1 In a future release,
== myfun errors. This new
behavior is consistent
with processing the
following code:
function myfun
disp(pi)
pi = 1;
end
% assignLocal.m scripfttocal fx Same output but warns |In a future release,
local = 1; Loeal on assignment. MATLAB will give
OCal =

precedence as
described in “Function
Precedence Order”. In
this example,
precedence goes to the
local function. This new
behavior is consistent
with processing the
following code:

function myfun
local()
assignlLocal
local()

end




Language and Programming

Functionality being removed or changed

format with no arguments is not recommended
Still runs

The format command, by itself, resets the output display format to the default, which is the short,
fixed-decimal format for floating-point notation and loose line spacing for all output lines.

format

For clearer code, explicitly specify the default style.

format default

Defining classes and packages: Using schema.m will not be supported in a future release
Still runs

Support for classes and packages defined using schema.m files will be removed in a future release.
Replace existing schema-based classes with classes defined using the classdef keyword.

compose does not accept an invalid hexadecimal value, octal value, or trailing backslash
Errors

Previously, when the formatSpec input to compose contained an invalid hexadecimal value, octal
value, or trailing backslash it would issue a warning and truncate the output at the point of the
invalid value. Starting in R2021a, MATLAB will issue an error instead. With this change, compose will
error for all invalid formatSpec inputs.

Using get and set to access or change display format is not recommended
Still runs

Using get and set to programmatically access or change the numeric display format and the display
line spacing is not recommended. Use settings instead. For example:

s = settings;
myformat = s.matlab.commandwindow.NumericFormat.ActiveValue

myformat =
'short'

s.matlab.commandwindow.DisplayLineSpacing.TemporaryValue = 'compact';
myspacing = s.matlab.commandwindow.DisplayLineSpacing.ActiveValue
myspacing =

‘compact'’

For more information, see matlab.commandwindow Settings.

Using feature('EightyColumns') to access and change Command Window display width is
not recommended
Still runs

Using the command feature('EightyColumns') or feature('EightyColumns', value) to
programmatically determine or change whether the Command Window display width limit is enabled
is not recommended. Use settings instead. For example:

s = settings;

s.matlab.commandwindow.UseEightyColumnDisplayWidth.TemporaryValue = 1;
limitwidth = s.matlab.commandwindow.UseEightyColumnDisplayWidth.ActiveValue

3-9


https://www.mathworks.com/help/releases/R2020a/matlab/ref/classdef.html
https://www.mathworks.com/help/releases/R2021a/matlab/ref/matlab.commandwindow-settings.html

R2021a

limitwidth =
logical
0

For more information, see matlab.commandwindow Settings.
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Data Preprocessing Live Editor Tasks: Operate on multiple table
variables and specify output format for table input

When you are working with data in a table or timetable, these Live Editor tasks now allow you to
operate on multiple table variables at the same time:

* Clean Missing Data

* Clean Outlier Data

* Smooth Data

* Remove Trends

* Find Local Extrema

* Find Change Points

You can also choose which variable to display when visualizing the results.

In addition, tasks that modify variables provide new output options. You can return a table with all of
the variables, or with only the variables that were modified. For tasks that return logical arrays, you
can specify the size of the output. The size can match the size of the input table or a table containing
only the variables that were used in the calculation.

Clean Outlier Data Live Editor Task: Visualize results with a histogram

The Clean Outlier Data Live Editor task now offers histogram plots for most detection methods. The
histogram can summarize the input data, the outliers, the cleaned data with the outliers filled, and
the outlier detection thresholds and center value.

fillmissing Function: Specify custom fill method

You can now specify a custom method for filling missing values when using the fillmissing
function. Specify the custom method as a function handle.

normalize Function: Normalize multiple data sets with same
parameters

normalize can now return the centering and scaling parameter values used to perform the
normalization. You can reuse these parameters to normalize subsequent data sets in the same
manner. For example, you can normalize an array of data A and then normalize a second array B with
the same parameters:

[Anorm,C,S] = normalize(A);
Bnorm = normalize(B, 'center',C, 'scale',S);

The new outputs C and S contain the centering and scaling parameter values, respectively. So that
you can easily reuse them in a later normalization step, you can also now specify the 'center' and
'scale' normalization methods at the same time. These are the only two normalization methods that
you can specify together.
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To further support these changes, when method is 'center' or 'scale’, the possible values of
methodtype now include arrays and tables. While these methodtype values are intended to work
with the new outputs C and S, you also can compute your own normalization parameters to specify.

groupcounts Function: Display percentages of group counts

groupcounts now displays information about the percentage each group count represents.
» For table and timetable inputs, groupcounts automatically displays the percentages represented
by each group count in the output table.

» For array inputs, groupcounts has a new third output argument to return the percentages
represented by each group count.

Version History

When groupcounts operates on data in a table or timetable, the output contains an additional table
variable for the percentages. The percentages are in the range [0 100] and are included in the table
variable Percent.

Any code that references specific table variables is unaffected. However, you might need to update
code that depends on the number of variables in the output table.

ts2timetable Function: Convert timeseries objects to timetables

To convert timeseries objects to timetables, use the ts2timetable function.

table and timetable Functions: Specify dimension names using the
‘DimensionNames' name-value argument

When you create tables and timetables, you can specify their dimension names by using the
'DimensionNames' name-value argument with these functions:

* array2table

* array2timetable

+ cell2table

+ struct2table

+ table

+ timetable

In previous releases, you could change the dimension names only by creating a table or timetable and
then changing its DimensionNames property.

Functionality being removed or changed

Table dimension names cannot match reserved names
Behavior change
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MATLAB raises an error if you assign a dimension name that matches one of these reserved names:
'Properties’', 'RowNames', 'VariableNames', or ':'. In previous releases, MATLAB raised a
warning and modified the dimension names so that they were different from the reserved names.

For example, if you create a table and then assign 'Properties' as a dimension name, the result is
an error.

T = array2table(magic(3));
T.Properties.DimensionNames = {'Rows', 'Properties'}

'SamplingRate' will be removed
Warns

The 'SamplingRate' name-value argument will be removed in a future release. Use 'SampleRate'
instead. The corresponding timetable property is also named SampleRate.

For backward compatibility, you still can specify 'SamplingRate' as the name of the name-value
argument. However, the value is assigned to the SampleRate property.

This change in behavior affects the timetable functions shown in the list:

* array2timetable
* retime

* synchronize

+ table2timetable
+ timetable
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XML Files: Read, write, and import XML files using readtable,
readtimetable, and other functions

The readtable, writetable, readtimetable, writetimetable, and detectImportOptions
functions now support reading and writing XML files. This list outlines the added capabilities of each
function.

* readtable and readtimetable — Read XML data into MATLAB as a table or timetable. You can
specify optional name-value arguments to control how readtable and readtimetable treat
XML data. For example, specify ‘ImportAttributes’, false to ignore attribute nodes.

* writetable and writetimetable — Write a table or timetable in MATLAB to an XML file.
Specify optional name-value arguments to control how writetable and writetimetable treat
XML data. For example, specify ‘AttributeSuffix',' att' to specify that all table or
timetable variables with the suffix ' att' should be written as attributes in the output XML file.

+ detectImportOptions — The detectImportOptions function now returns an
XMLImportOptions object when you call it on an XML file. Its behavior when you call it on other
file types has not changed. Use the XMLImportOptions object with readtable to customize
import options. For instance:

* Import only a subset of data using the SelectedVariableNames property.

* Specify the names and data types of the variables in the input file using the VariableNames
and the VariableTypes properties.

* Manage the import of specific nodes in the XML file using name-value arguments such as
'TableSelector', 'RowSelector', or 'VariableSelectors'.

For more information, see XMLImportOptions.

MATLAB API for Advanced XML Processing: Create, read, write,
transform, and query XML

Use the MATLAB API for XML Processing (MAXP) to develop advanced applications that create, read,
write, transform, and query XML documents. MAXP consists of these packages:

+ matlab.io.xml.dom — Classes for creating, reading, and writing XML files and strings following
the W3C DOM standard.

+ matlab.io.xml.transform — Classes for transforming XML documents from one type to
another following the XSLT 1.0 standard.

* matlab.io.xml.xpath — Classes for querying XML documents using XPath 1.0 expressions.

XML Files: Register XML namespace prefixes for evaluating XPath
expressions using readtable,readstruct, and other functions

Use the RegisteredNamespaces name-value argument to specify namespace prefixes that
readtable, readtimetable,readstruct, XMLImportOptions, and detectImportOptions use
when evaluating XPath expressions in an XML file. RegisteredNamespaces can be used when you
also evaluate an XPath expression specified by a selector name-value argument, such as
StructSelector for readstruct, or VariableSelectors for readtable and readtimetable.
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The readstruct function automatically detects namespace prefixes to register for use in XPath
evaluation, but you can also register new namespace prefixes using the RegisteredNamespaces
name-value argument. You might register a new namespace prefix when an XML node has a
namespace URL, but no declared namespace prefix in the XML file. In that case, you can specify
RegisteredNamespaces as a string array containing a namespace prefix and the associated URL.

For example, evaluate an XPath expression on an XML file named example.xml which does not
contain a namespace prefix declaration. Specify 'RegisteredNamespaces' as [“myprefix”,
“https://www.mathworks.com”] to assign the prefix myprefix to the URL https://

www . mathworks . com.

data = readstruct("example.xml", "StructSelector", "/myprefix:Data",...
"RegisteredNamespaces", [“myprefix”, “https://www.mathworks.com”])

In the resulting structure, the namespace prefix and URL will appear as attributes belonging to the

element specified in the StructSelector name-value argument.

Low-level file I/0O functions and remote data: Perform read and write
operations on remotely stored files

You can now use low-level file I/O functions, such as fopen, fread, and fwrite, to work with files
stored in remote locations. Some supported remote locations include Amazon S3™ and Windows
Azure® Blob Storage.

When reading from or writing to a remote location, you must specify the full path using a uniform
resource locator (URL). For example, open a binary file from the Amazon S3 cloud.

fid = fopen(“s3://bucketname/path to file/example.bin”);
For more information on setting up MATLAB to access your online storage service, see Work with

Remote Data.

save and load functions and remote data: Save, load, and append
data to remotely stored v7.3 MAT-files

You can now access v7.3 MAT-files stored in remote locations, such as Amazon S3 and Windows Azure
Blob Storage, using the save and load functions.

When saving, loading, or appending data to a remote location, you must specify the full path using a
uniform resource locator (URL). For example, load a MAT-file from the Amazon S3 cloud.

load(“s3:://bucketname/path _to file/example.mat”);

For more information on setting up MATLAB to access your online storage service, see Work with
Remote Data.

Reading Online Data: Read files over HTTP and HTTPS using
readtable, audioread, and other reading functions

Read files from an internet URL by specifying filename as a string that contains the protocol type
"http://' or 'https://'. This lets you read data from their primary online sources.
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This functionality is supported by these functions: audioread, audioinfo, parquetread,
parquetinfo, readtable, readtimetable, readvars, readstruct, readmatrix, readcell,
readlines, and detectImportOptions.

Parquet Data Format: Use categorical data in parquet data format
Read, write, and analyze parquet data that contain the categorical data type.

This functionality is supported by these functions: parquetread, parquetwrite, parquetinfo,
and parquetDatastore.

Datastores: Read all data from a datastore using parallel processing

You can use parallel processing when reading all data from a datastore (requires Parallel Computing
Toolbox). Parallel processing results in improved performance when reading data, especially with
remote data.

Data Compression Functions: Improved functionality in zip/unzip and
tar/untar

On Windows, macOS, and Linux systems:

* zip can compress an individual file of any size.
* zip can compress any number of files in a single function call.
* tar can compress a group of files of any cumulative size.

Additionally, on Windows systems, unzip and untar replace invalid characters with underscores if
they occur in entry path names of the original file.

imfinfo function: Get information about all Adobe Digital Negative
(DNG) file tags

The imfinfo function returns information on all DNG file tags as individual named fields in the
output structure. For a complete list of DNG file tags, see Chapter 4 of the Adobe Digital Negative
(DNG) Specification.

jsonencode: Add indentation to JSON text

Use the jsonencode 'PrettyPrint' option to display JSON text with an indentation of two spaces.

s.Width = 800;

s.Height = 600;

s.Title = 'View from the 15th Floor';
s.Animated = false;

s.IDs = [116, 943, 234, 38793];
jsonencode(s, 'PrettyPrint"', true)

"Width": 800,
"Height": 600,
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"Title": "View from the 15th Floor",
"Animated": false,
"IDs": [

116,

943,

234,

38793

Functionality being removed or changed

The H5l.get_name function only accepts named HDF5 datatypes as input arguments.
Behavior change

Starting in R2020a, the H5I.get name function only accepts committed (previously called named)
HDF5 datatypes as input arguments, and will error if you pass other datatypes as input. In releases
R2019b and earlier, H5I.get name does not error if you pass other datatypes as input.

To verify that the input is a committed HDF5 datatype, call the H5T. committed function on it. The
H5T.committed function returns a value of 1 if the input is a committed HDF5 datatype, and a value
of 0 if it is not.

imfinfo now returns Adobe DNG tags belonging to versions 1.2 through 1.5 in individual
named fields in the output structure
Behavior change

When you call the imfinfo function on an Adobe DNG file, it now returns tags belonging to versions
1.2 through 1.5 as individual named fields in the output structure. Previously, tags belonging to these
versions were stored in the 'UnknownTags' field of the output structure. For a complete list of DNG
file tags, see Chapter 4 of the Adobe Digital Negative (DNG) Specification.

imread reads the first frame in a GIF file by default
Behavior change

Starting in R2021a, when you read a GIF file without specifying additional arguments, the imread
function reads the first frame by default. Previously, imread read all the frames in the file by default.

To read all the frames in the order that they appear in the GIF file, specify the value of the 'Frames'
name-value argument as 'all’.

serial function will be removed
Still runs

serial and its object properties will be removed. Previously, serial and its object properties were
not recommended. Use serialport and its properties instead.

This example shows how to connect to a serial port device using the recommended functionality.

Functionality Use This Instead

s = serial("COM1"); s = serialport("COM1",115200);
s.BaudRate = 115200;

fopen(s)
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See Transition Your Code to serialport Interface for more information about using the
recommended functionality.
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Graph Algorithms: Compute all paths, all cycles, and cycle basis

graph and digraph objects have new functions to compute paths and cycles:

* allpaths — Compute all paths between two nodes in a graph or digraph object.
* allcycles — Compute all cycles in a graph or digraph object.

* cyclebasis — Compute the fundamental cycle basis of a graph object.

* hascycles — Determine whether a graph or digraph object contains cycles.

griddedinterpolant Object: Use multivalued interpolation to
interpolate multiple data sets simultaneously

griddedInterpolant can now interpolate multiple data sets on the same grid at the same query
points. For example, if you specify a 2-D grid, a 3-D array of values at the grid points, and a 2-D
collection of query points, then griddedInterpolant returns the interpolated values at the query
points for each 2-D page in the 3-D array of values.

Previously, this functionality was available in interp1l for 1-D interpolation, but this improvement to
griddedInterpolant adds support for N-D multivalued interpolation.

eig Function: Improved algorithm for skew-Hermitian matrices
eig now has an improved algorithm for input matrices that are skew-Hermitian. With the function

call [V,D] = eig(A), where A is skew-Hermitian, e1g now guarantees that the matrix of
eigenvectors V is unitary and the diagonal matrix of eigenvalues D is purely imaginary.

cdf2rdf Function: Improved algorithm for all inputs

cdf2rdf has an improved algorithm for all input matrices that reduces floating-point round-off errors
in the calculation.

Functionality being removed or changed

Line Continuation: Ellipsis following operator treated as a space
Behavior change

Previously, if an ellipsis followed an operator inside of a matrix or cell array, it caused the operator to
be treated as unary. Ellipses will now be treated as a space in all cases.

3-19


https://www.mathworks.com/help/releases/R2021a/matlab/ref/graph.html
https://www.mathworks.com/help/releases/R2021a/matlab/ref/digraph.html
https://www.mathworks.com/help/releases/R2021a/matlab/ref/graph.allpaths.html
https://www.mathworks.com/help/releases/R2021a/matlab/ref/graph.allcycles.html
https://www.mathworks.com/help/releases/R2021a/matlab/ref/graph.cyclebasis.html
https://www.mathworks.com/help/releases/R2021a/matlab/ref/graph.hascycles.html
https://www.mathworks.com/help/releases/R2021a/matlab/ref/griddedinterpolant.html
https://www.mathworks.com/help/releases/R2021a/matlab/ref/eig.html
https://www.mathworks.com/help/releases/R2021a/matlab/ref/cdf2rdf.html

R2021a

3-20

Old Behavior New Behavior
x =[1 -... X =[1 -...
2] 2]
X = X =

1 -2 -1

Previously, this code was equivalent to the
expression, x = [1 -2].

Now, the ellipsis will be treated as a space so this
code is equivalent to the expression, x = [1 -
2].
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Create Plot Live Editor Task: Create plots interactively and generate
code

The Create Plot Live Editor Task makes generating and exploring visualizations for data simple and
interactive. With this task you can select the data you wish to visualize and choose the plot type that
best represents that data. Alternatively, you can explore the visualizations available in MATLAB to
find the desired plot type and add your data. This task creates labels for the visualization based on
the data and can be used to add or adjust the optional parameters of the visualization.

bubblecloud Function: Visualize part-to-whole relationships

Use the bubblecloud function to illustrate the relationship between elements in your data set and
the set as a whole. For example, you can visualize data collected from different cities, and represent
each city as a bubble whose size is proportional to the value for that city.

tiledlayout Function: Control the tile indexing scheme

Control whether the tile indices increase across the rows or down the columns of a layout by setting
the TileIndexing property of a TiledChartLayout object. Select one of the following options:

* 'rowmajor' — Increment the tile indices across the first row before moving to the next row. This
is the default behavior.

* ‘'columnmajor' — Increment the indices down the first column before moving to the next
column. This indexing scheme is the same as linear indexing for arrays.

The nexttile function populates tiles according to the indexing scheme. If you change the tile
indexing of a populated layout, the tile positions change to match the new scheme.
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PolarAxes Objects: Use the CurrentPoint property or call ginput to get
the cursor location within polar axes

Query the CurrentPoint property of a PolarAxes object to get the location of the last click within
the axes. The ginput function also supports querying coordinates of polar axes.

Scatter Plots and Constant Lines: Create multiple scatter plots or
constant lines at once

* The scatter, polarscatter, and swarmchart functions now accept the same combinations of
matrices and vectors as the plot function does. As a result, you can visualize multiple data sets at
once rather using the hold function between plotting commands.

* The xline and yline functions now accept vectors of values for creating multiple vertical or
horizontal reference lines. You can also specify separate labels for each line using a string array or
a cell array.
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Axis Limits: Define LimitsChangedFcn callback that executes when the
limits of an axis change

Define the LimitsChangedFcn callback function on any type of ruler object such as a numeric ruler.
The callback function executes when the limits of the corresponding axis change. For example, you
can define the callback in an app to update another aspect of the UI when the user pans within the
axes.

Axis Limits: Control axis limits

Control the axis limits for your plots by setting the XLimitMethod, YLimitMethod, or
ZLimitMethod on the axes. Select one of the following property values:

* 'tickaligned' — Align the edges of the axes box with the tick marks that are closest to your
data without excluding any data. This is the default option.
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* 'tight' — Fit the axes box tightly around the data by setting the axis limits equal to the range of
the data.

* 'padded' — Fit the axes box around the data with a thin margin of padding on each side. The
width of the margin is approximately 7% of your data range.

5 tickaligned tight padded
1
1 1
0.5
0 0 0
-0.5
-1
-1 -1
-2
-4 =2 0 2 4 =2 0 2 =2 0 2

exportgraphics and copygraphics Functions: Specify RGB, CMYK, or
grayscale output

Choose a color space when exporting or copying graphics. Specify the Colorspace name-value
argument when you call the exportgraphics or copygraphics functions. Select one of the
following options:

* 'rgb' — Capture truecolor RGB content. This is the default color space.
* 'gray' — Convert the content to grayscale.

* 'cmyk' (exportgraphics only) — Convert the content to cyan, magenta, yellow, and black
(CMYK) before exporting the content as an EPS file.

colororder Function: Control colors in stacked plots

The colororder function now supports charts created with the stackedplot function.

Tick Labels: Automatically rotate tick labels

When you manually specify the ticks or the tick labels for a chart, the tick labels automatically rotate
to give the best possible presentation given the size of the figure and the number of the tick labels.
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patch and errorbar Functions: Expanded data type support

The patch and errorbar functions now support more data types:
* The patch function accepts numeric, datetime, duration, and categorical values for the x-, y-, and
z-coordinates.

* The errorbar function accepts numeric, datetime, duration, and categorical values for the x- and
y-coordinates. It also accepts numeric and duration values for the error bar lengths above, below,
and on either side of the data points.

Geographic Plots: Access basemaps using additional proxy server
authentication types

You can now access basemaps for geographic axes and charts using additional proxy server
authentication types.

* On Windows, you can use Basic, Digest, NTLM, Negotiate (SPNEGO), and Kerberos
authentication.

* On Linux and macOS, you can use Basic, Digest, and NTLM authentication.

Prior to R2021a, geographic axes and charts supported only types without authentication or with

Basic authentication. For more information about specifying proxy server settings, see Use MATLAB
Web Preferences For Proxy Server Settings.

Functionality being removed or changed

Tile spacing and padding options for tiled chart layouts have changed
Behavior change


https://www.mathworks.com/help/releases/R2021a/matlab/ref/patch.html
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When you create a tiled chart layout, some of the TileSpacing and Padding properties provide a
different result or have new names.

The new TileSpacing options are 'loose', 'compact’, 'tight', and 'none'. The new Padding
options are 'loose', 'compact’', and 'tight'. The following tables describe how the previous
options relate to the new options.

TileSpacing Changes

Previous TileSpacing R2021a TileSpacing Option [How to Update Your Code
Option
‘normal’ 'loose’ Consider changing instances of

'normal’ to 'loose’.

! ) T ! K "M 7T IThe ‘normal’ option is no
of \a, o II |'I I'| Ilrll ||I o \‘u, ) I| |'I ||| ||[|| ||I I F1ir|u;1er recommended, but it
\ \ I|| II || '| II \ ‘ I|I \ || '| II b(t)ﬁntinues to work, and there are
r \ r T r \ r '/ U |rloplans to remove it.
0 5 00 5 0 5 0 0 5 10
L T 1 T 1
I T ||"|‘Mﬂf|’||' I W H'||1ﬂ|1r|nr||r‘|'”"
-:3:||||“||||||||||”|| ﬁ||||||||||||||| {"|||||||||||||||||||| “|||||||||||||||||”|
JUY LY _1H|J|J||M LU _1H|1|||“|d |
0 5 0 0 5 0 5 0 0 5 10
"compact' 'compact’ No changes needed.

e
T
—
—
_:-"__FF‘-
B
ey
—

of |\ \ ‘3"|"|'|||| of \ ‘}'|"I"'I'I|'|
IRV B A1 I VA a1 A I A
0 5 0 0 5 0 5 10 0 5 10
O v T
L A YL
| Il o \|||‘|H||H||| a|||||| ||||||||| '”||| |||H|||‘|| ||||

=

i
LUV 1I.|

0 5 10 o

|

| LA

W LUV 11|U|1.t||1|1 il
5 b

(] 5 10 0

3-25



R2021a

Previous TileSpacing R2021a TileSpacing Option [How to Update Your Code
Option
Not Applicable "tight' "tight' is a new option. It

provides the same result as
'none' does in previous
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Padding Changes
Previous Padding Option R2021a Padding Option How to Update Your Code
‘normal’ 'loose’ Consider changing instances of

‘'normal’ to 'loose’.
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Previous Padding Option R2021a Padding Option How to Update Your Code
'compact' 'compact' No changes needed.
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Passing an empty label to the legend function omits the entry from the legend
Behavior change

When you call the legend function and specify a label as an empty character vector, an empty string,
or an empty element in a cell array or string array, the corresponding entry is omitted from the
legend. In R2020b and earlier releases, the entry appears in the legend without a label.

For example, this code plots two sine waves and a reference line at y=0. Then it creates a legend with

three labels, where the last label is empty. In R2020b, the third line appears in the legend without a
label. In R20214, the third line is omitted from the legend.

X =0:0.2:10;
plot(x,sin(x),x,sin(x+1));
hold on

yline(0,'--")
legend('sin(x) "', 'sin(x+1)"',"")
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To keep an entry in the legend without a label, include a space character in the label. For example, to
update the preceding code, specify the last label as a character vector containing a space ('

|)'
legend('sin(x)"','sin(x+1)"'," ")

Alternatively, if you do not want to display a space character, you can pass the individual line objects
to the legend function with an array of labels. To get the individual line objects, call each plotting
function with an output argument.

X =0:0.2:10;

p = plot(x,sin(x),x,sin(x+1));
hold on

line® = yline(0,'--");

legend([p(1) p(2) line@], {'sin(x)','sin(x+1)"',"'"'});

The XData, YData, and ZData properties on Patch objects created with the fill and fill3
functions return values of the original data type
Behavior change

The XData, YData, and ZData properties on a Patch object created by the fill or fill3 functions
return the coordinates using the original input data type, rather than returning them as double
values.

In previous releases, datetime, duration, and categorical coordinates are converted to double values
when they are stored in the XData, YData, and ZData properties.

For example, this code creates a filled polygon with datetime x-coordinates. Then it calculates x2

using the values stored in the XData property. In R2020b, h.XData and x2 are double arrays. In
R2021a, h.XData and x2 are datetime arrays.

datetime('01-Jan-2018"') + days([0 1 1 0]);
[06011];

fill(x,y, 'red');
x2 = h.XData + 1;

X
y
h

To preserve the double values in your code, get the double values from the Vertices property of
the Patch object. The x-, y-, and z-coordinates are stored as double values in the first, second, and
third columns of the Vertices array.

x2 = h.Vertices(:,1) + 1;
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Alternatively, use the ruler2num function. Pass the coordinate values and the corresponding axis
ruler to the ruler2num function.

ax
X2

gca;
ruler2num(h.XData,ax.XAxis) + 1;

Graphics objects and Ul components sized using 'points’, 'inches', and 'centimeters' units
will increase in size on macOS platforms
Behavior change in future release

In a future release, graphics and UI objects that have Units or FontUnits properties set to
'points’, 'inches', or 'centimeters' will use a conversion value of 1 pixel = 1/96th inch on
macOS platforms. The current conversion value is 1 pixel = 1/72nd inch. As a result, these objects
and text elements will display 1.33 times larger than their previous size. This change will provide a
more readable default font size and will ensure a consistent object size across Windows and macOS
platforms.

The following objects use a unit value of 'pixels' by default and will not be affected by this change:

* Ul components in App Designer or in apps created with the uifigure function

* Ul components in apps created in GUIDE and migrated to App Designer using the GUIDE to App
Designer Migration Tool for MATLAB

* Axes objects created using the uiaxes function
For the most control when sizing and laying out your graphics objects and UI components, use a

value of 'pixels' for Units and FontUnits properties. To maintain object sizes in current and
future releases, make these updates in your code:

* Objects with Units or FontUnits setto 'points' — Update the value of the property from
'points' to 'pixels’.

* Objects with Units or FontUnits setto 'inches' — Update the value of the property from
"inches' to 'pixels' and multiply all Position values by 72.

* Objects with Units or FontUnits setto 'centimeters' — Update the value of the property
from 'centimeters' to 'pixels' and multiply all Position values by 72/2.54.

For example, this code creates a push button in a figure window, with its position specified in inches:
uicontrol('Units', 'inches', 'Position',[0.6 0.1 1.75 0.5]);

In a future release, the push button created by this code will display 1.33 times larger on macOS
platforms. To maintain the size and position of the push button in current and future releases, update
the code to:

uicontrol('Units', 'pixels', 'Position',[50 10 126 36]);

Align Distribute Tool will be removed in a future release
Warns

The Align Distribute Tool will be removed in a future release.
To control the arrangement of multiple plots in a figure, create a tiled chart layout using the

tiledlayout function instead.
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To align or distribute graphics objects within a figure, select Tools > Align or Tools > Distribute
from the figure toolbar instead.
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App Building
uihyperlink Function: Add and configure clickable links in apps and on
the App Designer canvas

To create a link, call the uihyperlink function or, in App Designer, drag a hyperlink UI component
from the Component Library onto the canvas.

Hyperlink UI components are supported only in App Designer apps and in figures created with the
uifigure function.

uitree Function: Add and configure check box trees in apps and on the
App Designer canvas

A check box tree is a styled with check boxes to the left of every item. You can now create check box
trees in apps and on the App Designer canvas. Check box trees allow for easier selection of multiple
tree nodes.

In apps created programmatically with the uifigure function, create a check box tree using the
uitree function by specifying the style ' checkbox"'.

In App Designer, create a check box tree by dragging it from the Component Library onto the
canvas.

Interpreter Property: Style text and display equations in labels with
HTML and LaTeX markup

Use the Interpreter property on Label objects (created with the uilabel function) to enable
markup in the label text. To add HTML markup, set the Interpreter property to 'html'. To add
LaTeX markup, set the Interpreter property to 'latex"'.

For more information, see Label Properties.

WindowStyle Property: Create Ul figures that remain in the
foreground

To keep a specific Ul figure window in front of other windows, set the WindowStyle property to
"alwaysontop'. Unlike modal figures, Ul figure windows with this property setting do not restrict
keyboard and mouse interactions.

The 'alwaysontop' property value is available only in figures created using the uifigure function.
For more information, see UI Figure Properties.

scroll Function: Scroll to a location within a table Ul component
programmatically

Use the scroll function to scroll within a table Ul component programmatically. Specify the scroll
location as the top, bottom, left, or right side of the table, or as a specific row, column, or table cell.
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Ul Component Accessibility: Select ListBox items, Table cells,
ColorPicker colors, and DatePicker menus using the keyboard

You can now use keyboard shortcuts to change the focus and make selections in various Ul
components. These shortcuts are supported for components in figures created using
the uifigure function.

Component Action Keyboard Shortcut
ListBox with Multiselect Toggle list box selection. Space

property set to 'off'

ListBox with Multiselect Select all items. Ctrl+A

property set to “on’ Move focus to previous item and |Shift+Up

toggle selection.

Move focus to next item and Shift+Down
toggle selection.

Move focus to previous item Ctrl+Up
without toggling selection.

Move focus to next item without | Ctrl+ Down
toggling selection.

Toggle selection of item Ctrl+Space
currently in focus.
Table Select table cell in top-left Ctrl+Home
corner.
Select table cell in bottom-right |Ctrl+End
corner.
ColorPicker gradient selector |Move gradient selector. Arrow keys
ColorPicker hue slider Move hue slider. Up and Down
DatePicker Cycle between drop down Tab

menus, buttons, and calendar.

App Designer: Use custom Ul components in App Designer

You can now configure custom Ul component classes to appear in the App Designer Component
Library and to be used interactively in Design View.

To configure a custom UI component class for use in App Designer, follow these steps:
* Define your own Ul component class by creating a subclass of the
matlab.ui.componentcontainer.ComponentContainer base class.

* Call the appdesigner.customcomponent.configureMetadata function and specify the path
to the component class .m file.

* Use the resulting dialog box to configure the metadata associated with the component, including
the component name, icon, author, and category.

This creates a resources folder with the App Designer metadata. To view the component in the App
Designer Component Library, add the folder containing the component class file and the generated
resources folder to the MATLAB path.
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To share your custom UI component for others to use in App Designer, share both the component
class file and the resources folder.

For more information, see Configure Custom UI Components for App Designer.

App Designer: Zoom and pan in the canvas, and zoom in the Code
View editor

To zoom in or out in the App Designer canvas and in the Code View editor, hold Ctrl and move the
scroll wheel, or press Ctrl+Plus and Ctrl+Minus. To return to the default scale, press Ctrl+Alt+0.

Zooming does not affect the Component Library, Component Browser, or Code Browser.

To pan in the App Designer canvas, use one of the following:

* Click and drag with the middle mouse button.
* Hold Space while clicking and dragging with the left mouse button.
Version History

In previous releases, the Ctrl+Plus and Ctrl+Minus keyboard shortcuts zoomed the entire App
Designer desktop.

App Designer: Control color and tab settings in Code View using
MATLAB preferences

Color and tab preferences applied to the MATLAB Editor are now also applied to the App Designer
Editor.

Additionally, you can now change the background color of the App Designer read-only code. Access
this setting in the App Designer tab of MATLAB preferences.

For more information, see Personalize Code View Appearance.

App Designer: Customize split-screen layouts in the App Designer
editor

To view your document in horizontal or vertical split-screen mode in the App Designer Code View
editor, select a layout in the App Designer toolstrip.

App Testing Framework: Perform gestures on panels and tables

The app testing framework supports gestures on more Ul components:

* Perform press, hover, and chooseContextMenu gestures on panels.
» Perform choose, type, and chooseContextMenu gestures on table Ul components.
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App Testing Framework: Close alert dialog box in front of figure
window

You can now use the dismissAlertDialog method as part of a test case to programmatically close
an alert dialog box in front of a figure window. For example, create a modal alert dialog box and close
it by calling the method.

fig = uifigure;
uialert(fig, 'File not found', 'Invalid File')

tc = matlab.uitest.TestCase.forInteractiveUse;
tc.dismissAlertDialog(fig)

Web Apps and Standalone Applications: Datatips supported in
graphics

Graphics created in web apps and standalone applications support datatips. Use datatips in these
applications just as you would in MATLAB figures.

Functionality Being Removed or Changed

GUIDE will be removed in a future release
Warns

The GUIDE environment and the guide function will be removed in a future release.

After GUIDE is removed, existing GUIDE apps will continue to run in MATLAB but will not be editable
using the drag-and-drop GUIDE environment. To continue editing an existing GUIDE app and help
maintain its compatibility with future MATLAB releases, use one of the suggested migration
strategies listed in the table.

App Development Migration Strategy How to Migrate
Frequent or ongoing Migrate your app to App Use the GUIDE to App Designer
development Designer. Migration Tool for MATLAB on
mathworks.com.
Minimal or occasional editing  |Export your app to a single Open the app in GUIDE and
MATLARB file to manage your select File > Export to
app layout and code using MATLAB-file.
MATLAB functions.

To create new apps, use App Designer and the appdesigner function instead. App Designer is the
recommended app development environment in MATLAB.

To learn more about migrating apps, see GUIDE Migration Strategies.

For more information about App Designer, go to Comparing GUIDE and App Designer on
mathworks.com.

GUIDE templates have been removed
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All GUIDE templates other than the blank GUI have been removed. To create new apps interactively,
use App Designer and the appdesigner function instead.

Graphics objects and Ul components sized using 'points’, 'inches’, and 'centimeters' units
will increase in size on macOS platforms
Behavior change in future release

In a future release, graphics and Ul objects that have Units or FontUnits properties set to
'points’, "inches’, or 'centimeters' will use a conversion value of 1 pixel = 1/96th inch on
macOS platforms. The current conversion value is 1 pixel = 1/72nd inch. As a result, these objects
and text elements will display 1.33 times larger than their previous size. This change will provide a
more readable default font size and will ensure a consistent object size across Windows and macOS
platforms.

The following objects use a unit value of 'pixels' by default and will not be affected by this change:

* Ul components in App Designer or in apps created with the uifigure function

» UI components in apps created in GUIDE and migrated to App Designer using the GUIDE to App
Designer Migration Tool for MATLAB

* Axes objects created using the uiaxes function

For the most control when sizing and laying out your graphics objects and Ul components, use a
value of 'pixels' for Units and FontUnits properties. To maintain object sizes in current and
future releases, make these updates in your code:

* Objects with Units or FontUnits setto 'points' — Update the value of the property from
'points' to 'pixels’.

* Objects with Units or FontUnits set to 'inches' — Update the value of the property from
"inches' to 'pixels' and multiply all Position values by 72.

* Objects with Units or FontUnits set to 'centimeters' — Update the value of the property
from 'centimeters' to 'pixels' and multiply all Position values by 72/2.54.

For example, this code creates a push button in a figure window, with its position specified in inches:

uicontrol('Units', 'inches', 'Position',[0.6 0.1 1.75 0.5]);

In a future release, the push button created by this code will display 1.33 times larger on macOS
platforms. To maintain the size and position of the push button in current and future releases, update
the code to:

uicontrol('Units', 'pixels','Position',[50 10 126 36]);
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Sparse Matrix Multiplication: Improved performance multiplying large
sparse matrices

Matrix multiplication performance has improved when multiplying sparse matrices. The performance
improvement arises from added support for multithreading in the operation, and therefore the
speedup gets better as the matrix size and number of nonzeros increase.

For example, if you multiply two 1e5-by-1e5 random sparse matrices with approximately two million
nonzeros, performance in R2021a is about 4.4x faster than in R2020b on a machine with 6 physical
cores.

function timingSparseMult
rng default

A = sprand(1le5,1e5,0.0002);
B = sprand(le5,1e5,0.0002);
tic

C = A*B;

toc

end

The approximate execution times are:
R2020b: 2.2 s
R2021a: 0.5s

The code was timed on a Windows 10, Intel Xeon W-2133 CPU @ 3.60 GHz test system by calling the
function timingSparseMult.

Sparse Linear Systems: Improved performance solving sparse linear
systems A*X = B with multicolumn B

Solving a linear system of the form A*X = B by executing X = A\B shows improved performance
when A is a sparse square matrix and B is a matrix with two or more columns. The speedup applies to
the solving step of the calculation but not the factorization step. The performance improvement arises
from added support for multithreading, and therefore the speedup gets better as the number of
columns in B increases.

For example, if you solve A*X = B using a 1e4-by-1e4 sparse coefficient matrix with approximately

40,000 nonzeros and a B matrix with 100 columns, performance in R2021a is about 5x faster than in
R2020b on a machine with 6 physical cores. This code uses decomposition to factor the coefficient
matrix, so only the solving process is timed. If you use X = A\B instead, you still see a speedup, but
the time required to factor the matrix is included and has not changed.

function timingSparseBackslashMultRHS
rng default

A = sprand(le4,1e4,0.0003) + speye(led);
B = sprand(le4,100,0.002);

dA = decomposition(A);

tic

x = dA\B;
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toc
end

The approximate execution times are:
R2020b: 1.5
R2021a: 0.3 s

The code was timed on a Windows 10, Intel Xeon W-2133 CPU @ 3.60 GHz test system by calling the
function timingSparseBackslashMultRHS.

vecnorm Function: Improved performance operating on data with
multiple columns

The performance of the vecnorm function has improved for all norm types when the data has 16 or
more columns and at least 217 elements.

The improvement also applies to N-D array data that can be permuted into a matrix with the requisite
number of columns. The speedup varies depending on the type of norm being calculated.

For example, if you calculate the 2-norm of a 1000-by-1000-by-3 array along the third dimension,
performance in R2021a is about 7.3x faster than in R2020b.

function timingVecnorm
rng default
N = 1000;
A = rand(N,N,3);
for k = 1:200
D = vecnorm(A,2,3);
end
end

The approximate execution times are:
R2020b: 8.8 s
R2021a: 1.2 s

The code was timed on a Windows 10, Intel Xeon W-2133 CPU @ 3.60 GHz test system using the
timeit function:

timeit(@timingVecnorm)

ismember Function: Improved performance for cell inputs

The ismember function shows improved performance operating on cell inputs. The speedup
depends on the size and layout of the data, with the largest speedup when the input has many cells
that contain few elements in each cell.

For example, if you use ismember to compare two 1000-by-1 cell arrays with 10 elements in each
cell, performance in R2021a is about 4.7x faster than in R2020b.

function timingIsmember
a = num2cell(char(randi(127,[1000 10]1)),2);
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b = num2cell(char(randi(127,[1000 101)),2);
tic
for ii = 1:1e4
ismember(a,b);
end
toc
end

The approximate execution times are:
R2020b: 6.6 s
R2021a: 1.4 s

The code was timed on a Windows 10, Intel Xeon W-2133 CPU @ 3.60 GHz test system by calling the
function timingIsmember.

unique Function: Improved performance for numeric, logical, char, and
cell inputs

The unique function shows improved performance operating on numeric, Llogical, char, and cell
inputs. The speedup generally gets better as the size of the inputs increases, and the improvement
applies when using any optional flags except the 'legacy' flag.

For example, if you operate on a 100-by-1 cell array with 10 elements in each cell, performance in
R2021a is about 3.3x faster than in R2020b.

function timingUniqueCell
a = num2cell(char(randi(127,[100 10])),2);
tic
for ii = 1:1e5
b = unique(a);
end
toc
end

The approximate execution times are:
R2020b: 3.9 s
R2021a:1.2s

Also, if you use unique on a numeric input with 10,000 elements and specify three outputs with the
'stable' option, performance in R2021a is about 3.5x faster than in R2020b.

function timingUniqueNumeric
a = rand(10000,1);

tic
for ii=1:1e4
[C,ia,ic] = unique(a, 'stable');
end
toc
end

The approximate execution times are:

R2020b: 9.4 s
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R2021a: 2.7 s

In both cases, the code was timed on a Windows 10, Intel Xeon W-2133 CPU @ 3.60 GHz test system
by calling the functions timingUniqueCell and timingUniqueNumeric.

Graph Functions: Improved performance modifying node and edge
lists

graph and digraph functions that modify the node and edge lists of the graph show improved
performance. This applies to the functions addedge, rmedge, addnode, rmnode, subgraph, and
reordernodes. The improvement applies to graphs that have no node properties (or only node
names), and graphs with no edge properties (or only edge weights). The improvement is most
noticeable when one of these functions is called many times in a loop, and the largest improvement
applies to graphs that have both node names and edge weights.

For example, if you use addedge in a loop to add new edges with node names and edge weights to an
empty graph, performance in R2021a is about 13x faster than in R2020b.

function timingAddedge

names = string(('A':'Z")"') + (1:10);
names = names(1:100);

rng default

g = graph;
for ii = 1:1e3
g = addedge(g, names(randi(100)), names(randi(100)), randn);
end
end
The approximate execution times are:
R2020b: 2.6 s
R2021a: 0.2 s

The code was timed on a Windows 10, Intel Xeon W-2133 CPU @ 3.60 GHz test system by using the
timeit function:

timeit(@timingAddedge)

Axes Toolbar: Appears without delay when axes are ready

Prior to R2021a, when hovering the cursor over figure axes, there was delay before the axes toolbar
appeared. Now the toolbar will appear as soon as the axes are ready.

Rearranging Ul Components: Improved performance when rearranging
Ul components in a Ul figure

Programmatically rearranging existing UI components in a figure created with the uifigure
function shows improved performance.

For example, if you sort 50 panels within a grid layout, performance in R2021a is approximately 1.9x
faster than in R2020b.
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function timingSortComp

% Create components

panels = {};

fig = uifiqure;

g = uigridlayout(fig,[1,1], 'RowHeight',40);

g.Scrollable = true;

num = 50;

for i = 1:num
p = uipanel(g);
uilabel(p, 'Text',['Panel ', num2str(i)], 'Position',[10 10 70 22]);
g.RowHeight{end} = 40;
panels{end+1} = p;

end

drawnow;

% Rearrange components

tic

order = length(panels):-1:1;

for i = 1:1length(order)
panels{i}.Layout.Row = order(i);

end

drawnow;

toc

end

The approximate execution times are:
R2020b: 0.70 s
R2021a: 0.36 s

The code was timed on a Windows 10, Intel Xeon E5-1650 CPU @ 3.60 GHz test system by calling the
function timingSortComp.

Ul Figure Interactions: Faster responses to scroll, pointer movement,
and resize interactions in Ul figures

In figures created with the uifigure function, the following interactions have improved
performance:

* Scrolling in a figure with a WindowScrollWheelFcn callback or an object with a predefined
scroll behavior

* Resizing a visible figure with a SizeChangedFcn callback or an object with a predefined resize
behavior

* Moving the mouse pointer in a figure with a WindowButtonMotionFcn callback when the figure
contains any Ul components except axes components

This performance increase is more noticeable when using a trackpad to interact with the figure.

For example, scrolling to zoom in on the plot created by the code below is smoother and more
responsive in R2021a than in R2020b.

tl datetime(2019,1,1);

t2 datetime(2020,1,1);

dates = linspace(tl,t2,10000);
data = rand(10000,10);

fig = uifiqure;
stackedplot(fig,dates,data);
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On a Windows 10, Intel Xeon W-2133 CPU @ 3.60 GHz test system, the responses to the scroll action
are:

R2020b: When you zoom in on the plot by scrolling for approximately two seconds, the plot has
about a five second delay in completing the zoom animation.

R2021a: The zoom animation completes immediately after you finish the scroll action.

Plots in Apps: Improved performance for polar plots, volume
visualizations, plots with more than 16 axes, and older systems

Displaying polar plots, volume visualizations, or more than 16 axes in an app have improved
performance. The improvement affects plots displayed in apps:

* Plots that are displayed in an app created with App Designer
» Plots displayed in a figure created with the uifigure function

Systems with older graphics drivers might experience the improvement for all types of plots that are
created within the apps and figures listed above. For example, Intel drivers earlier than version
10.0.0.0 for Windows systems will experience additional improvements.

This code creates a polar plot and executes a for loop that changes the theta values at every
iteration. The for loop executes about 2x faster than in R2020b.

function timingPolar

f = uifigure;

pax = polaraxes('parent',f);
theta = 0:0.01:2*pi;

rho = sin(2*theta).*cos(2*theta);
pp = polarplot(pax, theta,rho);
pax.FontSize = 12;

drawnow

tic;

for i=1:100
pp.ThetaData = pp.ThetaData + .02*pi;
drawnow

end

toc

end

The approximate execution times are:
R2020b: 10.15 s
R2021a: 5.30 s

The code was timed on a Windows 10, Intel Xeon W-2133 CPU @ 3.60 GHz test system by calling the
function timingPolar.

3-41



R2021a

3-42

Plots in Apps: Improved performance for plots with large numbers of
markers

Performance is improved for modifying certain types of plots in apps. You can observe the
improvement when the following conditions are true:

* The plots are displayed in an App Designer app, or they are displayed in a figure created with the
uifigure function.

* Your system is running a locally installed version of MATLAB on a modern Windows or macOS
system.

* You run the code either from the MATLAB command window or within a program file (.m file).
Note that plots created in live scripts do not show this improvement.

The plots typically contain large numbers of markers, and your code updates an aspect of those
markers, such as their positions. The improvement is more significant as you increase the number of
markers. For example, if you create a scatter plot with 10 million markers, and change the marker
positions 10 times, the performance in R2021a is about 1.3x faster than in R2020b.

function timingScatter

f = uifiqure;

a = axes(f);

X = rand(le7, 2);

s = scatter(a,x(:,1),x(:,2), 'Marker','*');

drawnow;

tic;

for i=1:10
X = rand(1le7,2);
s.XData = x(:,1);
s.YData = x(:,2);
drawnow

end

toc

end

The approximate execution times are:

R2020b: 19.43 s

R2021a: 14.88 s

The code was timed on a macOS 10.14.6, Intel Core i9 CPU @ 3.60 GHz test system by calling the

function timingScatter.

Live Editor: Improved performance when saving large live scripts or
functions

When saving large live scripts or functions, you can continue using the Live Editor sooner in R2021a
than in R2020b. While you continue to use the Live Editor, MATLAB saves the file in the background.
When MATLAB finishes saving the file, the asterisk (*) next to the file name disappears, indicating
that the file is saved.

For example, on a Windows 10, Intel Xeon E5-1650 CPU @ 3.60 GHz test system, if you save a live
script containing 35,000 lines of code and then click the title bar of another document open in the
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Live Editor, MATLAB immediately switches to the other open document. In R2020b, there is a
noticeable delay before MATLAB switches to the other open document.
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Projects: List all referenced projects of the current project

You can now use ListAllProjectReferences to programmatically list all projects in the reference
hierarchy of a specified project.

Projects: List impacted project files

You can now use listImpactedFiles to programmatically list all project files impacted by changes
to a specified file.

Dependency Analyzer: Find required add-ons

Starting in R2021a, the Dependency Analyzer detects and lists required add-ons, including apps and
toolboxes, for the whole project or for selected files. The Dependency Analyzer might not detect
required support packages. For more details, see Find Required Products and Add-Ons.

Unit Testing Framework: Create test runners using alternative syntax

You can now use the testrunner function to create a runner for tests authored using the MATLAB
unit testing framework or Simulink® Test™. In previous releases, you can explicitly create a runner
only by calling one of the static methods of the matlab.unittest.TestRunner class.

Use the testrunner function to create a default runner, a minimal runner with no plugins installed,
or a runner configured for text output. For example, create a default runner to run the tests in a test
class.

suite = testsuite('MyTestClass');
runner = testrunner;
results = run(runner,suite);

Unit Testing Framework: Initialize parameterization properties at suite
creation time

Starting in R2021a, you can specify parameterization properties that do not have a default value. This
feature is useful when parameters cannot be determined at the time MATLAB loads the test class
definition. To initialize a parameterization property at test suite creation time, use a static method
with the TestParameterDefinition attribute. For more information, see Define Parameters at
Suite Creation Time.

Unit Testing Framework: Run tests in parallel on thread-based pool

You can now run your tests on a thread-based parallel pool (requires Parallel Computing Toolbox). To
run tests using thread workers, start a thread-based pool and then call the runInParallel method
or the runtests function with the UseParallel name-value pair argument.

Thread-based parallel pools support only a subset of MATLAB and testing framework functionality.
For more information, see runInParallel or runtests.
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Unit Testing Framework: Run tests in MATLAB Online interactively

Starting in R2021a, you can run tests in MATLAB Online interactively. When you open a .m file
defining a function-based or class-based test in MATLAB Online, the toolstrip lets you run all tests in
the file or run the current test in the file. Also, you can customize the test run with options, such as
running tests in parallel (requires Parallel Computing Toolbox) or running tests with a specified level
of output detail.

The Run Tests section in the Editor tab of the toolstrip provides an alternative to programmatically
running tests with the runtests function. For more information, see Run Tests in Editor.

App Testing Framework: Perform gestures on panels and tables

The app testing framework supports gestures on more Ul components:

* Perform press, hover, and chooseContextMenu gestures on panels.
* Perform choose, type, and chooseContextMenu gestures on table Ul components.

App Testing Framework: Close alert dialog box in front of figure
window

You can now use the dismissAlertDialog method as part of a test case to programmatically close
an alert dialog box in front of a figure window. For example, create a modal alert dialog box and close
it by calling the method.

fig = uifigure;
uialert(fig, 'File not found', 'Invalid File')

tc = matlab.uitest.TestCase.forInteractiveUse;

tc.dismissAlertDialog(fig)

Functionality being removed or changed

Character data is not supported in custom examples demos.xml file
Behavior change

Starting in R2021a, when creating custom examples, character data is not supported in the
description of the demos . xml file. If you have a demos . xml file that contains character data such as
&lt;, &gt ;, &apos;, &quot;, and &amp;, the description does not appear correctly in the Help
browser.

To patch an existing demos . xml that contains character data, use the patchdemoxmlfile function.
patchdemoxmlfile patches the specified demos . xml file, replacing character data with non-
character data.

For example, patch the demos . xml file in the folder D:\Work\mytoolbox\help:

patchdemoxmlfile D:\Work\mytoolbox\help
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C++ Interface: Support for C++ language features

The C++ interface supports these additional C++ language features.

* Support for std: : vector values containing std: : string values and C++ arrays containing C-
style strings. For more information, see String and Character Types in the C++ to MATLAB Data
Type Mapping topic.

* Support for void* values as input and output arguments. For more information, see Use void*
Arguments, void* Argument Types, and addOpaqueType.

* Pass C++ functions to function pointers. For more information, see Use Function Type Arguments
and addFunctionType.

* Support for function and member function template instantiations. Publishers can modify function
names. For more information, see Customize Function Template Names.

C++ Interface: Publisher options and analysis

The C++ interface supports these build configuration features.

* Generate an interface from header and source (. cpp) files. Pass a . cpp or . hpp file in the
clibgen.generatelLibraryDefinition SourceFiles argument.

* Generate an interface from a header and a .d11 file for Microsoft Visual Studio compilers. Pass
a .d11 file in the clibgen.generatelLibraryDefinition LibraryFiles argument.

* Improved troubleshooting messages.
Java Packages to be removed

Java packages and subpackages that currently ship with MATLAB will not be available in MATLAB in
a future release.

Version History

To continue using a Java package, install its JAR file and add the JAR file to the static path in MATLAB
using the instructions in Static Path.

Java Engine: MATLAB value object support
To work with MATLAB value objects in a Java engine application, use the
com.mathworks.matlab.types.ValueObject class in the Java Engine API Summary. You can

create a value object in MATLAB, return it to Java, and call its methods. For information about
mapping Java data types to MATLAB data types, see Java Data Type Conversions.

Python Interface and Engine: Version 3.6 support discontinued

Support for Python version 3.6 is discontinued.
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Version History

To ensure continued support for your applications, upgrade to a supported version of Python, either
version 3.7 or 3.8. For more information, see Versions of Python Compatible with MATLAB Products
by Release.

Perl 5.32.0: MATLAB support on Windows

As of R2021a, MATLAB on Windows ships with an updated version of Perl, version 5.32.0.

* See www.perl.org for a standard distribution of Perl, Perl source, and information about using
Perl.

* See https://metacpan.org/pod/HTML.::Parser for a standard distribution of HTML : : Parser, source
code, and information about using HTML : : Parser.

* See https://metacpan.org/pod/HTML::Tagset for a standard distribution of HTML : Tagset, source
code, and information about using HTML: Tagset.

Version History

If you use the perl command on Windows platforms, see www.perl.org for information about using
this version of the Perl programming language.
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